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I MANUALI 

CORSO BASE

1  WINDOWS 
98

1.1  Accensione 
del Computer
1.2 Schermata 
iniziale
1.3 Spegnimento 
del computer
1.4 Gestione 
delle finestre
1.5 Criteri per 
esplorare il 
computer
1.6 Tasti 
Generali
1.7 Creazione di 
una cartella di 
un oggetto e 
Rinomina
1.8 Copia e 
spostamento dei 
File e delle 
cartelle
1.9  
Trascinamento 
dei documenti
1.10  
Eliminazione di 
file o cartelle
1.11  Periferiche 
di un Computer
1.12  Ricerca di 
un file o cartella
1.13  Tipi di file

2  MICROSOFT 
WORD 2000

1 Windows 98

1.1 Accensione del Computer

Per accendere il computer basta premere il tasto sulla macchina. Una volta 
attivato bisogna aspettare che compaia la schermata della scrivania o 
desktop. 
Per esempio potrebbe essere

 

 

figura 1.1 - Il desktop

Ora dobbiamo aspettare che non compaia più la clessidra:  A questo punto 
possiamo iniziale a lavorare.

1.1.1 Mouse

Spostando il mouse viene spostata una freccia  che ci indica dove ci 
troviamo. Per scegliere gli oggetti (bottoni e icone) utilizzeremo 
sempre il tasto sinistro del mouse

1.2 Schermata iniziale

Nella schermata iniziale che viene definita scrivania o desktop compaiono 
diversi tipi di oggetti:

1.2.1 Icone
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2.1 Creazione di 
un documento 
Word
2.2 Spostarsi 
lungo il testo
2.3 Cancellare 
Annullare 
Ripristinare
2.4 La 
formattazione
2.5  
Impostazioni 
pagina e stampa
2.6  Tagliare 
copiare incollare
2.7 Trova e 
sostituisci
2.8  Gestione di 
più documenti
2.9  Inserimenti
2.10 Trattare le 
immagini
2.11  Correzione 
Automatica
2.12  Paragrafi
2.13  Le 
Tabulazioni
2.14  
Visualizzazione 
dei caratteri 
nascosti
2.15  
Intestazione e 
Piè di pagina
2.16  Tabelle
2.17  I Disegni
2.18  Utilità
2.19  Casi 
particolari
2.20  Clic e 
digitazione

SCRIVICI

Sono caratterizzate da avere un disegno e una scritta sotto che ne 
indica il nome. 
Per selezionare un icona (cioè indicare che la vogliamo utilizzare) 
basta fare un click sopra con il tasto di sinistra del mouse. L'icona 
selezionata cambierà colore.
Per aprire la finestra associata all'icona occorre fare doppio click 
sempre con il tasto di sinistra. 
Per spostarla invece occorre schiacciare e tenere premuto il tasto 
sinistro del mouse (si dice trascinare l'oggetto)

1.2.2 Bottoni

Per premere un bottone basta fare un click sopra con il tasto di sinistra del 
mouse

Barra delle Applicazioni

1.3 Spegnimento del computer

figura 1.2 - Fine della sessione di lavoro

Si procede in questo modo:

1.  Facendo click sul bottone di 
Start bisogna scegliere nel 
menù Chiudi sessione.

2.  Click su arresta il sistema 
e poi su su OK

1.4 Gestione delle finestre

1.4.1 Apertura di una finestra

Facciamo doppio click sull'icona Risorse del computer. Comparirà la finestra 
seguente:
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figura 1.3 - Una Finestra

Prendiamo confidenza con i bottoni che sono sempre presenti in tutte le 
finestre in alto a destra:

Chiudi Chiude la finestra su cui stiamo lavorando

Ingrandisci Con questo bottone la finestra riempie tutto 
schermo

Ripristina La finestra da tutto schermo si riduce a finestra 
normale

Riduci finestra a 
icona. 

La finestra viene temporaneamente nascosta ma 
è ancora disponibile premendo il relativo bottone 
nella barra delle applicazioni. 

 Avendo aperto la finestra risorse del computer compare 
anche un bottone sulla stessa barra che contiene il bottone di start (Barra 
delle applicazioni). Facendo un click sopra la finestra che era nascosta si 
riapre. Questo bottone serve anche per poter portare in primo piano la 
finestra quando rimane nascosta da altre.

1.4.2 Spostamento di una finestra 

figura 1.4 - Spostamento di una finestra

Fare click e tenere premuto nella 
barra del titolo della finestra.
Spostando il mouse verrà 
visualizzata una cornice che indica 
quale sarà la nuova posizione della 
finestra 

Appena si lascia il pulsante del 
mouse la finestra apparirà nella 
nuova posizione
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1.4.3 Dimensionamento di una finestra

figura 1.5 - Dimensionamento di una finestra 

Spostandosi sulla cornice della 
finestra compariranno delle 
frecce. Facendo Click e tenendo 
premuto il mouse è possibile 
cambiare le dimensioni della 
finestra verticalmente, 
orizzontalmente e 
diagonalmente. 
La finestra assumerà la nuova 
dimensione quando si lascia il 
tasto del mouse.

1.4.4 Barre di scorrimento

 

figura 1.6 - Le Barre di scorrimento 

1.4.5 Menù di una finestra

Da Risorse del computer fare click per esempio sul menù Visualizza

●     Il segno  indica che una scelta è attiva.
●     Il segno  indica che questa alternativa è selezionata.
●     Il segno  indica che c'è un sottomenù.
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●      I puntini di fianco a una parola parola indicano che facendo 
click viene aperto un altro menù.

1.5 Criteri per esplorare il computer

Il modo migliore per imperare a utilizzare il computer è esplorare le varie 
finestre e le varie opzioni tenendo conto che:

●     E' sempre possibile uscire da una finestra senza modificare facendo click 
su ANNULLA o sulla .

●     Le azioni vengono confermate solo quando viene dato OK
●     Azioni particolari come la cancellazione di un documento richiedono 

sempre la conferma per sicurezza.

1.6 Tasti Generali

In tabella un primo elenco dei tasti utili più utilizzati:

Azione Tasto

Annullare un menù ESC

Annullare la modifica di un nome file ESC

Consultare la guida F1

Cancellare CANC

Annullare CTRL + Z

 

1.7 Creazione di una cartella di un oggetto e Rinomina

Una cartella consente di raggruppare programmi e documenti presenti nel 
computer. Le cartelle possono essere create ovunque sul desktop, sulle varie 

unità disco, all'interno di una cartella.

 

1.7.1 Per creare una cartella all'interno della cartella documenti

1.  Sulla scrivania fare doppio click sulla cartella documenti 
2.  Scegliere File | Nuovo | Cartella
3.  Scrivere il nome che si desidera dare alla cartella, quindi 

premere Invio
(i nomi possono essere lunghi fino a 255 caratteri. Non è 
possibile utilizzare i seguenti caratteri: \ / : * ? " < > | )

NOTA: è possibile creare una cartella anche sulla scrivania utilizzando il menù 
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di scelta rapida con il tasto di destra del mouse . 

1.7.2 Per rinominare una cartella

1.  Selezionare la cartella con un click
2.  Scegliere File | Rinomina
3.  Scrivere il nuovo nome e premere Invio

1.7.3 Per cerare un oggetto in una cartella

Alcuni programmi installati sul computer gestiscono file. È quindi possibile 
creare nuovi oggetti per questi programmi.

1.7.3.1 Creazione di un nuovo documento Word

Per creare un documento word all'interno di una cartella occorre

1.  Selezionare la cartella con un doppio click
2.  Scegliere File | Nuovo | Documento Microsoft Word

NOTA: Il Termine File indica sia documenti che cartelle che programmi.

1.7.4 Per rinominare il documento o una cartella

1.  Selezionare il documento/cartella con un click
2.  Scegliere File | Rinomina
3.  Scrivere il nuovo nome e premere Invio

1.8 Copia e spostamento dei File e delle cartelle

Il modo più semplice per spostare i file e le cartelle e quello di utilizzare i 
comandi Taglia Copia e Incolla.

1.8.1 Per copiare o spostare un file o una cartella

figura 1.7 - Copia

1.  In una finestra selezionare 
il file o la cartella che si 
desidera copiare o spostare

2.  Per copiare o per spostare il 
file o la cartella selezionata, 
scegliere rispettivamente 
Copia e Taglia dal menù 
Modifica.
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figura 1.8 - Incolla 

1.  Aprire la cartella di 
destinazione nella quale si 
vuole copiare o spostare il 
file o la cartella selezionata 

2.  Scegliere Modifica | Incolla

Il file o la cartella verrà visualizzato nella nuova posizione.

1.9 Trascinamento dei documenti

1.9.1 Trascinare i documenti

E' anche possibile spostare i file o le cartelle semplicemente trascinandoli da 
una finestra a un'altra o portandoli direttamente sulla scrivania.

figura 1.9 - Trascina 

1.  Fare click con il bottone di 
sinistra sul documento e 
tenere premuto.

2.  Trascinare il file o la cartella 
nella nuova posizione

3.  Lasciare andare il bottone del 
mouse.

Per effettuare una copia del documento occorre tenere premuto il tasto CTRL.

1.10 Eliminazione di file o cartelle

Gli oggetti eliminati vengono collocati temporaneamente nel Cestino. 
Questi file comunque non vengono rimossi dal disco fisso finché il 
cestino non viene svuotato. In questo modo è possibile recuperare 
dal cestino i file che sono stati eliminati erroneamente fino a che non 
vengano definitivamente eliminati. 

1.10.1 Per eliminare un file o una cartella
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figura 1.10 - Conferma eliminazione file 

1.  Selezionare il 
file o la cartella 
che si desidera 
eliminare
Selezionare File 
| Elimina 
(oppure usare il 
tasto CANC)

2.  Confermare 
l'eliminazione 
del file
Il file 
selezionato 
verrà spostato 
nel cestino

1.10.2 Per eliminare definitivamente un file o una cartella

1.  Aprire il Cestino dal Desktop
2.  Selezionare il file o la cartella che si desidera eliminare 
3.  Selezionare File | Elimina (oppure usare il tasto CANC)
4.  Confermare l'eliminazione del file

Il file selezionato verrà eliminato definitivamente.

Oppure selezionare File | Svuota Cestino . Questa opeazione conviene 
sempre farla con molta cautela, per dare la possibilità, a chi utilizza lo stesso 
computer, di recuperare file che erroneamente sono stati cancellati.

1.10.3 Per recuperare file o una cartella dal cestino

figura 1.11 - Il cestino 

1.  Aprire il Cestino dal Desktop
2.  Selezionare il file che si vuole 

recuperare
3.  Selezionare File | Ripristina 

Il file verrà riportato nella stessa 
posizione (cartella o Desktop) da 
dove era stato cancellato).
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1.11 Periferiche di un Computer

1.11.1 Componenti di un Computer

Per parlare di come funziona un computer, prenderò come esempio una 
cucina, in cui tutti gli ingredienti sono posti in una dispensa Il Cuoco segue i 
vari passaggi scritti sulla Ricetta e produce una Torta. Nor-malmente sia gli 
ingredienti utilizzati sia la torta in fase di lavorazione sono portati sul Tavolo. 
Per evita-re che il lavoro sia perso possiamo immaginare che in cuoco salva 
una copia della torta, anche se non fini-ta, nella dispensa. In questo modo il 
cuoco può in qualunque momento ripartire da ciò che ha salvato in dispensa.

 

Esempio Dispositivo Caratteristica Unità di 
Misura Altro

Cuoco
Processore
(Intel, Amd, Ecc) Velocità

MHZ
(milioni di impulsi 
al secondo)

Memoria 
cache

Tavolo

Memoria 
Ram
(Random Access 
Memory)

Dimensione Byte 
(~carattere)
8 bit 
Es 01101001

 
Dispensa

Memorie di 
massa
dischi fissi, floppy, 
CD-ROM, ecc.. 

Dimensione

Pavimento BUS Velocità MHz

Ricetta Programma Dimensione Byte

 

Tabella di conversione delle dimensioni

1K - Chilo 1.024

1M - Mega 1.048.576

1G - Giga 1.073.741.824

 

1.11.2 Le Memorie di Massa

Sigla Nome Dimensioni
(byte) Affidabilità Velocità Scrivibile ?

A (B) Floppy da 
3,5 pollici 1,4M Bassa Bassa Si
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C Disco Fisso 30 G in su Alta Alta Si

D CD ROM 650 M Alta Alta / Media No (1)

(1) Particolari CD Rom possono essere scritti usando i Masterizzatori

1.12 Ricerca di un file o cartella

Per cercare un file o una cartella di cui non si conosce l'esatta posizione si può 
utilizzare il comando Trova

figura 1.12 - Trova tutti i documenti Word

1.  Scegliere Start | Trova | File o cartelle.
2.  Nella casella nome scrivere il nome del file o della cartella che si desidera 

trovare.
3.  Per specificare dove effettuare la ricerca, selezionare il percorso 

desiderato con la casella .
4.  Per iniziare la ricerca, fare click su Trova.

In figura è stata fatta la ricerca di tutti i documenti Word, utilizzando il 
carattere jolly *,che significa un qualunque carattere ripetuto più volte (anche 
nessuna). "*.doc" indica che i file dovranno essere documenti prodotti da 
word. 

1.13 Tipi di file

Ogni file è caratterizzato da avere un nome che può essere lungo fino a 250 
caratteri e 3 caratteri di estensione. 

nome.est
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Le estensioni più utilizzate sono le seguenti

Estensione Tipo di File

doc Documenti Word

exe Eseguibili: i programmi

gif Immagini con massimo 256 colori

htm File Internet in formato HTML

jpg Immagini con massimo 16,7 milioni di colori

mid File musicali in formato MIDI (tipo spartito musicale)

txt File di testo senza formattazione

wav File sonori (registrazione)

xls Documenti Excel

zip File compressi con Winzip

L'estensione identifica il tipo di file e in alcuni casi il programma con cui è 
stato creato il file. 

Word 2000
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1 Windows 98

1.1 Accensione del Computer

Per accendere il computer basta premere il tasto sulla macchina. Una volta 
attivato bisogna aspettare che compaia la schermata della scrivania o 
desktop. 
Per esempio potrebbe essere

 

 

figura 1.1 - Il desktop

Ora dobbiamo aspettare che non compaia più la clessidra:  A questo punto 
possiamo iniziale a lavorare.

1.1.1 Mouse

Spostando il mouse viene spostata una freccia  che ci indica dove ci 
troviamo. Per scegliere gli oggetti (bottoni e icone) utilizzeremo 
sempre il tasto sinistro del mouse
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1.2 Schermata iniziale

Nella schermata iniziale che viene definita scrivania o desktop compaiono 
diversi tipi di oggetti:

1.2.1 Icone

Sono caratterizzate da avere un disegno e una scritta sotto che ne 
indica il nome. 
Per selezionare un icona (cioè indicare che la vogliamo utilizzare) 
basta fare un click sopra con il tasto di sinistra del mouse. L'icona 
selezionata cambierà colore.
Per aprire la finestra associata all'icona occorre fare doppio click 
sempre con il tasto di sinistra. 
Per spostarla invece occorre schiacciare e tenere premuto il tasto 
sinistro del mouse (si dice trascinare l'oggetto)

1.2.2 Bottoni

Per premere un bottone basta fare un click sopra con il tasto di sinistra del 
mouse

Barra delle Applicazioni

1.3 Spegnimento del computer

figura 1.2 - Fine della sessione di lavoro

Si procede in questo modo:

1.  Facendo click sul bottone di 
Start bisogna scegliere nel 
menù Chiudi sessione.

2.  Click su arresta il sistema 
e poi su su OK
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1.4 Gestione delle finestre

1.4.1 Apertura di una finestra

Facciamo doppio click sull'icona Risorse del computer. Comparirà la finestra 
seguente:

figura 1.3 - Una Finestra

Prendiamo confidenza con i bottoni che sono sempre presenti in tutte le 
finestre in alto a destra:

Chiudi Chiude la finestra su cui stiamo lavorando

Ingrandisci Con questo bottone la finestra riempie tutto 
schermo

Ripristina La finestra da tutto schermo si riduce a finestra 
normale

Riduci finestra a 
icona. 

La finestra viene temporaneamente nascosta ma 
è ancora disponibile premendo il relativo bottone 
nella barra delle applicazioni. 

 Avendo aperto la finestra risorse del computer compare 
anche un bottone sulla stessa barra che contiene il bottone di start (Barra 
delle applicazioni). Facendo un click sopra la finestra che era nascosta si 
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riapre. Questo bottone serve anche per poter portare in primo piano la 
finestra quando rimane nascosta da altre.

1.4.2 Spostamento di una finestra 

figura 1.4 - Spostamento di una finestra

Fare click e tenere premuto nella 
barra del titolo della finestra.
Spostando il mouse verrà 
visualizzata una cornice che indica 
quale sarà la nuova posizione della 
finestra 

Appena si lascia il pulsante del 
mouse la finestra apparirà nella 
nuova posizione

1.4.3 Dimensionamento di una finestra

figura 1.5 - Dimensionamento di una finestra 

Spostandosi sulla cornice della 
finestra compariranno delle 
frecce. Facendo Click e tenendo 
premuto il mouse è possibile 
cambiare le dimensioni della 
finestra verticalmente, 
orizzontalmente e 
diagonalmente. 
La finestra assumerà la nuova 
dimensione quando si lascia il 
tasto del mouse.
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1.4.4 Barre di scorrimento

 

figura 1.6 - Le Barre di scorrimento 

1.4.5 Menù di una finestra

Da Risorse del computer fare click per esempio sul menù Visualizza

●     Il segno  indica che una scelta è attiva.
●     Il segno  indica che questa alternativa è selezionata.
●     Il segno  indica che c'è un sottomenù.
●      I puntini di fianco a una parola parola indicano che facendo 

click viene aperto un altro menù.

1.5 Criteri per esplorare il computer

Il modo migliore per imperare a utilizzare il computer è esplorare le varie 
finestre e le varie opzioni tenendo conto che:

●     E' sempre possibile uscire da una finestra senza modificare facendo click 
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su ANNULLA o sulla .
●     Le azioni vengono confermate solo quando viene dato OK
●     Azioni particolari come la cancellazione di un documento richiedono 

sempre la conferma per sicurezza.

1.6 Tasti Generali

In tabella un primo elenco dei tasti utili più utilizzati:

Azione Tasto

Annullare un menù ESC

Annullare la modifica di un nome file ESC

Consultare la guida F1

Cancellare CANC

Annullare CTRL + Z

 

1.7 Creazione di una cartella di un oggetto e Rinomina

Una cartella consente di raggruppare programmi e documenti presenti nel 
computer. Le cartelle possono essere create ovunque sul desktop, sulle varie 

unità disco, all'interno di una cartella.

 

1.7.1 Per creare una cartella all'interno della cartella documenti

1.  Sulla scrivania fare doppio click sulla cartella documenti 
2.  Scegliere File | Nuovo | Cartella
3.  Scrivere il nome che si desidera dare alla cartella, quindi 

premere Invio
(i nomi possono essere lunghi fino a 255 caratteri. Non è 
possibile utilizzare i seguenti caratteri: \ / : * ? " < > | )

NOTA: è possibile creare una cartella anche sulla scrivania utilizzando il menù 
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di scelta rapida con il tasto di destra del mouse . 

1.7.2 Per rinominare una cartella

1.  Selezionare la cartella con un click
2.  Scegliere File | Rinomina
3.  Scrivere il nuovo nome e premere Invio

1.7.3 Per cerare un oggetto in una cartella

Alcuni programmi installati sul computer gestiscono file. È quindi possibile 
creare nuovi oggetti per questi programmi.

1.7.3.1 Creazione di un nuovo documento Word

Per creare un documento word all'interno di una cartella occorre

1.  Selezionare la cartella con un doppio click
2.  Scegliere File | Nuovo | Documento Microsoft Word

NOTA: Il Termine File indica sia documenti che cartelle che programmi.

1.7.4 Per rinominare il documento o una cartella

1.  Selezionare il documento/cartella con un click
2.  Scegliere File | Rinomina
3.  Scrivere il nuovo nome e premere Invio

1.8 Copia e spostamento dei File e delle cartelle

Il modo più semplice per spostare i file e le cartelle e quello di utilizzare i 
comandi Taglia Copia e Incolla.

1.8.1 Per copiare o spostare un file o una cartella
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figura 1.7 - Copia

1.  In una finestra selezionare 
il file o la cartella che si 
desidera copiare o spostare

2.  Per copiare o per spostare il 
file o la cartella selezionata, 
scegliere rispettivamente 
Copia e Taglia dal menù 
Modifica.

figura 1.8 - Incolla 

1.  Aprire la cartella di 
destinazione nella quale si 
vuole copiare o spostare il 
file o la cartella selezionata 

2.  Scegliere Modifica | Incolla

Il file o la cartella verrà visualizzato nella nuova posizione.

1.9 Trascinamento dei documenti

1.9.1 Trascinare i documenti

E' anche possibile spostare i file o le cartelle semplicemente trascinandoli da 
una finestra a un'altra o portandoli direttamente sulla scrivania.

1.  Fare click con il bottone di 
sinistra sul documento e 
tenere premuto.

2.  Trascinare il file o la cartella 
nella nuova posizione

3.  Lasciare andare il bottone del 
mouse.
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figura 1.9 - Trascina 

Per effettuare una copia del documento occorre tenere premuto il tasto CTRL.

1.10 Eliminazione di file o cartelle

Gli oggetti eliminati vengono collocati temporaneamente nel Cestino. 
Questi file comunque non vengono rimossi dal disco fisso finché il 
cestino non viene svuotato. In questo modo è possibile recuperare 
dal cestino i file che sono stati eliminati erroneamente fino a che non 
vengano definitivamente eliminati. 

1.10.1 Per eliminare un file o una cartella
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figura 1.10 - Conferma eliminazione file 

1.  Selezionare il 
file o la cartella 
che si desidera 
eliminare
Selezionare File 
| Elimina 
(oppure usare il 
tasto CANC)

2.  Confermare 
l'eliminazione 
del file
Il file 
selezionato 
verrà spostato 
nel cestino

1.10.2 Per eliminare definitivamente un file o una cartella

1.  Aprire il Cestino dal Desktop
2.  Selezionare il file o la cartella che si desidera eliminare 
3.  Selezionare File | Elimina (oppure usare il tasto CANC)
4.  Confermare l'eliminazione del file

Il file selezionato verrà eliminato definitivamente.

Oppure selezionare File | Svuota Cestino . Questa opeazione conviene 
sempre farla con molta cautela, per dare la possibilità, a chi utilizza lo stesso 
computer, di recuperare file che erroneamente sono stati cancellati.

1.10.3 Per recuperare file o una cartella dal cestino
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figura 1.11 - Il cestino 

1.  Aprire il Cestino dal Desktop
2.  Selezionare il file che si vuole 

recuperare
3.  Selezionare File | Ripristina 

Il file verrà riportato nella stessa 
posizione (cartella o Desktop) da 
dove era stato cancellato).

 

1.11 Periferiche di un Computer

1.11.1 Componenti di un Computer

Per parlare di come funziona un computer, prenderò come esempio una 
cucina, in cui tutti gli ingredienti sono posti in una dispensa Il Cuoco segue i 
vari passaggi scritti sulla Ricetta e produce una Torta. Nor-malmente sia gli 
ingredienti utilizzati sia la torta in fase di lavorazione sono portati sul Tavolo. 
Per evita-re che il lavoro sia perso possiamo immaginare che in cuoco salva 
una copia della torta, anche se non fini-ta, nella dispensa. In questo modo il 
cuoco può in qualunque momento ripartire da ciò che ha salvato in dispensa.

 

Esempio Dispositivo Caratteristica Unità di 
Misura Altro

Cuoco
Processore
(Intel, Amd, Ecc) Velocità

MHZ
(milioni di impulsi 
al secondo)

Memoria 
cache
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Tavolo

Memoria 
Ram
(Random Access 
Memory)

Dimensione Byte 
(~carattere)
8 bit 
Es 01101001

 
Dispensa

Memorie di 
massa
dischi fissi, floppy, 
CD-ROM, ecc.. 

Dimensione

Pavimento BUS Velocità MHz

Ricetta Programma Dimensione Byte

 

Tabella di conversione delle dimensioni

1K - Chilo 1.024

1M - Mega 1.048.576

1G - Giga 1.073.741.824

 

1.11.2 Le Memorie di Massa

Sigla Nome Dimensioni
(byte) Affidabilità Velocità Scrivibile ?

A (B) Floppy da 
3,5 pollici 1,4M Bassa Bassa Si

C Disco Fisso 30 G in su Alta Alta Si

D CD ROM 650 M Alta Alta / Media No (1)

(1) Particolari CD Rom possono essere scritti usando i Masterizzatori

1.12 Ricerca di un file o cartella

Per cercare un file o una cartella di cui non si conosce l'esatta posizione si può 
utilizzare il comando Trova
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figura 1.12 - Trova tutti i documenti Word

1.  Scegliere Start | Trova | File o cartelle.
2.  Nella casella nome scrivere il nome del file o della cartella che si desidera 

trovare.
3.  Per specificare dove effettuare la ricerca, selezionare il percorso 

desiderato con la casella .
4.  Per iniziare la ricerca, fare click su Trova.

In figura è stata fatta la ricerca di tutti i documenti Word, utilizzando il 
carattere jolly *,che significa un qualunque carattere ripetuto più volte (anche 
nessuna). "*.doc" indica che i file dovranno essere documenti prodotti da 
word. 

1.13 Tipi di file

Ogni file è caratterizzato da avere un nome che può essere lungo fino a 250 
caratteri e 3 caratteri di estensione. 

nome.est
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Le estensioni più utilizzate sono le seguenti

Estensione Tipo di File

doc Documenti Word

exe Eseguibili: i programmi

gif Immagini con massimo 256 colori

htm File Internet in formato HTML

jpg Immagini con massimo 16,7 milioni di colori

mid File musicali in formato MIDI (tipo spartito musicale)

txt File di testo senza formattazione

wav File sonori (registrazione)

xls Documenti Excel

zip File compressi con Winzip

L'estensione identifica il tipo di file e in alcuni casi il programma con cui è 
stato creato il file. 

Word 2000
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2 Microsoft Word 2000

2.1 Creazione di un documento Word

2.1.1 Apertura di Word

Selezionare Start | Programmi | Microsoft Word

2.1.2 Scrivere un testo

Testo d'Esempio

Lezione di scrittura di un testo. Ogni volta che faccio un punto 
la parola successiva è automaticamente scritta in maiuscolo. 

2.1.3 Utilizzo della tastiera

Cursore linea | che lampeggia. E' la testina della macchina per scrivere.

Azione Tasto Effetto

Cancellare prima del cursore AB|CD -> A|CD

Cancellare dopo il cursore CANC AB|CD -> AB|D

Lettere maiuscole - segni speciali 
(£$%&/=?^.....)  + lettera a -> A

Sempre lettere maiuscole
(si accende la luce CAPS LOCK) ABC....

2.1.4 Salvare il documento

Selezionare File | Salva con nome

1.  Scegliere eventualmente la cartella
2.  Scegliere il nome da dare al documento
3.  Fare click su Salva
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figura 2.1

2.1.5 Salvare le modifiche successive

Quando un documento ha un nome, è possibile salvare le modifiche successive del 
documento selezionando File | Salva oppure facendo click sul bottone  

2.1.6 Uscire dal documento

Per uscire da Word basta fare click sulla  ppure selezionare File | Esci

2.1.7 Se le modifiche non sono state salvate

In questo caso appare la finestra:

http://www.centroreiki.org/abaco/manuali/T_Corso_Base_Word.htm (2 of 28) [11/11/2002 14.40.31]



Corsi di Informatica - Manuale Corso Base

●     

Selezionare Sì se si vogliono salvare le 
modifiche

●     

Selezionare No se si vuole mantenere il 
documento originale già salvato

●     

Annulla se non si vuole uscire dal documento 
(si può proseguire o salvare il documento)

(Nota Word aggiunge automaticamente l'estensione .doc al nome del documento. 
L'estensione serve per riconoscere i file prodotti da word. Vedi anche 1.13 Tipi di file 
) 

2.2 Spostarsi lungo il testo

2.2.1 Muoversi lungo il testo con la tastiera

Azione Tasto

A sinistra di un carattere Freccia Sinistra

A destra di un carattere Freccia Destra

In alto di una riga Freccia Su

In basso di una riga Freccia Giù

Inizio riga

Fine riga Fine

All'inizio del documento Ctrl + 

Alla fine del documento Ctrl + Fine

A sinistra di una parola Ctrl + Freccia Sinistra

A destra di una parola Ctrl + Freccia Sinistra

In alto di una schermata Pag

In basso di una schermata Pag

2.2.2 Tecniche di selezione del testo

Per selezionare una o più parole fare click davanti alla prima parola e spostarsi a 
destra tenendo premuto il tasto sinistro
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Caro amico |ti scrivo -> Caro amico ti scrivo
 --------->

Per selezionare una riga fare click sul margine sinistro (compare una freccia bianca) 
Tenendo premuto e scendendo è possibile selezionare più righe

Caro amico ti scrivo -> Caro amico ti scrivo

Se la selezione non è quella desiderata ripeterla facendo prima click in una "zona 
neutra" dove non c'è niente oppure spostarsi con le frecce sulla tastiera.
La selezione con l'uso della tastiera è molto comoda e più precisa

1.  posizionarsi all'inizio del testo da selezionare
2.  spostarsi con le frecce o gli altri tasti di spostamento tenendo premuto Maiusc

2.3 Cancellare Annullare Ripristinare

Per cancellare una selezione premere semplicemente CANC. In questo modo è 
possibile vedere ciò che si cancellerà

Caro amico ti scrivo -> caro ti scrivo

Il tasto di annulla  serve per annullare l'ultima azione eseguita. 

Metodo Cancella Annulla Ripristina

Menù Modifica | Cancella Modifica | Annulla Modifica | Ripristina

Tastiera CANC CTRL + Z CTRL + Y

Barra strumenti 
formattazione

2.4 La formattazione

2.4.1 Formattare il carattere

Una volta selezionato un testo è possibile cambiarne il formato. (Se non si seleziona 
il testo il formato sarà applicato al ciò che sarà scritto successivamente). Selezionare 
Formato | Carattere
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Figura 2.2

 

Campo Azione

Tipo Consente di cambiare il tipo di carattere

Stile normale grassetto corsivo grassetto-corsivo

Dimensione espressa in punti tipografici

Colore carattere colore carattere

Stile sottolineatura varie sottolineature

Colore sottolineatura colore sottolineatura differente da quello del carattere

Anteprima consente di verificare l'aspetto prima di dare ok

Predefinito
ATTENZIONE: tutti i nuovi documenti assumeranno le 
impostazioni correnti. Queste impostazioni possono essere 
date velocemente attraverso la barra di formattazione
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Figura 2.3

Tipo di carattere

Dimensione Carattere

Grasetto

Corsivo

Sottolineato

Evidenzia il testo

Colore del testo

2.4.2 Formattazione del paragrafo

Un paragrafo può essere allineato a sinistra, in centro e a destra. Può anche essere 
giustificato e cioè è allineato sia lungo il margine sinistro sia destro, modificando lo 
spazio delle parole

Allinea a Sinistra

Allinea a centro

Allinea a Destra

Giustifica

2.4.3 Elenchi puntati e numerati

Dopo aver scritto un elenco è possibile selezionarlo per mettere davanti un punto 
grafico o un numero

mele
pere
fragole

●     mele
●     pere
●     fragole

1.  mele
2.  pere
3.  fragole
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Oppure è possibile premere uno dei due bottoni di elenco e iniziare a scrivere. Ad 
ogni invio il testo è creato un paragrafo con il pallino o il numero. Per terminare 
spegnere il bottone

elenco numerato elenco puntato

2.5 Impostazioni pagina e stampa

2.5.1 Impostazioni pagina e stampa

Selezionare File | Imposta pagina. 

Figura 2.4

Tramite questo menù è possibile principalmente modificare:

Margini
La distanza del testo Superiore, Inferiore, a destra, e a 
sinistra. 
Pagine affiancate consente di rilegare il testo

Dimensioni Le dimensioni del foglio e soprattutto l'orientamento della 
pagina
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Layout Con intestazione e piè di pagina è possibile creare un 
frontespizio.

Pagine affiancate

Consente di creare fogli per essere stampati fronte-retro. In 
questo caso l'impostazione Interno darà un margine per 
consentire la rilegatura (nell'esempio è stato posto a 5 cm). 
Tale margine sarà applicato a destra o a sinistra secondo le 
pagine pari o dispari.

2 pagine per foglio consente di creare due pagine in verticale sullo stesso foglio

 

2.5.2 La Stampa

Prima di stampare un documento è sempre meglio vederlo in anteprima. Scegliere 
File | Anteprima di stampa. Le funzioni principali sono:

Figura 2.4 

 

Stampa

Visualizza una Pagina

Visualizzapiù pagine

riduci di una pagina

chiudi anteprima di stampa

Se si è sicuri della stampa premere nella barra degli strumenti il bottone . Per 

uscire dall'anteprima di Stampa premere chiudi anteprima di stampa .

2.6 Tagliare copiare incollare

E' possibile copiare una porzione di testo un altro punto o addirittura su un altro 
documento. 
Un'altra possibilità è quella invece di spostare il testo togliendolo dalla posizione di 
partenza. 
La prima azione è eseguita attraverso i comandi di copia e incolla. A differenza di 
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quanto ci si aspetta, il comando copia non esegue il duplicato, ma prepara 
quest'azione che termina con incolla. Per fare un pa-ragone con la macchina delle 
fotocopie potremmo affermare che:

copia

Pongo l'originale nella macchina delle 
fotocopie

Incolla

Premo il tasto di duplicazione

Il comando incolla può essere eseguito più volte, nello stesso testo o in altri 
documenti perché word si ricorda qual è la parte di testo che state duplicando.

Taglia funziona nesso stesso modo di copia ma l'originale è eliminato dal punto in cui 
era.

2.6.1 I comandi Taglia Copia e Incolla.

E possibile eseguire questi comandi in vari modi differenti:
Attraverso la barra dei menù, utilizzando la tastiera, utilizzando la barra degli 
strumenti o usando il bottone destro del mouse.

Metodo Taglia Copia Incolla

Menù Modifica > Taglia Modifica > Copia Modifica > Incolla

tastiera CTRL+X CTRL+C CTRL+V

Barra strumenti 
formattazione

Pulsante destro 
mouse Taglia Copia Incolla

Per copiare un testo occorre

1.  selezionarlo
2.  dare copia
3.  posizionarsi dove si vuole inserirlo
4.  dare incolla 
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(i punti 3-4 due operazioni possono essere ripetute quante volte si vuole)

Quando si utilizza Taglia il testo è tolto da dove si trova e posto nel punto in cui è 
dato incolla.

2.6.2 Copia formato (pennello)

Questo comando permette di dare lo stesso tipo di formattazione (tipo 
carattere, stile, dimensione, colore, ecc.) a un'altra porzione di testo. 
Il testo che ha la formattazione desiderata farà da modello

1.  Posizionare il cursore sul testo che ha la formattazione desiderata (modello)
2.  Fare click su Copia formato (per applicarlo più volte fare doppio click)
3.  Trascinare il puntatore a forma di  per applicare la formattazione a un'altra 

selezione
4.  Se è stato dato doppio click, ripetere l'operazione su un'altra area. Alla fine fare 

click sul pennello per disattivare la copia formato

2.7 Trova e sostituisci

In questa finestra è possibile trovare o/e sostituire elementi di testo.
Questo comando scambia un elemento con un altro, molte o anche tutte le volte che 
lo individua nel documento.

2.7.1 Sostituisci

Seleziona Modifica | Sostituisci 

Figura 2.5
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●     Trova successivo individua l'elemento ma non lo modifica
●     Sostituisci effettua la sostituzione e passa alla ricerca successiva
●     Sostituisci tutto sostituisce automaticamente la parola ricercata ogni volta che 

la trova.

Il raggiungimento della fine del documento è segnalata con un messaggio. Dando OK 
è possibile ripartire dall'inizio del documento.

2.7.2 Trova

Simile a Sostituisci non effettua le sostituzioni di testo ma permette di individuare il 
testo cercato

2.8 Gestione di più documenti

E' possibile aprire contemporaneamente più documenti. Questo consente per 
esempio di copiare una parte di testo da un foglio all'altro. Per passare da un 
documento all'altro utilizzare Finestra e fare click sul documento su cui si vuole 
passare.

2.9 Inserimenti

2.9.1 Interruzione di pagina

L'inserimento dell'interruzione di pagina consente di saltare direttamente a una 
pagina successiva.
L'interruzione di pagina è inserita tramite Inserisci | Interruzione ..

Figura 2.6
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●     L'interruzione di pagina porta alla pagina successiva
●     L'interruzione di sezione crea una nuova sezione

2.10 Trattare le immagini

2.10.1 Inserire un'immagine dalla libreria di Word

Andare nel punto dove si vuole inserire l'immagine
Selezionare Inserisci | Immagine | ClipArt
Scegliere l'immagine da clipArt o da Immagine e dare inserisci. 

2.10.2 Inserire un'immagine da un file

Vi sono vari modi per acquisire un immagine: con lo scanner, con una macchina 
fotografica digitale, da Internet, da un CD di foto ecc. Le immagini sono salvate sul 
file nei vari formati: GIF, JPG, BMP ecc.
Per inserire un immagine di questo tipo occorre

Figura 2.7

1.  Selezionare Inserisci | Immagine | Da file
2.  Selezionare il percorso in cui si trova l'immagine in Cerca in
3.  Selezionare l'immagine 
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4.  Dare Inserisci

2.10.3 Formato immagine

Figura 2.8

Per disporre il testo di fianco all'immagine fare click sull'immagine stessa e da 
formato scegliere formato immagine. 

Con incorniciato il testo può essere messo di fianco come in questo momento.

Dietro al testo permette di scrivere sopra il testo

Il bottone avanzate consente di attivare le opzioni più complete. In disposizione 
del testo è possibile attivare la disposizione sopra e sotto del testo.

2.11 Correzione Automatica

Word segnala le parole che non sono contenute nel suo dizionario sottolineandole in 
rosso. Normalmente il dizionario utilizzato da Word è quello italiano ma è possibile 
cambiarlo selezionando Strumenti | Lingua | Imposta lingua. 
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Quando è segnalata una parola 
sconosciuta si può
1. Correggerla
2. Aggiungerla nel dizionario
3. Fare in modo che word la ignori durante 
la sessione corrente (se si esce da word e 
si riapre il documento si avrà ancora la 
segnalazione di errore)

Figura 2.9

Figura 2.10

Per fare questo bisogna fare click con il tasto destro del 
mouse. Quindi possiamo:
1. Scegliere la parola corretta tra quelle proposte
2. Fare click su Aggiungi per inserirla nel dizionario
3. Scegliere Ignora tutto

Per attivare invece il controllo ortografia e grammatica si utilizza il bottone  
Le indicazione che Word suggerite possono essere applicate o ignorate secondo il 
tipo di errore rilevato.

2.12 Paragrafi

Normalmente se il testo è allineato a sinistra inizia sempre dal margine sinistro. Si 
può far iniziare il paragrafo selezionato da un punto qualunque utilizzando i rientri 
presenti sul righello 
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...
 Rientro prima riga

 Rientro Sporgente

 Rientro Sinistro

...  Rientro Destro

Spostando questi indicatori è possibile avere questi effetti

Testo normale

 

Rientro sinistro e destro spostati

 

Tutto ciò si trova anche nella finestra Formato | Paragrafo. Oltre alla modifica dei 
rientri è possibile modificare l'interlinea cioè la distanza tra una linea e quella 
successiva.
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Figura 2.11

2.13 Le Tabulazioni

Figura 2.11

Le Tabulazioni servono per far partire (o terminare un testo in 
un certo punto). Sono disponibili 5 tabulazioni selezionabili 
con il bottone che si trova a sinistra del righello orizzontale:

 

Tabulazione sinistra

Tabulazione destra

Tabulazione centrata

Tabulazione decimale

Tabulazione a barre 

Per selezionare le tabulazioni basta fare un click sopra il bottone di tabulazione. Ogni 
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click cambia il tipo di tabulazione. 

Una volta scelto il tipo di tabulazione questo può essere posto facendo click sul 
righello nel punto deside-rato. Nell'immagine che segue sono state utilizzate tutte le 
prime quattro le tabulazioni con cui è stata creata la tabella successiva (le linee 
gialle sono state aggiunte per mettere meglio in evidenza la po-sizione del testo 
rispetto alla tabulazione):

Figura 2.12

Per separare un elemento dall'altro si usa il tasto di tabulazione che è 
Per togliere una tabulazione basta fare click e tenendo premuto trascinarla in giù dal 
righello. 

Un altro modo per gestire le tabulazioni è attraverso Formato | Tabulazioni. 
Facendo click sul bottone tabulazioni è possibile agire sulla singola tabulazione.

Figura 2.13

Allineamento
Tipo di allenieamento della tabulazione

Carattere riempimento
carattere utilizzato tra un testo e l'altro

Cancella tutto
elimina tutte le tabulazioni sulla riga/ 
righe selezionate

 

2.14 Visualizzazione dei caratteri nascosti
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Per visualizzare spazi, tabulazioni, interruzioni di pagina, a capo si utilizza il tasto 
I caratteri speciali visualizzati non saranno stampati ma servono come guida per 
comprendere come è scritto il testo.

Figura 2.14

È possibile anche scegliere quali caratteri non stampabili visualizzare andando in 
Strumenti | Opzioni | Visualizza.

2.15 Intestazione e Piè di pagina

Nei documenti molto lungi è utile inserire un'intestazione e un Piè di pagina per 
identificare le pagine ed eventualmente numerarle.

2.15.1 Creazione

Per agire sull'intestazione e il piè di pagina bisogna selezionare Visualizza | 
Intestazione e il piè di pagina. Il documento sarà visualizzato con il testo 
"sbiadito" mentre compare la parte dell'intestazione e una barra degli strumenti

Il testo può essere scritto

Allineato a sinistra Centrato Allineato a destra

Per separare un testo da quello successivo occorre utilizzare il tasto di tabulazione.
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Figura 2.15 

Una volta terminata la compilazione del testo con il pulsante Chiudi  si torna a 
lavorare normalmente. 

Inserisci numero di pagina

Inserisci numero totale di pagine

Formato numero di pagina

Inserisci data

Inserisci ora

Imposta pagina

Mostra / nascondi testo doumento

Come sezione precedente

Alterna intestazione / piè di pagina

Mostra precedente

Mostra succesiva

Chiudi

2.15.2 Iniziare dalla seconda pagina

Se si vuol far iniziare l'intestazione e il piè di pagina dalla seconda pagina (in modo 
da lasciare il titolo nella prima) occorre:

1.  Selezionare File | Imposta pagina
2.  Fare click sulla linguetta Layout
3.  Selezionare la casella Diversi per la prima pagina
4.  Confermare con OK
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Figura 2.16

Selezionando Visualizza | Intestazioni e piè di pagina l'area dell'intestazione e 
piè di pagina saranno diverse per la prima pagina

2.16 Tabelle

Le tabelle permettono di creare delle colonne e dei riquadri detti celle. Ogni cella è 
un piccolo testo e ha quindi tutti i vantaggi offerti da Word. Le tabelle in Word hanno 
la caratteristica di avere la dimensione variabile. E' possibile utilizzarle anche per 
fare delle somme ma per calcoli più complessi è preferibile utilizzare Excel. 
La creazione delle tabelle può avvenire in due modi: attraverso il menù Tabella 
oppure con lo strumento disegna tabella nella barra degli strumenti Tabelle e bordi.

2.16.1 Inserire una tabella

Questo procedimento permette di creare una tabella che parte dal margine sinistro e 
arriva al margine de-stro. Bisogna già avere in mente di quante righe e di quante 
colonne è composta la tabella.
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Figura 2.17

1.  Selezionare Tabella | Inserisci 
tabella.

2.  Si indicano il numero di righe e di 
colonne 

3.  si conferma con OK

2.16.2 Modifica della tabella

In ogni cella si può inserire il testo lungo quanto si vuole. Se la cella e troppo bassa 
la riga si allarga automaticamente. 

2.16.2.1 Selezione di una colonna

Occorre posizionarsi in cima alla colonna dove comparirà una freccia nera. A questo 
punto si può fare click

Figura 2.18

Una volta selezionata la colonna posso applicare tutti gli attributi di formattazione 

es. Allinea a Destra 

2.16.2.2 Selezione di una colonna

http://www.centroreiki.org/abaco/manuali/T_Corso_Base_Word.htm (21 of 28) [11/11/2002 14.40.31]



Corsi di Informatica - Manuale Corso Base

Occorre posizionarsi a sinistra della riga dove comparirà una freccia bianca. A questo 
punto si può fare click

Figura 2.18 

2.16.2.3 Selezione della tabella

E' molto comodo fare click su una cella qualsiasi e utilizzare Tabella | Seleziona 
tabella.

2.16.2.4 Modifica dimensioni di una colonna

Per modificare le dimensioni di una colonna utilizzare i cursori nel righello:

Figura 2.19

2.16.2.5 Modifica dimensioni di una cella

Una cella può avere larghezza differente rispetto a quelle che si trovano sopra o 
sotto.

Selezionare una cella 

Spostare il separatore di colonne  della misura 
desiderata.

Posizionandosi su una riga è possibile modificarne le 
dimensioni

http://www.centroreiki.org/abaco/manuali/T_Corso_Base_Word.htm (22 of 28) [11/11/2002 14.40.31]



Corsi di Informatica - Manuale Corso Base

2.16.2.6 Inserimento righe

1.  Selezionare la cella sopra la quale inserire la riga.
2.  Dare Tabella | Inserisci righe sopra o Inserisci righe sotto

Con lo stesso procedimento è possibile inserire una colonna a sinistra della cella 
selezionata.

2.16.2.7 Unione celle

È possibile unire le celle per creare delle intestazioni. L'unione può essere fatta 
orizzontalmente e verticalmente.

Selezionare le celle da unire

Dare Tabella | Unisci celle.

Il risultato

2.16.2.8 Divisione celle

E possibile dividere le celle in più righe e colonne

1.  Selezionare la cella da dividere
2.  Dare Tabella | Dividi celle.

2.17 I Disegni

È possibile eseguire dei disegni facendo click sull'apposito strumento . Una volta 
attivato compare la seguente barra dei disegni:
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Figura 2.20

 

Opzioni disegno

Selezione oggetti

Ruota per gradi

Inserimento forme

Linea

Freccia

Rettangolo

Ovale

Casella di testo

Word Art

Clip Art

Colore di riempimento

Colore linea

Colore carattere

Stile linea

Stile Tratteggio

Stile freccia

Stile 3 Dimensioni

Ombreggiatura

2.17.1 Per disegnare una linea 

1.  Scegliere lo strumento linea (fare click)
2.  Fare click e tenere premuto col il pulsante di sinistra nel punto di partenza
3.  Lasciare andare il pulsante nel punto di arrivo

La linea così tracciata ha delle maniglie per poterla modificare
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Modifica di un punto di inizio / fine
Si sposta la maniglia all'estremità 

Spostamento dell'oggetto
Basta prendere l'oggetto in un punto 
qualunque tranne le maniglie 

Nello stesso modo è possibile tracciare rettangoli ed ellissi.
Per tracciare facilmente quadrati e cerchi occorre tenere premuto il tasto di MAIUSC 
mentre si traccia.

Mentre si traccia un 
rettangolo compare una 
croce

Finito di tracciare si hanno 
le maniglie per modificarlo

Le frecce indicano che 
invece facendo click è 
possibile spostarlo

2.17.2 Colorare

Una volta selezionato un oggetto si può colorare

Riempimento Colore linea Stile linea Stile tratteggio 

2.17.3 Le Caselle di Testo

Sono rettangoli dove è possibile inserire un testo. Sono molto comode perché 
consentono di creare dei foglietti scritti che possono essere posti in qualunque punto 
del foglio.

La casella di testo può essere messa sopra un testo 

La casella di testo può essere utilizzata per scrivere nome via e indirizzo di una 
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persona e porlo in evidenza in cima al foglio.

2.17.3.1 È possibile creare caselle di testo senza bordo.

Figura 2.21

1.  Creare una casella di testo o selezionare una già esistente
2.  Selezionare Formato | Casella di testo 
3.  Scegliere Linea e Colore = nessuno

Ora la casella di testo non ha bordo

2.17.4 Selezionare più oggetti

Per selezionare più oggetti utilizzare lo strumento freccia 
Gli oggetti selezionati possono essere spostati o modificati. È comodo in molti casi 
raggruppare gli oggetti in modo da farli diventare uno solo 
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Si traccia un rettangolo per 
cattu-rare gli oggetti 

oppure si fa un click con 
MAIUSC premuto

Una volta selezionati gli 
oggetti da Disegno si 
sceglie raggruppa.

Ora gli oggetti sono 
raggruppati in un oggetto 

solo.

Possono essere separati 
con Disegno | Separa

2.17.5 Ruotare gli oggetti

1.  Selezionare l'oggetto da ruotare
2.  Utilizzare lo strumento Ruota per gradi 
3.  Trascinare le maniglie rotonde e l'oggetto ruoterà

Per rotazioni più semplici è possibile utilizzare il bottone  e scegliere Ruota e 
Capovolgi

2.18 Utilità

Dal bottone Disegno scegliere Ordine. In questo modo è possibile stabilire a quale 
livello un disegno si trova rispetto agli altri. Si può infatti immaginare che ogni 
disegno sia su un foglio da lucido e l'ultimo disegnato si trovo sempre sopra tutti gli 
altri.
Porta dietro il testo serve quando si vuole che il testo rimanga sopra un disegno

2.19 Casi particolari

2.19.1 Spostamento delle barre

Una delle barre si è spostata e ora è in mezzo allo schermo
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Figura 2.19

 

Per riportare la barra della formattazione al suo posto non bisogna chiuderla con la 
 ma spostarla come una finestra al suo posto lavorando sul bordo blu, oppure fare 

doppio click su bordo blu.

Se la barra non è più visibile per farla riapparire si seleziona Visualizza | Barre 
degli strumenti e si riattiva la barra che è scomparsa.

2.20 Click e digitazione 

Con Word 2000 è possibile inserire il testo automaticamente dove si vuole: basta 
fare doppio click nel punto desiderato. Quando questa possibilità è attiva appaiono i 
seguenti cursori:

    

Questa possibilità molto comoda implica la conoscenza della tabulazione e dei vari 
sistemi di formattazione del testo.
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I MANUALI 

CORSO 
AVANZATO

1  WINDOWS 
98

1.1 Utilità
1.2 Creazione 
dei collegamenti
1.3 Tasti 
Generali
1.4 Selezionare 
più file
1.5 Uso 
avanzato della 
tastiera e del 
mouse
1.6 Utilità di 
sistema

2 EXCEL 2000

2.1 Introduzione
2.2 Le formule
2.3 Una 
semplice rubrica 
ovvero un 
database
2.4 
Impostazione 
della pagina
2.5 Formule 
avanzate
2.6 Database
2.7 
Visualizzazioni
2.8 I grafici

3 WORD 2000

3.1 Inserimento 
di grafici e 
tabelle Excel
3.2 Stili
3.3 La struttura 

1 Windows 98

1.1 Utilità 

1.1.1 Accesso rapido al Desktop

Per accedere velocemente alla scrivania si può evitare di ridurre ad icona le finestre 
aperte e utilizzare il bottone che compare nella barra degli strumenti: Mostra desktop

1.1.2 Vari tipi di visualizzazione dei file

Le cartelle possono essere visualizzate in quattro modi differenti. Dal menù 
visualizza posso scegliere:

Visualizza Icone Grandi

 

Visualizza Icone Piccole

 
Visualizza Elenco

 

Visualizza Dettagli

 

La visualizzazione per Dettagli consente facilmente di ordinare le icone per
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di un 
documento, il 
sommario

SCRIVICI

 

●     Nome
●     Dimensione
●     Tipo
●     Modificato (cioè la data dell'ultima modifica)

Per riordinare le icone in questo caso occorre fare un click sul bottone grigio 
corrispondente

Un secondo click sullo stesso bottone rieffettuerà l'ordinamento al contrario. Con 
l'ordinamento per Modificato è molto comodo risalire all'ultimo file che è stato 
cambiato.

1.2 Creazione dei collegamenti

I Collegamenti consentono di avviare rapidamente un'applicazione o di aprire 
rapidamente un file o una cartella. Molto spesso si usano i collegamenti per avere sul 
Desktop tutto quello che utilizziamo spesso.
I collegamenti evitano di dover spostare i file dalla loro posizione originale. Possono 
essere immaginati come dei biglietti da visita, mentre il file originale non è altro che la 
mia casa.

Da Notare:

●     E' possibile avere più collegamenti per lo stesso file.
●     Se si cancella un collegamento non si elimina il file associato.
●     I collegamenti occupano poco spazio (circa 0,5K Byte)

1.2.1 Creazione di un collegamento sul Desktop (scrivania)

Il modo più semplice per creare un collegamento sul Desktop è cercare il file con il 
comando Trova

1.2.1.1 Creazione di un collegamento per Word sul Desktop

1.  Selezionare Start > Trova > File o Cartelle
2.  Selezionare Winword.exe (cioè il programma Word) e dare Trova.
3.  Fare click sull'icona Winword e trascinarla sul Desktop. 
4.  L'icona che appare sul Desktop ha nome Collegamento a Winword.exe.
5.  A questo punto coviene rinominare l'icona come Word facendo click con il tasto 

di destra e selezionando Rinomina.
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Facendo doppio click sul collegamento appena creato verrà aperto Word.  

1.2.1.2 Creazione di un collegamento per un programma

In questo caso occorre fare la ricerca ancora con *.exe
Una volta individuato il programma lo si trascina sul desktop

1.2.1.3 Creazione di un collegamento per un File

Con i collegamenti è possibile avere sul Desktop dei riferimenti rapidi a documenti che 
utilizziamo spesso senza spostare i file dalla loro posizione originale.
Volgiamo creare un collegamento per un documento che si chiama Lettera e portarlo 
sul Desktop.

1.  Selezionare il documento corso con un click.
2.  Selezionare File > Crea collegamento. Sarà creato un collegamento nella 

stessa cartella.
3.  A questo punto rimpicciolendo opportunamente la finestra si può trascinare il 

collegamento sul Desktop.

 

 

Trascino fuori
sul desktop

 

1.  Si può eventualmente rinominare il collegamento con il nome corso. (con File > 
Rinomina ).

2.  Si può cambiare il disegno dell'icona con File > Proprietà e sceglie cambia 
icona.

3.  Una volta selezionata l'icona si conferma con OK 
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1.2.1.4 Creazione di un collegamento per una Cartella

1.  Aprire la cartella
2.  Utilizzare la finestra non a tutto schermo (bottone ripristina)
3.  Trascinare la piccola icona in alto a destra sul Descktop. Verrà creato un 

collegamento a questa cartella

1.2.1.5 Creazione di un collegamento dal menù Programmi

Una volta aperto il menù Start > Programmi è possibile creare un collegamento al 
programma trascinamdo il bottone sulla scrivanta tenendo contemporaneamente 
premuto il tasto CTRL.

1.2.1.6 Eliminazione di un collegamento

Quando un collegamento viene eliminato il file associato al collegamento non viene 
cancellato.
Per cancellare il collegamento a corso si procede in questo modo:

1.  Selezionare il collegamento a corso sulla scrivania.
2.  Eliminare il collegamento con CANC. Il documento originale rimane.
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1.2.1.7 Eliminazione del file associato a un collegamento

Se il file originale associato al collegamento viene eliminato, il collegamento non può 
più funzionare correttamente. In questo caso facendo doppio click sull'icona del 
collegamento appare la finestra:

Il computer cerca un documento simile a corso.doc . Il risultato della ricerca spesso 
non è soddisfacente:

Conviene cancellare il collegamento perché ora non ha più senso.

1.3 Tasti Generali

Tabella riassuntiva dei tasti di scelta rapida (altri tasti sono contenuti nel manuale in 
linea che può essere attivata con Start > Guida in linea 
dando cerca e inserendo come parole scelta rapida)

FUNZIONE TASTI

Annullare CTRL + Z

Annullare la modifica di un nome file ESC

Annullare un menù ESC

Cancellare CANC

Chiudere un documento CTRL + F4

Consultare la guida F1

Copiare CTRL + C

Incollare CTRL + V

Passare a un'altra finestra tenendo premuto ALT e 
premendo ripetutamente TAB ALT + TAB
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Rinominare un file F2

Salvare MAIUSC + F12

Stampare MAIUSC + MAIUSC + F12

Tagliare CTRL + X

Uscire da una finestra ALT + F4

Per accedere a un menù bisogna utilizzare ALT + la lettera sottolineata del menù. Per 
esempio per accedere a File bisogna premere ALT + f. Per spostarsi tra i menù si 
utilizzano le frecce e si conferma con Invio

1.4 Selezionare più file

Spesso abbiamo l'esigenza di agire su più file contemporaneamente (Es., vogliamo 
copiarli). E' molto comoda la visualizzazione della cartella per dettagli. (Scegliere 
Visualizza > Dettegli).

E' possibile:

●     Selezionare tutti i file nella cartella
●     Selezionare file sparsi
●     Selezionare un intervallo di file

1.4.1 Selezionare tutti i file nella cartella

Selezionare Modifica > Seleziona tutto

1.4.2 Selezionare file sparsi

1.  Fare click sul primo file che si vuole selezionare
2.  Fare click sugli altri file tenendo premuto CTRL. 
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Un ulteriore click su un file selezionato lo deseleziona.

1.4.3 Selezionare un intervallo di file

1.  Fare click sul primo file dell'intervallo.
2.  Fare click sul ultimo file dell'intervallo tenendo premuto Maiusc.

1.5 Uso avanzato della tastiera e del mouse

1.5.1 Tasto Destro

Il tasto destro del mouse permette di accedere ad un menù rapido contenente le 
azioni che possiamo eseguire sull'oggetto su cui abbiamo fatto click

1.5.1.1 Icona (su Desktop)
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Sul Desktop questo è l'unico modo per accedere ad 
una serie di operazioni .

In Proprietà troviamo tutte le informazioni che 
riguardano l'icona.

Invia a è molto comodo se vogliamo copiare per 
esempio il file su floppy.

1.5.1.2 Barra degli strumenti (Es Word)

Facendo click con il tasto destro sulla barra dei menu 
compare il menù con tutte le barre attive. 

Con il tasto di sinistra si possono attivare / disattivare le 
varie barre dei menù.

1.5.1.3 Testo Errato in Word
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Quando si scrive un testo con una parola 
sconosciuta a Word, questa viene 
sottolineata in rosso. Facendo Click con il 
tasto di destra sulla parola appare un 
menù con le parole che si avvicinano a 
quella sbagliata. Attraverso il 
suggerimento è possibile correggere la 
parola sbagliata.

1.5.2 Tasti particolari

Se il mouse non funziona è possibile utilizzare i seguenti tasti

Questo tasto corrisponde al click sul bottone Start. Per Spegnere 
velocemente il computer su può premere questo tasto poi C e poi Invio.

Questo tasto corrisponde al click sul bottone di destra del mouse

1.6 Utilità di sistema

1.6.1 Controllo volume

Facendo click sull'altoparlante in basso a destra è possibile 
regolare il volume delle casse. Facendo click e tenendo premuto 
sul cursore si regola il volume degli altoparlanti

1.6.2 La Calcolatrice

Per eseguire dei conti è possibile attivare la calcolatrice selezionando Start > 
Programmi > Accessori.

La calcolatrice può essere selezionata come 
Standard o Scientifica attraverso Visualizza.

Il risultato delle operazioni può essere copiato in 
un altro programma (Word, Excel, ..) 
selezionando Modifica > Copia.
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Excel 2000
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1 Windows 98

1.1 Utilità 

1.1.1 Accesso rapido al Desktop

Per accedere velocemente alla scrivania si può evitare di ridurre ad icona le finestre 
aperte e utilizzare il bottone che compare nella barra degli strumenti: Mostra desktop

1.1.2 Vari tipi di visualizzazione dei file

Le cartelle possono essere visualizzate in quattro modi differenti. Dal menù 
visualizza posso scegliere:

Visualizza Icone Grandi

 

Visualizza Icone Piccole
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Visualizza Elenco

 

Visualizza Dettagli

 

La visualizzazione per Dettagli consente facilmente di ordinare le icone per

●     Nome
●     Dimensione
●     Tipo
●     Modificato (cioè la data dell'ultima modifica)

Per riordinare le icone in questo caso occorre fare un click sul bottone grigio 
corrispondente

Un secondo click sullo stesso bottone rieffettuerà l'ordinamento al contrario. Con 
l'ordinamento per Modificato è molto comodo risalire all'ultimo file che è stato 
cambiato.

1.2 Creazione dei collegamenti

I Collegamenti consentono di avviare rapidamente un'applicazione o di aprire 
rapidamente un file o una cartella. Molto spesso si usano i collegamenti per avere sul 
Desktop tutto quello che utilizziamo spesso.
I collegamenti evitano di dover spostare i file dalla loro posizione originale. Possono 
essere immaginati come dei biglietti da visita, mentre il file originale non è altro che la 
mia casa.
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Da Notare:

●     E' possibile avere più collegamenti per lo stesso file.
●     Se si cancella un collegamento non si elimina il file associato.
●     I collegamenti occupano poco spazio (circa 0,5K Byte)

1.2.1 Creazione di un collegamento sul Desktop (scrivania)

Il modo più semplice per creare un collegamento sul Desktop è cercare il file con il 
comando Trova

1.2.1.1 Creazione di un collegamento per Word sul Desktop

1.  Selezionare Start > Trova > File o Cartelle
2.  Selezionare Winword.exe (cioè il programma Word) e dare Trova.
3.  Fare click sull'icona Winword e trascinarla sul Desktop. 
4.  L'icona che appare sul Desktop ha nome Collegamento a Winword.exe.
5.  A questo punto coviene rinominare l'icona come Word facendo click con il tasto 

di destra e selezionando Rinomina.

Facendo doppio click sul collegamento appena creato verrà aperto Word.  

1.2.1.2 Creazione di un collegamento per un programma

In questo caso occorre fare la ricerca ancora con *.exe
Una volta individuato il programma lo si trascina sul desktop

1.2.1.3 Creazione di un collegamento per un File

Con i collegamenti è possibile avere sul Desktop dei riferimenti rapidi a documenti che 
utilizziamo spesso senza spostare i file dalla loro posizione originale.
Volgiamo creare un collegamento per un documento che si chiama Lettera e portarlo 
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sul Desktop.

1.  Selezionare il documento corso con un click.
2.  Selezionare File > Crea collegamento. Sarà creato un collegamento nella 

stessa cartella.
3.  A questo punto rimpicciolendo opportunamente la finestra si può trascinare il 

collegamento sul Desktop.

 

 

Trascino fuori
sul desktop

 

1.  Si può eventualmente rinominare il collegamento con il nome corso. (con File > 
Rinomina ).

2.  Si può cambiare il disegno dell'icona con File > Proprietà e sceglie cambia 
icona.

3.  Una volta selezionata l'icona si conferma con OK 
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1.2.1.4 Creazione di un collegamento per una Cartella

1.  Aprire la cartella
2.  Utilizzare la finestra non a tutto schermo (bottone ripristina)
3.  Trascinare la piccola icona in alto a destra sul Descktop. Verrà creato un 

collegamento a questa cartella

1.2.1.5 Creazione di un collegamento dal menù Programmi

Una volta aperto il menù Start > Programmi è possibile creare un collegamento al 
programma trascinamdo il bottone sulla scrivanta tenendo contemporaneamente 
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premuto il tasto CTRL.

1.2.1.6 Eliminazione di un collegamento

Quando un collegamento viene eliminato il file associato al collegamento non viene 
cancellato.
Per cancellare il collegamento a corso si procede in questo modo:

1.  Selezionare il collegamento a corso sulla scrivania.
2.  Eliminare il collegamento con CANC. Il documento originale rimane.

1.2.1.7 Eliminazione del file associato a un collegamento

Se il file originale associato al collegamento viene eliminato, il collegamento non può 
più funzionare correttamente. In questo caso facendo doppio click sull'icona del 
collegamento appare la finestra:

Il computer cerca un documento simile a corso.doc . Il risultato della ricerca spesso 
non è soddisfacente:

Conviene cancellare il collegamento perché ora non ha più senso.
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1.3 Tasti Generali

Tabella riassuntiva dei tasti di scelta rapida (altri tasti sono contenuti nel manuale in 
linea che può essere attivata con Start > Guida in linea 
dando cerca e inserendo come parole scelta rapida)

FUNZIONE TASTI

Annullare CTRL + Z

Annullare la modifica di un nome file ESC

Annullare un menù ESC

Cancellare CANC

Chiudere un documento CTRL + F4

Consultare la guida F1

Copiare CTRL + C

Incollare CTRL + V

Passare a un'altra finestra tenendo premuto ALT e 
premendo ripetutamente TAB ALT + TAB

Rinominare un file F2

Salvare MAIUSC + F12

Stampare MAIUSC + MAIUSC + F12

Tagliare CTRL + X

Uscire da una finestra ALT + F4

Per accedere a un menù bisogna utilizzare ALT + la lettera sottolineata del menù. Per 
esempio per accedere a File bisogna premere ALT + f. Per spostarsi tra i menù si 
utilizzano le frecce e si conferma con Invio

1.4 Selezionare più file

Spesso abbiamo l'esigenza di agire su più file contemporaneamente (Es., vogliamo 
copiarli). E' molto comoda la visualizzazione della cartella per dettagli. (Scegliere 
Visualizza > Dettegli).
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E' possibile:

●     Selezionare tutti i file nella cartella
●     Selezionare file sparsi
●     Selezionare un intervallo di file

1.4.1 Selezionare tutti i file nella cartella

Selezionare Modifica > Seleziona tutto

1.4.2 Selezionare file sparsi

1.  Fare click sul primo file che si vuole selezionare
2.  Fare click sugli altri file tenendo premuto CTRL. 
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Un ulteriore click su un file selezionato lo deseleziona.

1.4.3 Selezionare un intervallo di file

1.  Fare click sul primo file dell'intervallo.
2.  Fare click sul ultimo file dell'intervallo tenendo premuto Maiusc.
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1.5 Uso avanzato della tastiera e del mouse

1.5.1 Tasto Destro

Il tasto destro del mouse permette di accedere ad un menù rapido contenente le 
azioni che possiamo eseguire sull'oggetto su cui abbiamo fatto click

1.5.1.1 Icona (su Desktop)

Sul Desktop questo è l'unico modo per accedere ad 
una serie di operazioni .

In Proprietà troviamo tutte le informazioni che 
riguardano l'icona.

Invia a è molto comodo se vogliamo copiare per 
esempio il file su floppy.

http://www.centroreiki.org/abaco/manuali/T_Corso_Avanzato_Win98.htm (10 of 13) [11/11/2002 14.41.15]



Corsi di Informatica - Manuale Corso

1.5.1.2 Barra degli strumenti (Es Word)

Facendo click con il tasto destro sulla barra dei menu 
compare il menù con tutte le barre attive. 

Con il tasto di sinistra si possono attivare / disattivare le 
varie barre dei menù.
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1.5.1.3 Testo Errato in Word

Quando si scrive un testo con una parola 
sconosciuta a Word, questa viene 
sottolineata in rosso. Facendo Click con il 
tasto di destra sulla parola appare un 
menù con le parole che si avvicinano a 
quella sbagliata. Attraverso il 
suggerimento è possibile correggere la 
parola sbagliata.

1.5.2 Tasti particolari

Se il mouse non funziona è possibile utilizzare i seguenti tasti

Questo tasto corrisponde al click sul bottone Start. Per Spegnere 
velocemente il computer su può premere questo tasto poi C e poi Invio.

Questo tasto corrisponde al click sul bottone di destra del mouse

1.6 Utilità di sistema

1.6.1 Controllo volume

Facendo click sull'altoparlante in basso a destra è possibile 
regolare il volume delle casse. Facendo click e tenendo premuto 
sul cursore si regola il volume degli altoparlanti

1.6.2 La Calcolatrice

Per eseguire dei conti è possibile attivare la calcolatrice selezionando Start > 
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Programmi > Accessori.

La calcolatrice può essere selezionata come 
Standard o Scientifica attraverso Visualizza.

Il risultato delle operazioni può essere copiato in 
un altro programma (Word, Excel, ..) 
selezionando Modifica > Copia.

 

Excel 2000
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2 Excel 2000 

2.1 Introduzione

2.1.1 Componenti di un foglio

I dati inseriti in Excel sono organizzati in Cartelle di lavoro a loro volta suddivise in Fogli 
elettronici. I fogli sono formati da celle disposte per righe e colonne identificate da 
lettere (colonne) e numeri (righe). Quando una cella è selezionata il bordo è contornato 
e le lettere e i numeri sono in grassetto.

Con Excel siamo sempre in una delle seguenti modalità:

●     Navigazione - ci si sposta da una cella ad un'altra o si selezionano
●     Immissione dati - si inseriscono i dati in una cella

2.1.2 Selezione delle celle

Per selezionare una cella basta fare un click sopra. È importante che spostandosi con il 
mouse compaia una croce 
Per selezionarne più celle si fa click sulla prima e tenendo premuto il tasto di sinistra e ci 
si sposta:
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Selezione di un intervallo di celle.
Fare click da B2 e tenendo premuto si arriva a C4

 

Selezione di una colonna
Fare click sulla lettera (esempio colonna C)
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Selezione di una riga
Fare click sul numero (Esempio riga 2)

 

Selezione di tutta la tabella
Fare click sul bottone

 

Per selezionare più celle non contigue si usa contemporaneamente il tasto CTRL + Click 
con il mouse
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Quando si inserisce un valore in una cella questo compare nella barra della formula

Per confermare l'immissione dei dati si può:

●     Premere INVIO. In questo modo si passa alla cella sottostante.
●     Premere TAB. In questo modo si passa alla cella successiva.
●     Fare click sul bottone  In questo modo si rimane nella stessa cella.

Una cella può anche avere un nome utilizzando l'apposita casella Nome.
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In una cella possono essere immessi:

●     testi lunghi quanto si vuole (la colonna non ha dimensione fissa). Saranno allineati 
a sinistra 

●     numeri. Sono allineati a destra
●     date immettendo giorno/mese/anno (allineate a destra) 
●     ore immettendo ora.minuti.secondi (allineate a destra)
●     percentuali 
●     formule. Iniziano con un =
●     (Ed altro…)

Come già visto in Word una volta selezionata una cella (o più celle) è possibile modificare 
il tipo di formattazione:

Tipo di carattere

Dimensione Carattere

Grasetto

Corsivo

Sottolineato

Bordi

Colore Riempimento
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Colore Carattere

Come in Word è possibile 
cambiare il formato dei caratteri 
utilizzando una finestra che è 
selezionata con Formato > Celle 
e la Scheda Carattere. 

2.1.3 Modifica delle dimensioni delle celle

Quando un testo e molto lungo o un numero ha molte cifre occorre allargare le colonne. 

●     Nel primo caso il testo è visualizzato troncato 
●     Mentre nel secondo appaiono dei caratteri ######

Per allargare le colonne occorre posizionarsi nella zona grigia 
dove ci sono le lettere. 
Quando compare il cursore con la doppia freccia  fare doppio 
click e la colonna si adatta alla lunghezza ottimale

2.1.4 Funzionalità simili a Word

Molte delle funzioni viste in Word sono applicabili anche in Excel:

●     Annullare, ripristinate
●     Salvare, Salvare con nome, uscire
●     Tagliare, Copiare, Incollare
●     Trovare, Sostituire

http://www.centroreiki.org/abaco/manuali/T_Corso_Avanzato_Excel.htm (6 of 31) [11/11/2002 14.42.45]



Corsi di Informatica - Manuale Corso

2.1.5 Modificare il contenuto di una cella

Normalmente lavorando con Excel ci si trova in modalità navigazione. Per modificare il 
contenuto di una cella, una volta posizionati, si può utilizzare uno dei seguenti modi:

uso della barra della formula

●     Si riscrivere il contenuto digitando 
direttamente sulla tastiera

●     Si utilizza la barra della formula 
●     Si preme F2 e si modifica direttamente 

nella cella scelta
●     Si fa doppio click sulla cella

Il contenuto di una cella varia:

●     Dando INVIO
●     Confermando con  ella barra della formula
●     Con il tasto di Tabulazione 

Se non si vuole cambiare il contenuto di una cella prima di aver confermato 

●     Si preme basta dare ESC.
●     Si preme il bottone  nella barra della formula

2.1.6 Spostare le celle

Oltre ad utilizzare il metodo di Taglie e Incolla è possibile spostare le celle selezionate 
trascinandole:

In questo caso occorre schiacciare e tenere premuto sulla 
"cornice" nera delle celle selezionate.
Mentre ci si sposta la cornice grigia indica il punto in cui 
saranno inserite le celle.

2.1.7 Cancellare il contenuto di una cella

Per cancellare il contenuto di una cella si usa semplicemente Canc. Se per esempio la 
cella era in grassetto, questo attributo rimane anche dopo la cancellazione. Per 
cancellare "tutto" occorre selezionare Modifica > Cancella > Tutto. 

2.1.8 Inserire righe e colonne
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●     Per inserire una riga sopra alla cella in cui ci troviamo si seleziona Inserisci > Riga 
●     Per inserire una colonna a sinistra della cella in cui ci troviamo si seleziona 

Inserisci > Colonna 
●     Per inserire una cella si seleziona Inserisci > Celle. La nuova cella può essere 

inserita spostando in basso o a destra le celle che sono al di sotto o a destra della 
cella corrente.

2.1.9 Eliminare righe e colonne

Per cancellare il contenuto delle celle un modo molto comodo è quello di cancellare 
direttamente le righe o le colonne.

1.  Si seleziona la riga/e o la colonna/e.
2.  Si seleziona Modifica > Elimina.

2.1.10 Formato celle

Le celle possono contenere vari tipi di dati. A seconda del dato è possibile cambiarne la 
rappresentazione. Per Es. la data può essere rappresentata come 26/02/1995 oppure 
26 Febbraio 1995. 

La scelta di come visualizzare avviene selezionando Formato > Celle. 
La Categoria permette di scegliere:

●     Generale (usato normalmente)
●     Numero. Molto utile per impostare il separatore delle migliaia (cioè il punto tra 22 

e 945 se scrivo 22495)
●     Valuta. Se si inserisce il simbolo £, $ ecc.
●     Contabilità. Simile a Valuta non consente di rappresentare in rosso i numeri 

negativi
●     Data. Per rappresentare le date
●     Ora. Per le Ore
●     Percentuale. Per le percentuali
●     Testo. Comodo per i CAP e i CF
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2.1.10.1 Come inserire lo "0"

Per inserire i numeri preceduti dallo "0", caso tipico dei codici postale di Roma ("00100") 
occorre fare precedere il numero da un apostrofo. '00100 sarà scritto come 00100 
mentre 00100 è riconosciuto come il numero 100.

2.1.10.2 Andare a capo nella stessa cella

Per andare a capo nella stessa cella basta premere ALT + INVIO.
Per fare in modo che questo avvenga automaticamente si seleziona 
Formato > Celle > Allineamento e si fa click su testo a capo

2.1.11 Le serie

Excel consente facilmente di riempire le celle utilizzando le serie. Se si vogliono scrivere i 
giorni della settimana su una colonna basterà:
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1.  Scrivere lunedì e confermare con INVIO.
2.  Ritornare sulla cella dove è stato scritto lunedì.
3.  Trascinare (schiacciare e tenere premuto) il quadratino nero 

che si trova in basso a destra della cella. Mentre si scende 
nelle celle saranno scritti i giorni della settimana.

Questo è possibile anche per le righe, in questo caso ci si sposta in orizzontale. 

La serie:
· Aumenta - andando in basso/ a destra
· Diminuisce - andando in alto/ a sinistra

Le serie già impostate sono 
· Giorni della settimana (lunedì,…; lun, …)
· Mesi (gennaio,…)
· Date: basta scrivere la data e trascinare. 

Per creare serie di numeri occorre lavorare con un intervallo di due celle. 

Per avere i numeri dispari 
1. Scrivere 1 e nella cella sotto 3. 
2. A questo punto selezionare entrambe le celle 
3. Facendo click sul bottone nero (quando compare la croce nera ) si 
trascina in basso

2.2 Le formule

Le formule consentono di eseguire una serie di operazioni sulle celle, dalla semplice 
somma fino a funzioni complesse. Una formula è costituita da due elementi

●     le celle da includere nella formula
●     gli operatori che determinano il tipo di calcolo da eseguire

Le formule iniziano sempre con il segno di uguale =

2.2.1 Una formula semplice: la copia di un'altra cella

Se volgiamo visualizzare nella cella B1 quello che è inserito nella cella A1 basterà
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1.  Selezionare la cella B1
2.  Scrivere =A1 oppure scrivere solo = e fare click sulla cella A1

Ciò che sarà visualizzato nella cella B1 varierà a seconda del contenuto della cella A1

Le formule più complesse richiedono l'uso di operatori aritmetici. Ecco un elenco di quelli 
disponibili:

Operatore Significato

+ Addizione

- Sottrazione

* Moltiplicazione

/ Divisione

% Percentuale

^ Elevamento a potenza

& Concatena testi

La formula =B2+(B2*20%) 
calcola il 20% del contenuto della cella B2 e lo somma.

2.2.2 Una formula semplice: la somma automatica

Per eseguire automaticamente la somma su un gruppo di celle si utilizzerà il bottone 
somma automatica

●     Posizionarsi sulla cella in cui si vuole inserire la somma
●     Premere il bottone somma automatica
●     Selezionare l'intervallo della somma. Automaticamente Excel 

propone le celle contigue contenenti numeri che si trovano sopra 
la cella selezionata. Se non vengono trovati numeri, saranno 
proposte le celle che si trovano a sinistra.

●     Confermare con INVIO o con 

2.2.3 Sintassi delle formule

Le formule sono caratterizzade da avere un nome e una serie di argomenti (anche 
nessuno).
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= nome (arg1; arg2; .. ; argn)

Gli argomenti sono separati da punto e virgola. Quando l'argomento è un intervallo di 
celle, viene usata al sintassi prima_cella:ultima_cella. Nell'esempio della somma 
A1:A5 significa sommare tutte le celle comprese da A1 ad A5

2.3 Una semplice rubrica ovvero un database

Con Excel è facile creare una rubrica. Vedremo come è anche semplice ordinarla e fare 
altre operazioni. E' comodo e conveniente scrivere gli elementi (campi) che costituiscono 
il database nella prima riga

2.3.1 Ordinamento di una tabella

Per ordinare la tabella è comodo fare click sulla cella A1 oppure la si seleziona.

1.  Selezionare Dati > Ordina .
2.  Scegliere la prima chiave di 

ordinamento (Nome, Via, Città, 
Telefono). 
Questo accade perché Excel 
riconosce la prima riga come di 
intestazione

3.  Scegliere la direzione (crescente o 
decrescente)

4.  Eventualmente scelgiere altre chiavi 
(Quindi per)

5.  Avviare l'ordinamento con OK

L'ordinamento delle celle è anche possibile con i bottoni Ordinamento 
crescente e Ordinamento decrescente. In questo caso è importate 
selezionare attentamente l'area su cui eseguire l'ordinamento altrimenti verranno 
ordinate solo una parte delle celle. 
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2.4 Impostazione della pagina

E' possibile impostare la pagina sia da File > Imposta Pagina che dall'anteprima di 
stampa agendo sul bottone Imposta. Le varie schede consentono di effettuare le 
seguenti modifiche:

Pagina
Oltre a modificare l'orientamento è molto comodo utilizzare l'Adatta
Quando una tabella non ci sta su un foglio è possibile ridurla adattandola a una pagina di 
altezza e una di larghezza.

Margini
Oltre a modificare tutti i margini è possibile centrare orizzontalmente e verticalmente la 
pagina rispetto al foglio.

Foglio
Una opzione molto utile in questo menù è griglia che permetterà di stampare i dati con 
una griglia grigia.

Intestazione e piè di pagina
Il bottone personalizza l'intestazione permette di lavorare sull'intestazione del 
documento. Le finestre A Sinistra, In Centro, e A Destra consentono di scrivere nei 
vari punti dell'intestazione. 
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Utilizzando i seguenti bottoni è possibile inserire:

Con questo bottone, una volta selezionato il testo, è possibile modificarne il formato

Numero di Pagina

Numero Totale di Pagine

Data

Ora

Il nome del file

Il nome della scheda

Il bottone personalizza piè di pagina lavora nello stesso modo.

2.4.1 Area di stampa

Normalmente quando si stampa viene selezionate le celle da A1 fino alla cella più in 
basso a destra che contiene dati. E' possibile cambiare l'area di stampa selezionando File 
> Area di stampa > Imposta Area di stampa. 

Un'altra tecnica per non stampare delle righe o delle colonne è quella di nasconderle. In 
questo caso una volta selezionate le righe (o colonne) da non stampare dare il comando 
Formato > Riga > Nascondi. Le Righe o colonne nascoste potranno riapparire 
selezionando tutta la tabella e agendo con Formato > Riga > Scopri. 

2.5 Formule avanzate

2.5.1 Riferimenti relativi ed assoluti
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Nelle formule in Excel, quando indichiamo una cella automaticamente utilizziamo un 
riferimento relativo. Questo ci permette di creare rapidamente delle tabelle. In alcuni 
casi occorre però utilizzare i riferimenti misti ed assoluti:

2.5.2 Riferimento relativo

Varia secondo il punto in cui è copiata la formula.

2.5.2.1 Es. Calcolo dell'I.V.A. e del prezzo lordo

Nella tabella sono state inserite le seguenti formule

Queste formule sono relative, infatti, se abbiamo più articoli possiamo selezionare le 
formule e trascinarle in modo da non doverle riscrivere:

Le formule che sono riportate nelle altre celle sono corrette. Nella cella C4 avremo, 
infatti, =B4*20% quindi automaticamente B2 è stato trasformato in B4

Questo avviene perché si può immaginare che nella cella C2 invece che "B2" ci sia stato 
scritto "la cella immediatamente a sinistra". 

Questa informazione è relativa alla cella in cui mi trovo. Quando si copia nelle altre celle 
questa formula, automaticamente Excel la traduce con il riferimento reale alla cella da 
utilizzare (lettera e numero).
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2.5.3 Riferimento assoluto

Si riferisce sempre alla stessa cella indipendentemente dall'area del foglio di lavoro in cui 
sarà copiata o incollata la formula.

2.5.3.1 Es. Calcolo dell'I.V.A. e del prezzo lordo

Nell'esempio precedente il valore 20% era scritto in ogni cella della colonna C. Se 
questo valore dovesse cambiare saremmo costretti a riscrivere tutte le formule. 

L'ideale è scrivere questo valore in una cella particolare e fare sempre riferimento a 
questa. 

La formula =B3*C1 però non funziona correttamente. Appena trasciniamo in giù la cella 
C3 otteniamo delle formule errate:

Nella cella C4 la formula è errata perché fa riferimento alla cella C2 e non alla cella C1 
(20%). Questo perché nella formula contenuta in C3 c'è scritto = B3*C1 "moltiplica 
per il contenuto della cella che si trova due passi sopra" cioè C1.

Per fissare la cella C1 dobbiamo utilizzare il riferimento assoluto che si ottiene inserendo 
il carattere "$".
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La formula corretta da inserire in C3 diventa =B3*$C$1. Se trasciniamo questa formula 
otteniamo risultati corretti. 

La formula nella cella C5 è corretta perché fa riferimento alla cella C1.

2.5.4 Riferimento misto

Sono riferimenti in cui una parte dell'informazione è relativa mentre l'altra è assoluta.
ES C$1. La colonna C è relativa (e quindi varia se trascino la formula) la riga 1 è fissa.

2.5.4.1 Es. Calcolo delle valute

Volgiamo calcolare il prezzo degli articoli in base alle valute indicando nella prima riga il 
cambio odierno. 

La formula =B3*C$1 in questo caso non è corretta perché vale solo per la colonna C. 
Infatti, se copiassimo questa formula sulle altre celle continueremo ad utilizzare il cambio 
del Dollaro, (C1) e non utilizzeremmo più i dati nella colonna B

La formula corretta da inserire è invece =$B3/C$1. In questo modo copiando la formula 
su tutte le celle ottengo dei valori corretti:

= $B 3/C $1  
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Colonna
Assoluta 

Riga
Assoluta 

2.6 Database

Un elenco o rubrica può essere facilmente gestito da Excel. Normalmente un elenco di 
dati è definito database.

Definizioni

Database Elenco

Campo Colonne dell'elenco 

Nome del Campo Etichette di colonna dell'elenco

Record Ciascuna riga dell'elenco

Nel database d'esempio abbiamo i campi:
N, Nome, Via, Cap, Città, Pr, Tel, Data, Importo

Nome Via CAP Città PR Tel Data Importo 

A.S. Ticinia 
Robecchetto 

Via Ugo 
Foscolo, 12 20020 Robecchetto 

Con Induno MI 0331 
876508 27/04/2000 175,15 

Abaco 
Francesco 

Via 
Valcamonica, 
13 

21100 Varese VA 0332 
334495 10/03/2000 554,83 

Abate Nicola Piazza Del 
Popolo, 4/9 20020 Robecchetto 

Con Induno MI 0331 
875913 06/04/2000 470,96 

Abate Prof. 
Pietro Via Majella, 36 21100 Varese VA 0332 

333231 05/04/2000 397,95 

2.6.1 I filtri

Con i filtri è possibile selezionare solo una parte dei dati nell'elenco. Il vantaggio è di 
poter visualizzare ed eventualmente stampare solo quei dati che rispondono ad un 
preciso criterio.

2.6.1.1 Per attivare il filtro 

1.  Fare click sulla cella A1 per filtrare tutta la tabella.
2.  Selezionare Dati > Filtro > Filtro automatico.

Una volta attivato il filtro compaiono dei bottoni in corrispondenza dei campi del 
database:
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Nella figura è stato fatto click sul bottone in corrispondenza a Città. Facendo click su 
Turbigo si selezioneranno tutti i record di Turbigo.

2.6.1.2 Per disattivare il filtro 

Per disattivare il filtro si seleziona ancora Dati > Filtro > Filtro automatico.

2.6.1.3 Tipi di filtro 

Una volta fatto click su un bottone si può scegliere:

●     Tutto Vengono visualizzati tutti i record 
●     Primi 10 Poco usato visualizza i primi 10 record
●     Personalizza Permette di scegliere i record in base a criteri personali
●     Valore Visualizzati i record in base al valore scelto
●     Vuote Seleziona i record che non contengono dati
●     Non vuote Seleziona i record che contengono dati

2.6.1.4 Personalizza

E' possibile personalizzare la ricerca dei record:

Le scelte possibili sono:

●     uguale a
●     diverso da
●     è maggiore di
●     è maggiore o uguale a
●     è minore di
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●     è minore o uguale a
●     inizia con
●     non inizia con
●     finisce con
●     non termina con
●     contiene
●     non contiene

Nel database d'esempio se volessimo selezionare tutte le persone di nome Anna 
potremmo utilizzate contiene Anna (verrebbero trovate anche le persone di nome 
Annalisa).

La personalizzazione permette anche di utilizzare un secondo criterio. 
· AND significa che anche il secondo criterio deve essere valido
· OR basta che uno dei due criteri sia valido.

2.7 Visualizzazioni

Quando si visualizza un database di grandi dimensioni può essere difficile scorrerne il 
contenuto perché i nomi dei campi e i nomi sulle colonne scompaiono.
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Per fare in modo che la riga d'intestazione e le colonne contenenti Nome e Cognome 
siano sempre visibili si utilizza blocca riquadri.

2.7.1 Blocca riquadri

1.  Selezionare la cella al disotto delle righe e a destra delle colonne da bloccare.
2.  Selezionare Finestra > Blocca riquadri.

Nell'esempio è stata selezionata la cella E2 e poi dato il comando blocca riquadri. In 
questo modo la prima riga e le colonne A, B, C e D sono sempre visibili.
NOTA Questo non è riportato nella stampa.

2.7.2 Sblocca riquadri

Per rimuovere le righe e colonne bloccate basta selezionare Finestra > Sblocca riquadri

2.7.3 Nascondere le righe e colonne

Quando si stampa un documento Excel può esserci l'esigenza di nascondere delle righe o 
colonne. Sarà illustrato il procedimento per nascondere e scoprire le colonne. Questo 
procedimento è simile per le righe. E' inoltre possibile nascondere più righe/colonne 
anche separate (ES colonna B, E, F …)
Nel Database d'esempio non si vuole stampare la colonna St contenete l'informazione 
"stampa il record" tramite il procedimento stampa e unione di Word.
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2.7.3.1 Per nascondere una colonna

1.  Selezionare la colonna (anche più di una)
2.  Selezionare Formato > Colonna > Nascondi

Ora la colonna è nascosta

2.7.3.2 Per Scoprire una colonna

1.  Selezionare le colonne adiacenti a quella (quelle) nascoste
2.  Dare il comando Formato > Colonna > Scopri

Ora la colonna è riapparsa
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2.7.4 Area di stampa

Se l'esigenza è di stampare solo una pozione di tabella può essere utile utilizzare Area di 
Stampa.

2.7.4.1 Imposta Area di stampa

1.  Selezionare le celle che si vogliono stampare
2.  Selezionare File > Area di Stampa > Imposta Area di Stampa

Per verificare la correttezza dell'area bisogna andare in Anteprima di stampa.

2.7.4.2 Cancella Area di stampa

L'area di stampa impostata è memorizzata quando salviamo il documento Excel. Per 
eliminare l'area di stampa impostata bisogna:
Selezionare File > Area di Stampa > Cancella Area di Stampa

NOTA: Per visualizzare l'area di stampa, utilizzare Visualizza >Anteprima 
interruzioni di stampa.

2.7.5 Stampa dell'intestazione

Quando si stampa un database di grandi dimensioni nelle pagine successive alla prima 
non appare la riga (righe) d'intestazione. Per fare in modo che questa riga appaia (ed 
eventualmente anche le colonne) occorre procedere come segue:

2.7.5.1 Creazione dei Titoli

1.  Selezionare File > Imposta Pagina.
2.  Fare click sulla scheda Foglio.
3.  Fare click sul campo Righe da ripetere in alto.
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4.  Fare click il bottone sulla destra  in modo da visualizzare completamente il foglio 
di Excel.

5.  Selezionare la riga da ripetere su tutti i fogli durante la stampa. Saranno indicate le 
righe nel formato assoluto cioè $1:$1 significa la prima riga.

6.  Fare click sul bottone  per chiudere la finestra righe da ripetere in alto e 
ritornare nella finestra Imposta pagina.

7.  Confermare con OK

Ora durante la stampa in tutti i fogli comparirà sempre la prima riga.

Il procedimento può essere applicato a più righe ed anche alle colonne.

2.7.5.2 Cancellazione dei Titoli

1.  Selezionare File > Imposta Pagina.
2.  Cancellare le informazioni in righe da ripetere in alto (e anche colonne se utilizzato)
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2.8 I grafici

2.8.1 Tipi di grafici

I grafici prodotti da Excel sono fondamentalmente di due tipi

●     A una dimensione per dati che sono su una singola linea o colonna: 
Grafici a Torta, ad Anello, Radar

●     A più dimensioni quando si utilizzano aree di dati: 
❍     Grafici Istogramma, 
❍     Barre, 
❍     Linee, 
❍     Dispersione, 
❍     Area, 
❍     Superficie, 
❍     Bolle, 
❍     Azionario, 
❍     Cilindri, 
❍     Coni, 
❍     Piramidi

2.8.2 Creare i grafici

Excel consente facilmente di creare i grafici utilizzando lo strumento autocomposizione 
grafico . I passi da seguire sono i seguenti:

1.  Selezionare l'area dei dati su cui si vuole costruire il grafico. ES di dati

 1985 1985 1985

Gennaio 52 43 95

Febbraio 7 44 34

Marzo 78 52 35

Aprile 70 94 64

Maggio 26 75 67

NOTA: non includere nella selezione dei dati righe e colonne vuote, né celle con dei 
totali. Per selezionae intervalli di celle discontinui occorre mantenere premuto il 
tasto CTRL.
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2.  Selezionare Inserisci > Grafico oppure il bottone autocomposizione grafico.

3.  Nel Primo passaggio scegliere il tipo di grafico a seconda dell'area dei dati scelta.

È possibile avere un'anteprima del grafico tenendo premuto il bottone evidenziato 
in rosso.

Premere Avanti per continuare

4.  Nel Secondo passaggio verificare l'intervallo di dati.
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È possibile variare l'intervallo facendo click sull'intervallo dati e selezionando l'area 
che interessa sul grafico. Aree non adiacenti possono essere selezionate premendo 
contemporaneamente CTRL mentre si selezionano le aree successive.

La serie dei dati può essere disposta per righe o per colonne. 

La scheda Serie permette di precisare ulteriormente i nomi e i valori delle singole 
serie di dati. Questo serve se i dati utilizzati per costruire il grafico non sono 
contenuti nella stessa area selezionata nel passo uno (caso poco frequente).

Il risultato del grafico varia a seconda della scelta come visualizzato sotto con il 
grafico per Istogramma:

Per Colonne Per Righe
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Premere Avanti per continuare.

5.  Nel Terzo Passaggio è possibile:
❍     Inserire un titolo al grafico
❍     Dare un nome ai dati in orizzontale (asse x)
❍     Dare un nome ai dati in verticale (asse y)
❍     Dare un nome ai dati disposti in profondità se presente (asse z)
❍     Specificare il tipo di Asse
❍     Dettagliare la griglia sullo sfondo
❍     Scegliere la posizione della Legenda
❍     Mostrare l'etichetta dei dati
❍     Inserire eventualmente la tabella che contiene i dati su cui è stato costruito il 

grafico.

Inoltre in

❍     Griglia - è possibile aggiungere linee che attraversano il grafico in modo da 
semplificare la lettura dei dati. 
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❍     Legenda - è possibile cambiare la posizione della legenda
❍     Etichetta Dati - scegliere se mostrare il valore o l'etichetta associata ad ogni 

valore
❍     Tabella dati - inserire una tabella contenente i dati su cui è basato il grafico 

Premere Avanti per continuare

6.  Nel Quarto Passaggio occorre decidere dove inserire il grafico: 
❍     Come oggetto in Foglio x significa che il grafico verrà inserito come oggetto 

all'interno del foglio scelto. Potrà essere spostato e modificato come se si 
trattasse di un rettangolo.

❍     Come nuovo foglio nome verrà creato un nuovo foglio all'interno della 
stessa cartella contenente il grafico. 

Qui il grafico è stato inserito all'interno dello stesso foglio. 
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2.8.3 Uso della Barra degli strumenti grafico

La barra degli strumenti grafico consente facilmente di modificare le opzione dei grafici. 
Si attiva selezionando Visualizza > Barre degli strumenti > Grafico.

 

Formato oggetto selezionato

Tipo di grafico

Legenda

Tabella dati

Per Riga

Per Colonna

Inclina Testo in Basso

Inclina Testo in Alto

2.8.4 Modifica dei singoli elementi di un grafico

È possibile selezionare e modificare i singoli elementi che compongono il grafico come 
testi, griglie, ombreggiatura, colori ecc. Per poter modificare un elemento è sufficiente 
fare un doppio click nei punti:

1.  Per modificare l'intero grafico 
2.  per l'etichetta numeri (formato carattere, colore dimensione, ecc.)
3.  colore delle barre
4.  colore di sfondo
5.  legenda
6.  posizionare l'area dati 
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ogni elemento può essere selezionato con un doppio click

 

Word 2000
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3 word 2000 

3.1 Inserimento di grafici e tabelle Excel

Una volta prodotto un foglio o un grafico in Excel è possibile inserirlo in Word.
Per i fogli di lavoro ci sono tre possibilità:

●     Trasformazione del foglio in tabella
●     Inserimento come foglio di lavoro
●     Inserimento come collegamento al foglio di lavoro Excel

3.1.1 Copia da Excel

1.  Aprire il foglio di Excel
2.  Selezionare le celle da copiare
3.  Selezionare Modifica > Copia

3.1.2 Trasformazione del foglio in tabella

1.  Aprire il documento Word
2.  Selezionare Modifica > Incolla

E' creata una normale tabella Word. Il risultato è il seguente:

3.1.3 Trasformazione del foglio in Foglio di Lavoro Excel

1.  Aprire il documento Word.
2.  Selezionare Modifica > Incolla Speciale
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Scegliere Oggetto Foglio di lavoro Microsoft Excel e dare OK. Il risultato è il 
seguente:

E' stato creato un foglio Excel all'interno di Word. Questo foglio è un oggetto grafico 
e può essere allargato o rimpicciolito. Inoltre può essere modificato come se 
stessimo lavorando don Excel facendovi sopra doppio click. 

3.1.4 Trasformazione del foglio in collegamento alla tabella

1.  Aprire il documento Word
2.  Selezionare Modifica > Incolla Speciale
3.  Scegliere Incolla collegamento e Oggetto Foglio di lavoro Microsoft Excel 

e dare OK

http://www.centroreiki.org/abaco/manuali/T_Corso_Avanzato_Word.htm (2 of 11) [11/11/2002 14.43.04]



Corsi di Informatica - Manuale Corso

Il risultato è apparentemente simile al precedente ma se si effettuano delle 
modifiche sul foglio Excel originale, queste si riflettono anche nella tabella contenuta 
in Word.

NOTA se si copia su un dischetto il documento Word per portarlo su un altro 
Computer occorrerà copiare anche la tabella Excel con cui abbiamo creato il 
collegamento.

3.1.5 Grafici

La procedura è simile. Si selezionerà il grafico e per incollare attraverso Incolla 
speciale si dovrà scegliere Oggetto Grafico Microsoft Excel.
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La scelta tra Incolla e Incolla collegamento dipende se si vuole fissare o rendere 
sensibile alle modifiche il grafico.

3.2 Stili

Per ottenere documenti più accurati si possono utilizzare gli stili. Con questo sistema 
è possibile assegnare a parti di testo le stese caratteristiche. Inoltre, è possibile in un 
solo colpo modificare l'aspetto del testo in tutti i punti del documento in cui è stato 
assegnato lo stile. Solitamente lo stile utilizzato da Word è normale. 

3.2.1 Creazione di uno stile

Per definire uno stile occorre

1.  Formattare una parte di testo nel modo desiderato (attribuendo tipo e 
dimensione carattere, allineamento, ecc. - vedi formato > carattere).

2.  Fare click sulla casella stile e digitare il nuovo nome.
3.  Confermare con Invio

Lo stile così creato è associato al documento corrente e non al modello utilizzato per 
la stesura di nuovi documenti
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3.2.2 Applicare uno stile

1.  Selezionare il testo su cui si vuloe applicare lo stile.
2.  Dalla casella stile selezionare lo stile appena creato.

Ora il testo apparirà secondo lo stile selezionato.

3.2.3 Modificare uno stile

Per modificare uno stile occorre

1.  Selezionare un testo su cui è stato applicato lo stile.
2.  Modificare la formattazione.
3.  Selezionare il nome dello stile dalla casella stile e premere invio. 
4.  Nella finestra Modifica lo stile scegliere Ridefinire lo stile utilizzando il 

testo selezionato come esempio. 
5.  Se si vuole che la modifica dello stile venga applicata automaticamente occorre 

fare click sulla casella Aggiorna automaticamente lo stile. 
6.  Confermare con OK
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3.2.4 Gestione degli stili

È possibile gestire gli stili dalla finestra stile selezionando Formato > Stile.
Selezionando lo stile desiderato è possibile vedere quali sono tutti i paramerti di 
formattazione applicati.

3.2.4.1 Modifica di uno stile

Per modificare uno stile occorre
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1.  Fare click sul bottone Modifica.
2.  Attivare aventualmente Aggiorna Automaticamente.
3.  Fare click su Formato e selezionare opportunamente 

❍     Carattere
❍     Formato
❍     Paragrafo
❍     Bordo
❍     Lingua
❍     Cornice
❍     Numerazione.

4.  Una volta effettuata la modifica dare OK.
5.  Chiudere la finestra Stile con Applica

Lo stile ora è aggiornato.

3.3 La struttura di un documento, il sommario
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Attraverso la definizione dei titoli (Titolo1, Titolo2, Titolo3, ecc.) è possibile 
strutturare un documento. Grazie a questo sistema Word è in grado di creare 
automaticamente il sommario.

3.3.1 Assegnazione dei titoli

Durante la stesura del documento posso utilizzare gli stili Titolo1, Titolo2, ecc. 
selezionando la riga e attribuendo l'opportuno stile con la casella stile.
Se il testo è già stato redatto senza assegnare dei titoli posso utilizzare: la 
visualizzazione per struttura

3.3.1.1 Visualizzazione della struttura

Si seleziona Visualizza > Struttura. Il documento apparirà come segue:

La parte sulla sinistra permette di riconoscere facilmente quali sono le rige a cui 
assegnare i vari titoli. 
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Il segno (+) indica che la riga ha dei sottolivelli mentre (-) indica che non ve ne 
sono.
Per arrivare nel punto del testo in cui compare la riga bassa fare un click sempre 
nella zona a sinistra. E molto comodo utilizzare la barra degli strumenti struttura.

3.3.1.2 Barra degli strumenti struttura

 

Alza Livello

Abbassa Livello

Abbassa a Livello di Corpo del Testo

Sposta in Alto

Sposta in Basso

Espandi Mostra tutti i titoli subordinati a una selezione

Comprimi nasconde tutti i titoli subordinati a una selezione

Mostra Titolo di livello inferiore o uguale a n

Espade l'intera struttura fino al corpo del testo

Mostra solo la prima riga di ciascun paragrafo

Mostra/ Nascondi la Formattazione

Visualizza Doc Master

3.3.2 Creazione del Sommario

La creazione di un sommario è molto semplice. Il sommario non è altro che l'insieme 
di tutte le righe che abbiamo definito con lo stile Titolo.

3.3.2.1 Come creare un sommario

1.  Posizionarsi nel punto in cui si vuole inserire il sommario.
2.  Scegliere Inserisci > Indici e sommario.
3.  Definire : 

❍     Carattere di riempimento tra il titolo e il numero di pagina
❍     Il livello di titolo. (Eventualmente utilizzare le Opzioni)
❍     La presenza dei numeri di pagina
❍     L'allineamento dei numeri di pagina
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4.  Dare ok. 

Il sommario viene così creato, ma non sarà modificato automaticamente se 
cambiamo il numero di pagine del documento o inseriamo dei nuovi titoli.

3.3.2.2 Modifica del sommario

Una volta inserito il sommario può essere modificato nel seguente modo:

1.  Fare click sul testo che compone il sommario con il tasto destro del mouse.
2.  Scelgliere aggiorna campo.
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3.  Se sono state aggiunte / tolte pagine durante la stesura del testo scegliere 
Aggiorna solo i numeri di pagina, altrimenti scegliere Aggiorna l'intero 
sommario.
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1 Introduzione

1.1 Cos'è Internet

Oggi Internet è uno strumento di comunicazione che permette di accedere ad una 
grande banca dati. Attraverso un linguaggio di trasmissione comune (protocollo 
TCP/IP) due dispositivi/macchine di diverso tipo sono in grado di colloquiare tra 
loro.

1.2 La storia

Internet (INTERconnected NETworks), nacque in California alla fine degli anni 
Sessanta dal progetto ARPAnet, a fronte dell'esigenza del Ministero della Difesa di 
creare una rete di interconnessioni in grado di sopravvivere ad un eventuale 
"attacco nemico", con il compito principale di consentire ai militari, per conto del 
Ministero della Difesa, di scambiare dati ed informazioni (ARPA è, infatti, l'acronimo 
di Advanced Research Projects Agency).

Per molti anni Internet è stato utilizzato dai ricercatori delle università per lo 
scambio di informazioni tra loro (posta elettronica) e per parlare di specifici 
argomenti (gruppi di discussione).
Il grande boom di Internet si ebbe dopo la nascita del World Wide Web Frutto di un 
progetto del Cern di Ginevra e dalla creazione delle Pagine Web.

1.3 Pagina Web

Sono pagine che possono contenere:

Testo Suoni

Immagini Collegamenti ad altre pagine o link ipertestuali
Collegamenti alla posta elettronica

Bottoni Moduli da compilare per la richiesta di informazioni

1.4 Sito

Le pagine Web sono raccolte nei siti che possono essere considerati come dei 
"giornali elettronici" con un proprio nome ad esempio il sito 
http://www.centroreiki.org
Grazie ad un sistema di gestione degli indirizzi (database) ad ogni computer 
collegato nella rete Internet è associato un nome e un indirizzo numerico.

1.5 Struttura degli indirizzi URL
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4.1 L'indirizzo

5 MS OUTLOOK 
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5.1 Le cartelle 
Locali
5.2 
Composizione di 
un messaggio
5.3 Invio di un 
messaggio
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7.6 Salvataggio 
della ricerca
7.7 Modifica di 

Per individuare una risorsa sulla rete è stata creata una regola universale per 
indicare gli indirizzi o URL Universal Resource Location. Gli indirizzi sono sempre 
scritti in minuscolo e hanno la seguente struttura:

http://www.miosito.it/pagina.html

http://
opzionale tipo di server (computer di rete) che si desidera 
contattare e il protocollo utilizzato per dialogare (Hyper Text 
Transfert Protocol)

www dominio di 3° livello: tipo di servizio (www sta per World Wide 
Web)

miosito dominio di 2° livello: nome del sito

it dominio di 1° livello: paese o ente che possiede il computer 
associato al nome

/pagina.html opzionale nome della pagina

L'indirizzo è tradotto in una serie formata da quatto numeri (Es. 124.123.12.71) da 
un sistema chiamato DNS Domain Name Service. Attraverso questo numero è 
individuato univocamente il computer che ospita la pagina sulla rete.

1.5.1 I domini di Primo livello

Sono di due tipi quelli associati a organizzazioni e quelli associati a nazioni. Al 
momento della nascita del sistema DNS Internet era diffuso negli Stati Uniti. Erano 
stati creati dei domini a seconda delle organizzazioni.

com Organizzazioni di tipo commerciale

edu Enti di ricerca ed università

gov Enti governativi statunitensi

net Organizzazioni impegnate nella gestione 
della rete

mil Organizzazioni militari

org Organizzazioni ed enti privati che non 
rientrano nelle categorie precedenti

Con il diffondersi di Internet nel mondo sono stati creati dei nuovi nomi di dominio 
divisi per nazioni. La tabella che segue è solo un esempio.

it Italy

fr Francia 

uk Regno Unito

1.6 Accedere ad una pagina Web

Ci sono tre modi per determinare l'indirizzo Internet di una pagina che si vuole 
vedere:

1.  E' noto. Attraverso la pubblicità, riviste o amici. 
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una ricerca
7.8 Raffinare la 
ricerca
7.9 Scaricare i 
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7.10 Cancellare 
una ricerca
8 APPENDICE

SCRIVICI

 

2.  Si deduce. Se per esempio si vogliono vedere le pagine meteo in Itala 
l'indirizzo può essere www.meteo.it. Se il sito esiste raggiungerò la pagina. 
Normalmente nei siti commerciali per questione di prestigio è utilizzato il 
dominio .com. Es. www.fiat.com 

3.  Si cerca. Utilizzando dei siti appositi chiamati motori di ricerca è possibile 
rintracciare le pagine inerenti ad un determinato argomento.

2 Utilizzo di MS Explorer 5

Explorer 5 è il programma utilizzato per la navigazione (browser). Può essere 
lanciato comodamente dalla scrivania oppure attraverso il bottone nella barra 
degli strumenti.
Sotto la barra del titolo si trovano 

●     la barra dei menu 
●     la barra degli strumenti
●     La casella Indirizzo
●     La barra dei collegamenti (opzionale e personalizzabile)

In basso si trova la barra di stato che visualizza i messaggi delle operazioni in 
corso. 

2.1 Inserimento di un indirizzo

Per inserire un indirizzo basta fare click nell'area bianca della barra degli indirizzi e 
digitare l'URL seguito da INVIO. Se l'indirizzo è già stato visitato basta scriverne 
solo una parte e confermare con INVIO.
Explorer da per scontato che si utilizzi il protocollo HTTP perciò la parte http:// può 
essere omessa.

2.2 I bottoni della barra degli strumenti

Indietro Torna alla pagina precedentemente visitata

Avanti Va alla pagina visitata successivamente

Termina Interrompe il prelevamento dei dati dal sito corrente

Aggiorna richiede la pagina aggiornata

Pagina iniziale richiede la pagina aggiornata

Cerca permette la ricerca di argomenti alcuni 
motori di ricerca (si può personalizzare)
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Preferiti Siti preferiti preimpostati (si può personalizzare)

Cronologia elenco cronologico dei siti visitati

Posta Attiva Outlook Express per la gestione 
della posta elettronica

Stampa Stampa la pagina visualizzata

2.3 Barra dei collegamenti

Pagine Microsoft per la gestione dei canali, elenco migliori siti, informazioni su 
Explorer, Pagina di informazioni di Microsoft. La barra è personalizzabile.

2.4 Apertura di una nuova pagina

E' comodo mentre si aspetta il caricamento di una pagina lavorare 
contemporaneamente su un'altra per visitare un altro sito. Per aprire una nuova 
finestra dare File > Nuovo > Finestra oppure CTRL + n. E' possibile aprire tante 
finestre quanto si vuole tende

2.5 Salvataggio della pagina

Explorer permette di salvare automaticamente sia il testo sia le immagini della 
pagina che stiamo vedendo. Per fare ciò viene creata una cartella che contiene tutte 
le immagini utilizzate nella pagina che viene salvata. Con questo sistema è possibile 
consultare la pagina in un secondo momento senza essere collegati. Il comando si 
trova in File > Salva con nome.

Un'altra possibilità è di selezionare parte di testo con il mouse e dare il comando 
con il tasto di destra di copia.
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2.6 Salvataggio delle immagini

Per salvare un'immagine basta fare click con il tasto di destra del mouse e 
selezionare Salva immagine con nome .

2.7 I siti preferiti

I siti che si desidera visitare abitualmente possono essere memorizzati nei siti 
preferiti. In questo modo il sito è facilmente richiamabile utilizzando il bottone 
preferiti. Per aggiungere il nome (e l'indirizzo associato) del sito basta dare dal 
menu Preferiti > Aggiungi ai preferiti .

Con il bottone Nuova cartella è possibile creare una nuova cartella entro cui inserire 
la pagina

3 Motori di ricerca

Sono siti che mettono a disposizione dei programmi che sono in grado d effettuare 
una ricerca automatica basata sulle parole fornite dall'utente. 
Per questo argomento esiste anche una guida su Internet al sito 
www.motoridiricerca.it.

3.1 Alcuni Motori

3.1.1 Alcuni Motori Italiani

●     www.arianna.it
●     www.lycos.it
●     www.virgilio.it - diviso per categorie
●     www.yahoo.it - diviso per categorie

3.1.2 Alcuni Motori Internazionali
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●     www.altavista.com
●     www.excite.com 
●     www.goto.com
●     www.hotbot.com
●     www.infoseek.com
●     www.lycos.com
●     www.northernlight.com
●     www.webcrawler.com
●     www.yahoo.com - diviso per categorie

Per attivare la ricerca si specificano uno o più parole (le chiavi) e dei criteri di 
esclusione o di inclusione di argomenti con appositi simboli. Alcuni motori 
consentono di ricercare solo in certi tipi di sito, per limitare la ridondanza delle liste 
risultanti dalla ricerca.
Il risultato della ricerca è una serie di pagine con collegamenti ipertestuali ad altre 
pagine.

Link ipertestuale 

si passa ad un'altra pagina

3.2 Regole per inserimento delle chiavi

Se si vuole effettuare la ricerca su scultura greca occorre tenere conto che 

- scultura greca troverà tutti i siti che parlano sia della scultura che di greca

- "scultura greca" troverà tutti i siti che parlano sia della scultura greca

Per avviare la ricerca basta scrivere le parole chiavi e dare INVIO o fare click su 
SEARCH

Nel caso di siti organizzati per categorie è possibile partire da una categoria e 
seguire le sottocategorie fino ad arrivare all'argomento che interessa.

3.2.1 Operatori speciali

or Oppure: l'operatore or è utilizzato per ricerche che contengono solo alcuni 
dei termini inseriti, per esempio si può digitare riviste or informatica

Not

Non, No: esclude dalla ricerca i documenti che hanno al loro interno una 
certa parola. Se per ex. vogliamo trovare riviste che parlino di informatica 
ma non in formato elettronico (...su Internet) scriveremo la seguente 
stringa di ricerca: riviste not e-zine

- Meno: si può usare al posto di not.

Near

Vicino: non è sempre sufficiente che due termini compaiano in un 
documento perché questo soddisfi i requisiti richiesti, è possibile richiedere 
al motore che i termini siano vicini l'uno all'altro, riviste near computerLa 
distanza massima dei termini è diversa da motore a motore (10, 20, 25 
parole)
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... 

Virgolette: quando si desidera ricercare una precisa sequenza di parole, 
occorre delimitare con le virgolette la stringa da cercare: "riviste di 
informatica, questa è la giusta sintassi per una ricerca formata da più 
parole.

4 La posta elettronica e-mail

Con questo sistema è possibile trasmettere messaggi di testo o file di qualsiasi tipo 
(programmi, immagini, suoni, ecc.),
I documenti trasmessi dal mittente (1) arrivano al server (2) che gestisce il servizio 
di posta elettronica per conto del destinatario e qui restano fino a che il destinatario 
(3) non decide di prelevarli, copiandoli sul suo computer.

I vantaggi di questo sistema sono

●     La velocità - Un messaggio impiega pochi secondi per raggiungere server del 
destinatario.

●     Il costo - Grandi quantità di informazioni possono essere trasmesse al costo 
di una chiamata telefonica verso il server.

●     Affidabilità - A differenza del fax il messaggio è perfettamente leggibile e 
riutilizzabile (può essere inserito in un documento).

●     Più destinatari - Uno stesso messaggio può essere spedito a più destinatari 
contemporaneamente. indicando nella casella dei destinatari gli indirizzi di 
tutte le persone a cui si desidera inviare il messaggio.

Svantaggi

Se un computer non è in rete (caso "domestico") l'unico modo per sapere se è 
arrivata posta è connettersi al fornitore del servizio (provider) e visitare la casella di 
posta elettronica.

4.1 L'indirizzo

Gli indirizzi di posta elettronica e bene che siano scritti in minuscolo e hanno il 
seguente formato:

mionome@provider.dominio 

Un esempio di casella di posta del signor Mario Rossi che è abbonato a Italia On 
Line è il seguente:

mrossi@iol.it 

http://www.centroreiki.org/abaco/manuali/F_Corso_Internet.htm (7 of 22) [11/11/2002 14.44.23]



Corsi di Informatica - Manuale Corso Base

Sulla tastiera italiana normalmente per ottenere il carattere @ occorre premere il 
tasto Alt Gr + 

5 MS Outlook Express 5

Al momento dell'avvio, Outlook Express chiede di selezionare (se non è ancora 
stata attivata) la connessione da utilizzare per accedere al servizio di posta 
elettronica. La schermata iniziale della versione 5 del programma è la seguente:

5.1 Le cartelle Locali

Posta in arrivo Contiene i messaggi ricevuti 
(se è in grassetto significa che c'è posta)

Posta in uscita Contiene i messaggi da inviare

Posta inviata Contiene i messaggi inviati

Posta eliminata Contiene la posta che è stata cancellata 
(ma che può essere recuperata)

Quando viene selezionata una particolare cartella in alto appare l'elenco dei 
messaggi contenuti e in basso viene visualizzato il contenuto del messaggio 
selezionato.
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5.2 Composizione di un messaggio

Per comporre un messaggio basta premere il bottone Nuovo messaggio oppure 
scegliere Crea un nuovo messaggio di posta elettronica. Gli elementi 
fondamentali da inserire sono:

A: il destinatario (o i destinatari del messaggio)

Oggetto: il titolo del messaggio

Il testo da inserire nella parte inferiore
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Facoltativi invece sono:

Cc: Copia per conoscenza

Ccn: Copia per conoscenza nascosta 
(il destinatario principale non ne viene informato)

Se la rubrica è stata utilizzata è possibile scegliere il destinatario tra quelli immessi 
in precedenza. Facendo click sul bottone  Appare la finestra Selezione 
destinatari da cui è possibile scegliere il destinatario del messaggio con i bottoni 
A: / Cc. / Ccn
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Alla fine basta dare OK per ritornare alla composizione del messaggio.

5.3 Invio di un messaggio

Una volta creato un messaggio è sufficiente premere il bottone INVIA Se la 
connessione non è attiva (computer non collegato a Internet) il messaggio viene 

automaticamente spostato nella cartella Posta in uscita, dove resta fino al 
momento dell'effettiva trasmissione.

La modalità non in linea consente di scrivere messaggi e risposte senza 
utilizzare il collegamento telefonico. Una volta preparati i nuovi messaggi si 
possono spedire con il comando Invia e Ricevi.

5.4 Utilizzo degli allegati

Attraverso la posta elettronica è possibile inviare altri documenti di qualsiasi 
tipo (programmi, foto, fogli elettronici, ecc.) Per spedire un file lo si può 

trascinare all'interno della finestra del messaggio oppure utilizzare il bottone Allega 
scegliendo il file da inviare.

5.5 Lettura della posta

Nella cartella Posta in arrivo sono presenti tutti i messaggi ricevuti. Se la scritta è in 
grassetto significa che sono arrivati dei nuovi messaggi da leggere. Nella parte 
sotto della finestra è possibile già leggere una parte del messaggio ma per aprirlo 
occorre fare doppio click oppure usare il comando File > apri. 

5.6 Spostamento ed eliminazione di un messaggio
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I messaggi presenti in Posta in arrivo possono essere spostati in altre cartelle di 
sistema. Per eseguire lo spostamento è sufficiente trascinare l'elemento selezionato 
fino alla cartella di destinazione. Per cancellare un messaggio basta selezionarlo e 
premere CANC.

5.7 Salvataggio degli allegati

Un messaggio può contenere dei file allegati (contraddistinti dalla graffetta ). Per 
poterli salvare su disco e sufficiente fare doppio click sul documento indicando la 
cartella di destinazione oppure dare il comando File > Salva allegati (E' molto 
comodo salvare gli allegati sul desktop per un immediato utilizzo successivo).

5.8 Come rispondere a un messaggio

E' possibile inviare una risposta al mittente del messaggio selezionato con il 
pulsante Rispondi Viene presentato un nuovo messaggio con i campi A: e 

Oggetto già compilati. Inoltre vene riportato il testo del documento originario. 
Come al solito per spedire la risposta dare invia. 
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5.9 Come inoltrare a un messaggio

Un messaggio può essere rispedito ad un'altra persona senza aggiunte con il 
comando inoltra.

5.10 La rubrica degli indirizzi

Il pulsante Rubrica consente di gestire la rubrica dei contatti. Questa rubrica 
può contenere molte informazioni che sono utilizzate da altre applicazioni. Per 

aggiungere un nuovo contatto dare Strumenti > Rubrica e successivamente File 
> Nuovo contatto. I dati che sicuramente vanno inseriti sono Il Cognome il 
Nome e l'indirizzo di posta elettronica.
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6 Indirizzi Utili

Nascendo un sito all'ora è difficile avere un'idea di che cosa ci sia su tutta la rete. Ci 
sono siti di links cioè pagine che rimandano ad altre pagine in base ad argomenti .

Indirizzo Servizio

www.100links.com Sito di Links italiano

www.corriere.it l "Corriere della sera

www.ferrovienord.it Orario Ufficiale delle Ferrovie Nord

www.fs-on-line.com Orario Ufficiale delle Ferrovie dello Stato

www.meteo.it Il bollettino meteorologico 

www.paginebianche.it Il servizio 12 su Internet 

www.paginegialle.it Servizio Pagine Gialle

www.repubblica.it La Repubblica

www.motoridiricerca.it Tutto sui motori di ricerca

www.liuc.it Sito Università di CastellanaNella sezione studente è 
possibile scaricare molti programmi "freeware

7 Copernic 2001 Basic

Copernic 2001 è un programma che effettua ricerche sulla rete consultando 
contemporaneamente i più importanti motori di ricerca di Internet. La ricerca può 
essere effettuata sul web in Italia, su tutta le rete, e su una nazione scelta tra le 
sette disponibili in fase di istallazione. Sono disponibili anche le categorie 
Newsgroup, Indirizzi e-mail, Acquisto libri, Acquisto Hardware e Acquisto Software 
che non tratteremo in questo manuale.

I vantaggi offerti da Copernic sono:

1.  Possibilità di definire quanti documenti ottenere come risultato della ricerca 
(Max 1000).

2.  Il risultato della ricerca viene salvato e può essere aggiornato, raggruppato in 
cartelle, ecc.

3.  Possibilità di scaricare documenti corrispondenti per la consultazione offline.
4.  I documenti trovati vengono classificati e visualizzati secondo la loro rilevanza.
5.  Evidenziazione delle parole chiave nei risultati.
6.  Traduzione direttamente nella pagina principale e nella pagina dei risultati 

della ricerca, dei documenti individuati utilizzando Gist-In-Time.
7.  Possibilità di esportare o inviare per e-mail in diversi formati i rapporti relativi 

alle ricerche

7.1 Definizione della ricerca

http://www.centroreiki.org/abaco/manuali/F_Corso_Internet.htm (14 of 22) [11/11/2002 14.44.23]



Corsi di Informatica - Manuale Corso Base

Per iniziare una ricerca si scrive ciò che si vuole cercare nel campo Ricerca Rapida

E' anche possibile specificare in che WEB (Italiano, mondiale, ecc.) efferruare la 
ricerca.

Un altro modo è attraverso il bottone Ricerca. Compare una finestra dove 
possiamo scegliere la categoria di ricerca. Le categorie sbiadite sono 
disponibili solo nella versione completa del programma. Per Query si intende 

la frase o le parole salienti che si vogliono trovare.
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Si sceglie anche il tipo di ricerca:

●     ricerca tutte le parole - i risultati includeranno tutte le parole chiave 
immesse.

●     ricerca qualsiasi parola - i risultati includeranno almeno una parola chiave.
●     ricerca la frase esatta - i risultati includeranno la frase così come è stata 

digitata

una sequenza di parole può essere raggruppata con le virgolette Es. "Albert 
Einstein".

In Dettagli abbiamo le possibilità:

●     indicare il risultato massimo per ogni motore di ricerca (Max 300) 
●     Indicare il numero totale dei risultati desiderati (Max 3000)
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7.2 Aggiornamento dei motori di ricerca

Periodicamente Copernic esegue un aggiornamento per verificare se sono cambiati i 
parametri per effettuare le ricerche. Cerca inoltre se esistono dei nuovi motori da 
aggiungere nella propria lista.

Questa operazione può essere anche saltata.

7.3 Progresso della ricerca

A questo punto una finestra informa sull'andamento dell'interrogazione ai vari 
motori indicando quanti risultati sono stati ottenuti. L'operazione può durare alcuni 
minuti.
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7.4 Analisi della ricerca

I siti ottenuti dalla ricerca vengono ordinati per punteggio.

  

Facendo click sui vari campi è possibile ordinare per Titolo, Indirizzo, Punteggio, 
Motori di ricerca.

I siti più interessanti possono essere marcati con la casella di controllo  in modo 
da essere facilmente ordinati.

7.5 Visualizzazione dei risultati

Il modo migliore per vedere il risultato della nostra ricerca è con il bottone 
Sfoglia 

Viene aperta una finestra con l'elenco di tutti i risultati con:

●     Titolo sito
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●     Parole chiave in giallo
●     Descrizione
●     Elenco dei Motori di ricerca che lo segnalano
●     Indirizzo WEB
●     Punteggio in %

Da questa finestra, come in Explorer, è possibile visualizzare i siti trovati.

Molto comodo l'elenco a discesa Documento per passare da un sito a un altro.

7.6 Salvataggio della ricerca

Copernic salva automaticamente i risultati della ricerca quando si esce dal 
programma. In questo modo è possibile rivedere le ricerche effettuate ogni volta 
che si attiva Copernic.

7.7 Modifica di una ricerca

Una ricerca può essere modificata con il bottone Modifica. Questo può essere 
utile per passare da "ricerca tutte le parole" a "ricerca frase esatta" più 
restrittiva.

7.8 Raffinare la ricerca

È Possibile raffinare una ricerca con il bottone Raffina. 
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Possono essere inseriti gli operatori di ricerca:

●     E - trova solo i documenti contenti tutte le parole o le frasi specificate.
●     O - trova solo i documenti contenti almeno una delle parole o delle frasi 

specificate. I documenti trovati possono contenerle tutte, ma non 
necessariamente.

●     TRANNE - Esclude i documenti contenenti la parola specificata.
●     VICINO - Trova i documenti contenenti le parole specificate separate da un 

massimo di 10 parole

Inoltre

●     Solo parole intere - i documenti rilevanti devono contenere parole intere.
●     Maiuscole/minuscole - i documenti rilevanti devono contenere l'esatta 

combinazione di lettere maiuscole e minuscole delle parole chiave.
●     Rimuovi i documenti non corrispondenti - consente di rimuovere 

automaticamente i documenti non rilevanti ed i collegamenti irraggiungibili.
●     Scarica immagini - consente di scaricare le immagini. Notare che il tempo di 

scaricamento potrebbe aumentare notevolmente se la ricerca contiene molti 
documenti o alcuni documenti con numerose e voluminose immagini.

●     Raffina solo i documenti selezionati - consente di raffinare solo i 
documenti selezionati dalla finestra principale. Per selezionare i documenti, 
fare click su ognuno di essi con il pulsante sinistro del mouse tenendo premuto 
il tasto Ctrl

7.9 Scaricare i documenti

È possibile scaricare su disco i documenti trovati per la consultazione non in 
linea. È possibile applicare tale funzione a tutti i risultati di una ricerca o solo a 
risultati selezionati.

http://www.centroreiki.org/abaco/manuali/F_Corso_Internet.htm (20 of 22) [11/11/2002 14.44.23]



Corsi di Informatica - Manuale Corso Base

Se non vengono scaricate le immagini i documenti salvati sul disco conterranno solo 
il testo ma occuperanno poco spazio.

7.10 Cancellare una ricerca

Una ricerca può essere eliminata:

1.  Selezionandola
2.  Dando Modifica > Elimina e confermando la cancellazione.

8 Appendice

Termine Significato

Browser Detti anche Navigatori, Sono programmi per la visualizzazione 
delle pagine informatiche della rete. (Es. Microsoft Explorer)

Client Programma usato dall'utente per chiedere e ricevere 
informazioni dalla rete 

DNS Domain Name Service - sistema di database per 
l'individuazione dell'indirizzo sulla rete

Hardware Componenti fisici di un computer (schede elettronica ecc.)

Host computer collegato direttamente alla rete in grado di ospitare 
utenti informazioni e posta elettronica

HTML HyperText Markup Language linguaggio standard che consente 
di creare le pagine Web

Interfaccia collegamento tra più unità hardware, tra hardware e software 
e tra software e utente.

Link ipertestuale Parola o immagine da cliccare che rinvia ad un'altra pagina, 
alla posta elettronica, o scarica un file

POP Post Office Protocol - protocollo utilizzato per l'invio della posta

PPP sistema di trasmissione delle informazioni a pacchetto

Server Programma su computer remoto che fornisce i dati.

SMTP Simple Mail Transport Protocol protocollo per la ricezione della 
posta elettronica

Software Programmi
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TCP/IP
Trasmission Control Protocol/Internet Protocol è composto di 
una serie di protocolli che garantiscono il trasferimento dei dati 
dai programmi applicativi sino alla rete

URL Uniform Resource Locator - Indirizzo di una pagina o risorsa 
sulla rete

WWW

World Wide Web, la ragnatela globale. Rende immediatamente 
disponibili le informazioni su Internet. Documenti con testo, 
grafica, suono e video sono facilmente reperibili con 
un'interfaccia immediata da usare anche con il solo mouse.

ZIP File compressi da un particolare programma (winzip) per 
essere trasmessi più velocemente.
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1 Introduzione

1.1 Cos'è Internet

Oggi Internet è uno strumento di comunicazione che permette di accedere ad una 
grande banca dati. Attraverso un linguaggio di trasmissione comune (protocollo 
TCP/IP) due dispositivi/macchine di diverso tipo sono in grado di colloquiare tra 
loro.

1.2 La storia

Internet (INTERconnected NETworks), nacque in California alla fine degli anni 
Sessanta dal progetto ARPAnet, a fronte dell'esigenza del Ministero della Difesa di 
creare una rete di interconnessioni in grado di sopravvivere ad un eventuale 
"attacco nemico", con il compito principale di consentire ai militari, per conto del 
Ministero della Difesa, di scambiare dati ed informazioni (ARPA è, infatti, l'acronimo 
di Advanced Research Projects Agency).

Per molti anni Internet è stato utilizzato dai ricercatori delle università per lo 
scambio di informazioni tra loro (posta elettronica) e per parlare di specifici 
argomenti (gruppi di discussione).
Il grande boom di Internet si ebbe dopo la nascita del World Wide Web Frutto di un 
progetto del Cern di Ginevra e dalla creazione delle Pagine Web.

1.3 Pagina Web

Sono pagine che possono contenere:

Testo Suoni

Immagini Collegamenti ad altre pagine o link ipertestuali
Collegamenti alla posta elettronica

Bottoni Moduli da compilare per la richiesta di informazioni
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1.4 Sito

Le pagine Web sono raccolte nei siti che possono essere considerati come dei 
"giornali elettronici" con un proprio nome ad esempio il sito 
http://www.centroreiki.org
Grazie ad un sistema di gestione degli indirizzi (database) ad ogni computer 
collegato nella rete Internet è associato un nome e un indirizzo numerico.

1.5 Struttura degli indirizzi URL

Per individuare una risorsa sulla rete è stata creata una regola universale per 
indicare gli indirizzi o URL Universal Resource Location. Gli indirizzi sono sempre 
scritti in minuscolo e hanno la seguente struttura:

http://www.miosito.it/pagina.html

http://
opzionale tipo di server (computer di rete) che si desidera 
contattare e il protocollo utilizzato per dialogare (Hyper Text 
Transfert Protocol)

www dominio di 3° livello: tipo di servizio (www sta per World Wide 
Web)

miosito dominio di 2° livello: nome del sito

it dominio di 1° livello: paese o ente che possiede il computer 
associato al nome

/pagina.html opzionale nome della pagina

L'indirizzo è tradotto in una serie formata da quatto numeri (Es. 124.123.12.71) da 
un sistema chiamato DNS Domain Name Service. Attraverso questo numero è 
individuato univocamente il computer che ospita la pagina sulla rete.

1.5.1 I domini di Primo livello

Sono di due tipi quelli associati a organizzazioni e quelli associati a nazioni. Al 
momento della nascita del sistema DNS Internet era diffuso negli Stati Uniti. Erano 
stati creati dei domini a seconda delle organizzazioni.

com Organizzazioni di tipo commerciale

edu Enti di ricerca ed università

gov Enti governativi statunitensi
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net Organizzazioni impegnate nella gestione 
della rete

mil Organizzazioni militari

org Organizzazioni ed enti privati che non 
rientrano nelle categorie precedenti

Con il diffondersi di Internet nel mondo sono stati creati dei nuovi nomi di dominio 
divisi per nazioni. La tabella che segue è solo un esempio.

it Italy

fr Francia 

uk Regno Unito

1.6 Accedere ad una pagina Web

Ci sono tre modi per determinare l'indirizzo Internet di una pagina che si vuole 
vedere:

1.  E' noto. Attraverso la pubblicità, riviste o amici. 
2.  Si deduce. Se per esempio si vogliono vedere le pagine meteo in Itala 

l'indirizzo può essere www.meteo.it. Se il sito esiste raggiungerò la pagina. 
Normalmente nei siti commerciali per questione di prestigio è utilizzato il 
dominio .com. Es. www.fiat.com 

3.  Si cerca. Utilizzando dei siti appositi chiamati motori di ricerca è possibile 
rintracciare le pagine inerenti ad un determinato argomento.

2 Utilizzo di MS Explorer 5

Explorer 5 è il programma utilizzato per la navigazione (browser). Può essere 
lanciato comodamente dalla scrivania oppure attraverso il bottone nella barra 
degli strumenti.
Sotto la barra del titolo si trovano 

●     la barra dei menu 
●     la barra degli strumenti
●     La casella Indirizzo
●     La barra dei collegamenti (opzionale e personalizzabile)
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In basso si trova la barra di stato che visualizza i messaggi delle operazioni in 
corso. 

2.1 Inserimento di un indirizzo

Per inserire un indirizzo basta fare click nell'area bianca della barra degli indirizzi e 
digitare l'URL seguito da INVIO. Se l'indirizzo è già stato visitato basta scriverne 
solo una parte e confermare con INVIO.
Explorer da per scontato che si utilizzi il protocollo HTTP perciò la parte http:// può 
essere omessa.

2.2 I bottoni della barra degli strumenti

Indietro Torna alla pagina precedentemente visitata

Avanti Va alla pagina visitata successivamente

Termina Interrompe il prelevamento dei dati dal sito corrente

Aggiorna richiede la pagina aggiornata

Pagina iniziale richiede la pagina aggiornata

Cerca permette la ricerca di argomenti alcuni 
motori di ricerca (si può personalizzare)

Preferiti Siti preferiti preimpostati (si può personalizzare)

Cronologia elenco cronologico dei siti visitati

Posta Attiva Outlook Express per la gestione 
della posta elettronica

Stampa Stampa la pagina visualizzata

2.3 Barra dei collegamenti

Pagine Microsoft per la gestione dei canali, elenco migliori siti, informazioni su 
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Explorer, Pagina di informazioni di Microsoft. La barra è personalizzabile.

2.4 Apertura di una nuova pagina

E' comodo mentre si aspetta il caricamento di una pagina lavorare 
contemporaneamente su un'altra per visitare un altro sito. Per aprire una nuova 
finestra dare File > Nuovo > Finestra oppure CTRL + n. E' possibile aprire tante 
finestre quanto si vuole tende

2.5 Salvataggio della pagina

Explorer permette di salvare automaticamente sia il testo sia le immagini della 
pagina che stiamo vedendo. Per fare ciò viene creata una cartella che contiene tutte 
le immagini utilizzate nella pagina che viene salvata. Con questo sistema è possibile 
consultare la pagina in un secondo momento senza essere collegati. Il comando si 
trova in File > Salva con nome.

Un'altra possibilità è di selezionare parte di testo con il mouse e dare il comando 
con il tasto di destra di copia.
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2.6 Salvataggio delle immagini

Per salvare un'immagine basta fare click con il tasto di destra del mouse e 
selezionare Salva immagine con nome .

2.7 I siti preferiti

I siti che si desidera visitare abitualmente possono essere memorizzati nei siti 
preferiti. In questo modo il sito è facilmente richiamabile utilizzando il bottone 
preferiti. Per aggiungere il nome (e l'indirizzo associato) del sito basta dare dal 
menu Preferiti > Aggiungi ai preferiti .

Con il bottone Nuova cartella è possibile creare una nuova cartella entro cui inserire 
la pagina

3 Motori di ricerca

Sono siti che mettono a disposizione dei programmi che sono in grado d effettuare 
una ricerca automatica basata sulle parole fornite dall'utente. 
Per questo argomento esiste anche una guida su Internet al sito 
www.motoridiricerca.it.
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3.1 Alcuni Motori

3.1.1 Alcuni Motori Italiani

●     www.arianna.it
●     www.lycos.it
●     www.virgilio.it - diviso per categorie
●     www.yahoo.it - diviso per categorie

3.1.2 Alcuni Motori Internazionali

●     www.altavista.com
●     www.excite.com 
●     www.goto.com
●     www.hotbot.com
●     www.infoseek.com
●     www.lycos.com
●     www.northernlight.com
●     www.webcrawler.com
●     www.yahoo.com - diviso per categorie

Per attivare la ricerca si specificano uno o più parole (le chiavi) e dei criteri di 
esclusione o di inclusione di argomenti con appositi simboli. Alcuni motori 
consentono di ricercare solo in certi tipi di sito, per limitare la ridondanza delle liste 
risultanti dalla ricerca.
Il risultato della ricerca è una serie di pagine con collegamenti ipertestuali ad altre 
pagine.

Link ipertestuale 

si passa ad un'altra pagina

3.2 Regole per inserimento delle chiavi

Se si vuole effettuare la ricerca su scultura greca occorre tenere conto che 

- scultura greca troverà tutti i siti che parlano sia della scultura che di greca

- "scultura greca" troverà tutti i siti che parlano sia della scultura greca

Per avviare la ricerca basta scrivere le parole chiavi e dare INVIO o fare click su 
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SEARCH

Nel caso di siti organizzati per categorie è possibile partire da una categoria e 
seguire le sottocategorie fino ad arrivare all'argomento che interessa.

3.2.1 Operatori speciali

or Oppure: l'operatore or è utilizzato per ricerche che contengono solo alcuni 
dei termini inseriti, per esempio si può digitare riviste or informatica

Not

Non, No: esclude dalla ricerca i documenti che hanno al loro interno una 
certa parola. Se per ex. vogliamo trovare riviste che parlino di informatica 
ma non in formato elettronico (...su Internet) scriveremo la seguente 
stringa di ricerca: riviste not e-zine

- Meno: si può usare al posto di not.

Near

Vicino: non è sempre sufficiente che due termini compaiano in un 
documento perché questo soddisfi i requisiti richiesti, è possibile richiedere 
al motore che i termini siano vicini l'uno all'altro, riviste near computerLa 
distanza massima dei termini è diversa da motore a motore (10, 20, 25 
parole)

... 

Virgolette: quando si desidera ricercare una precisa sequenza di parole, 
occorre delimitare con le virgolette la stringa da cercare: "riviste di 
informatica, questa è la giusta sintassi per una ricerca formata da più 
parole.

4 La posta elettronica e-mail

Con questo sistema è possibile trasmettere messaggi di testo o file di qualsiasi tipo 
(programmi, immagini, suoni, ecc.),
I documenti trasmessi dal mittente (1) arrivano al server (2) che gestisce il servizio 
di posta elettronica per conto del destinatario e qui restano fino a che il destinatario 
(3) non decide di prelevarli, copiandoli sul suo computer.
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I vantaggi di questo sistema sono

●     La velocità - Un messaggio impiega pochi secondi per raggiungere server del 
destinatario.

●     Il costo - Grandi quantità di informazioni possono essere trasmesse al costo 
di una chiamata telefonica verso il server.

●     Affidabilità - A differenza del fax il messaggio è perfettamente leggibile e 
riutilizzabile (può essere inserito in un documento).

●     Più destinatari - Uno stesso messaggio può essere spedito a più destinatari 
contemporaneamente. indicando nella casella dei destinatari gli indirizzi di 
tutte le persone a cui si desidera inviare il messaggio.

Svantaggi

Se un computer non è in rete (caso "domestico") l'unico modo per sapere se è 
arrivata posta è connettersi al fornitore del servizio (provider) e visitare la casella di 
posta elettronica.

4.1 L'indirizzo

Gli indirizzi di posta elettronica e bene che siano scritti in minuscolo e hanno il 
seguente formato:

mionome@provider.dominio 

Un esempio di casella di posta del signor Mario Rossi che è abbonato a Italia On 
Line è il seguente:

mrossi@iol.it 

Sulla tastiera italiana normalmente per ottenere il carattere @ occorre premere il 
tasto Alt Gr + 

5 MS Outlook Express 5

Al momento dell'avvio, Outlook Express chiede di selezionare (se non è ancora 
stata attivata) la connessione da utilizzare per accedere al servizio di posta 
elettronica. La schermata iniziale della versione 5 del programma è la seguente:
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5.1 Le cartelle Locali

Posta in arrivo Contiene i messaggi ricevuti 
(se è in grassetto significa che c'è posta)

Posta in uscita Contiene i messaggi da inviare

Posta inviata Contiene i messaggi inviati

Posta eliminata Contiene la posta che è stata cancellata 
(ma che può essere recuperata)

Quando viene selezionata una particolare cartella in alto appare l'elenco dei 
messaggi contenuti e in basso viene visualizzato il contenuto del messaggio 
selezionato.
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5.2 Composizione di un messaggio

Per comporre un messaggio basta premere il bottone Nuovo messaggio oppure 
scegliere Crea un nuovo messaggio di posta elettronica. Gli elementi 
fondamentali da inserire sono:

A: il destinatario (o i destinatari del messaggio)

Oggetto: il titolo del messaggio

Il testo da inserire nella parte inferiore
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Facoltativi invece sono:

Cc: Copia per conoscenza

Ccn: Copia per conoscenza nascosta 
(il destinatario principale non ne viene informato)

Se la rubrica è stata utilizzata è possibile scegliere il destinatario tra quelli immessi 
in precedenza. Facendo click sul bottone  Appare la finestra Selezione 
destinatari da cui è possibile scegliere il destinatario del messaggio con i bottoni 
A: / Cc. / Ccn
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Alla fine basta dare OK per ritornare alla composizione del messaggio.

5.3 Invio di un messaggio

Una volta creato un messaggio è sufficiente premere il bottone INVIA Se la 
connessione non è attiva (computer non collegato a Internet) il messaggio viene 

automaticamente spostato nella cartella Posta in uscita, dove resta fino al 
momento dell'effettiva trasmissione.

La modalità non in linea consente di scrivere messaggi e risposte senza 
utilizzare il collegamento telefonico. Una volta preparati i nuovi messaggi si 
possono spedire con il comando Invia e Ricevi.

5.4 Utilizzo degli allegati

Attraverso la posta elettronica è possibile inviare altri documenti di qualsiasi 
tipo (programmi, foto, fogli elettronici, ecc.) Per spedire un file lo si può 

trascinare all'interno della finestra del messaggio oppure utilizzare il bottone Allega 
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scegliendo il file da inviare.

5.5 Lettura della posta

Nella cartella Posta in arrivo sono presenti tutti i messaggi ricevuti. Se la scritta è in 
grassetto significa che sono arrivati dei nuovi messaggi da leggere. Nella parte 
sotto della finestra è possibile già leggere una parte del messaggio ma per aprirlo 
occorre fare doppio click oppure usare il comando File > apri. 

5.6 Spostamento ed eliminazione di un messaggio

I messaggi presenti in Posta in arrivo possono essere spostati in altre cartelle di 
sistema. Per eseguire lo spostamento è sufficiente trascinare l'elemento selezionato 
fino alla cartella di destinazione. Per cancellare un messaggio basta selezionarlo e 
premere CANC.

5.7 Salvataggio degli allegati

Un messaggio può contenere dei file allegati (contraddistinti dalla graffetta ). Per 
poterli salvare su disco e sufficiente fare doppio click sul documento indicando la 
cartella di destinazione oppure dare il comando File > Salva allegati (E' molto 
comodo salvare gli allegati sul desktop per un immediato utilizzo successivo).

5.8 Come rispondere a un messaggio
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E' possibile inviare una risposta al mittente del messaggio selezionato con il 
pulsante Rispondi Viene presentato un nuovo messaggio con i campi A: e 

Oggetto già compilati. Inoltre vene riportato il testo del documento originario. 
Come al solito per spedire la risposta dare invia. 

  

5.9 Come inoltrare a un messaggio

Un messaggio può essere rispedito ad un'altra persona senza aggiunte con il 
comando inoltra.

5.10 La rubrica degli indirizzi

Il pulsante Rubrica consente di gestire la rubrica dei contatti. Questa rubrica 
può contenere molte informazioni che sono utilizzate da altre applicazioni. Per 

aggiungere un nuovo contatto dare Strumenti > Rubrica e successivamente File 
> Nuovo contatto. I dati che sicuramente vanno inseriti sono Il Cognome il 
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Nome e l'indirizzo di posta elettronica.

 

6 Indirizzi Utili

Nascendo un sito all'ora è difficile avere un'idea di che cosa ci sia su tutta la rete. Ci 
sono siti di links cioè pagine che rimandano ad altre pagine in base ad argomenti .

Indirizzo Servizio

www.100links.com Sito di Links italiano

www.corriere.it l "Corriere della sera

www.ferrovienord.it Orario Ufficiale delle Ferrovie Nord

www.fs-on-line.com Orario Ufficiale delle Ferrovie dello Stato

www.meteo.it Il bollettino meteorologico 

www.paginebianche.it Il servizio 12 su Internet 

www.paginegialle.it Servizio Pagine Gialle

www.repubblica.it La Repubblica

www.motoridiricerca.it Tutto sui motori di ricerca
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www.liuc.it Sito Università di CastellanaNella sezione studente è 
possibile scaricare molti programmi "freeware

7 Copernic 2001 Basic

Copernic 2001 è un programma che effettua ricerche sulla rete consultando 
contemporaneamente i più importanti motori di ricerca di Internet. La ricerca può 
essere effettuata sul web in Italia, su tutta le rete, e su una nazione scelta tra le 
sette disponibili in fase di istallazione. Sono disponibili anche le categorie 
Newsgroup, Indirizzi e-mail, Acquisto libri, Acquisto Hardware e Acquisto Software 
che non tratteremo in questo manuale.

I vantaggi offerti da Copernic sono:

1.  Possibilità di definire quanti documenti ottenere come risultato della ricerca 
(Max 1000).

2.  Il risultato della ricerca viene salvato e può essere aggiornato, raggruppato in 
cartelle, ecc.

3.  Possibilità di scaricare documenti corrispondenti per la consultazione offline.
4.  I documenti trovati vengono classificati e visualizzati secondo la loro rilevanza.
5.  Evidenziazione delle parole chiave nei risultati.
6.  Traduzione direttamente nella pagina principale e nella pagina dei risultati 

della ricerca, dei documenti individuati utilizzando Gist-In-Time.
7.  Possibilità di esportare o inviare per e-mail in diversi formati i rapporti relativi 

alle ricerche

7.1 Definizione della ricerca

Per iniziare una ricerca si scrive ciò che si vuole cercare nel campo Ricerca Rapida
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E' anche possibile specificare in che WEB (Italiano, mondiale, ecc.) efferruare la 
ricerca.

Un altro modo è attraverso il bottone Ricerca. Compare una finestra dove 
possiamo scegliere la categoria di ricerca. Le categorie sbiadite sono 
disponibili solo nella versione completa del programma. Per Query si intende 

la frase o le parole salienti che si vogliono trovare.
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Si sceglie anche il tipo di ricerca:

●     ricerca tutte le parole - i risultati includeranno tutte le parole chiave 
immesse.

●     ricerca qualsiasi parola - i risultati includeranno almeno una parola chiave.
●     ricerca la frase esatta - i risultati includeranno la frase così come è stata 

digitata

una sequenza di parole può essere raggruppata con le virgolette Es. "Albert 
Einstein".

In Dettagli abbiamo le possibilità:

●     indicare il risultato massimo per ogni motore di ricerca (Max 300) 
●     Indicare il numero totale dei risultati desiderati (Max 3000)
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7.2 Aggiornamento dei motori di ricerca

Periodicamente Copernic esegue un aggiornamento per verificare se sono cambiati i 
parametri per effettuare le ricerche. Cerca inoltre se esistono dei nuovi motori da 
aggiungere nella propria lista.

Questa operazione può essere anche saltata.

7.3 Progresso della ricerca

A questo punto una finestra informa sull'andamento dell'interrogazione ai vari 
motori indicando quanti risultati sono stati ottenuti. L'operazione può durare alcuni 
minuti.
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7.4 Analisi della ricerca

I siti ottenuti dalla ricerca vengono ordinati per punteggio.

  

Facendo click sui vari campi è possibile ordinare per Titolo, Indirizzo, Punteggio, 
Motori di ricerca.
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I siti più interessanti possono essere marcati con la casella di controllo  in modo 
da essere facilmente ordinati.

7.5 Visualizzazione dei risultati

Il modo migliore per vedere il risultato della nostra ricerca è con il bottone 
Sfoglia 

Viene aperta una finestra con l'elenco di tutti i risultati con:

●     Titolo sito
●     Parole chiave in giallo
●     Descrizione
●     Elenco dei Motori di ricerca che lo segnalano
●     Indirizzo WEB
●     Punteggio in %

Da questa finestra, come in Explorer, è possibile visualizzare i siti trovati.
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Molto comodo l'elenco a discesa Documento per passare da un sito a un altro.

7.6 Salvataggio della ricerca

Copernic salva automaticamente i risultati della ricerca quando si esce dal 
programma. In questo modo è possibile rivedere le ricerche effettuate ogni volta 
che si attiva Copernic.

7.7 Modifica di una ricerca

Una ricerca può essere modificata con il bottone Modifica. Questo può essere 
utile per passare da "ricerca tutte le parole" a "ricerca frase esatta" più 
restrittiva.

7.8 Raffinare la ricerca

È Possibile raffinare una ricerca con il bottone Raffina. 

 

Possono essere inseriti gli operatori di ricerca:

●     E - trova solo i documenti contenti tutte le parole o le frasi specificate.
●     O - trova solo i documenti contenti almeno una delle parole o delle frasi 

specificate. I documenti trovati possono contenerle tutte, ma non 
necessariamente.

●     TRANNE - Esclude i documenti contenenti la parola specificata.
●     VICINO - Trova i documenti contenenti le parole specificate separate da un 

massimo di 10 parole
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Inoltre

●     Solo parole intere - i documenti rilevanti devono contenere parole intere.
●     Maiuscole/minuscole - i documenti rilevanti devono contenere l'esatta 

combinazione di lettere maiuscole e minuscole delle parole chiave.
●     Rimuovi i documenti non corrispondenti - consente di rimuovere 

automaticamente i documenti non rilevanti ed i collegamenti irraggiungibili.
●     Scarica immagini - consente di scaricare le immagini. Notare che il tempo di 

scaricamento potrebbe aumentare notevolmente se la ricerca contiene molti 
documenti o alcuni documenti con numerose e voluminose immagini.

●     Raffina solo i documenti selezionati - consente di raffinare solo i 
documenti selezionati dalla finestra principale. Per selezionare i documenti, 
fare click su ognuno di essi con il pulsante sinistro del mouse tenendo premuto 
il tasto Ctrl

7.9 Scaricare i documenti

È possibile scaricare su disco i documenti trovati per la consultazione non in 
linea. È possibile applicare tale funzione a tutti i risultati di una ricerca o solo a 
risultati selezionati.

Se non vengono scaricate le immagini i documenti salvati sul disco conterranno solo 
il testo ma occuperanno poco spazio.

7.10 Cancellare una ricerca

Una ricerca può essere eliminata:

1.  Selezionandola
2.  Dando Modifica > Elimina e confermando la cancellazione.

http://www.centroreiki.org/abaco/manuali/T_Corso_Internet.htm (24 of 26) [11/11/2002 14.44.32]



Corsi di Informatica - Manuale Corso Internet

8 Appendice

Termine Significato

Browser Detti anche Navigatori, Sono programmi per la visualizzazione 
delle pagine informatiche della rete. (Es. Microsoft Explorer)

Client Programma usato dall'utente per chiedere e ricevere 
informazioni dalla rete 

DNS Domain Name Service - sistema di database per 
l'individuazione dell'indirizzo sulla rete

Hardware Componenti fisici di un computer (schede elettronica ecc.)

Host computer collegato direttamente alla rete in grado di ospitare 
utenti informazioni e posta elettronica

HTML HyperText Markup Language linguaggio standard che consente 
di creare le pagine Web

Interfaccia collegamento tra più unità hardware, tra hardware e software 
e tra software e utente.

Link ipertestuale Parola o immagine da cliccare che rinvia ad un'altra pagina, 
alla posta elettronica, o scarica un file

POP Post Office Protocol - protocollo utilizzato per l'invio della posta

PPP sistema di trasmissione delle informazioni a pacchetto

Server Programma su computer remoto che fornisce i dati.

SMTP Simple Mail Transport Protocol protocollo per la ricezione della 
posta elettronica

Software Programmi

TCP/IP
Trasmission Control Protocol/Internet Protocol è composto di 
una serie di protocolli che garantiscono il trasferimento dei dati 
dai programmi applicativi sino alla rete

URL Uniform Resource Locator - Indirizzo di una pagina o risorsa 
sulla rete

WWW

World Wide Web, la ragnatela globale. Rende immediatamente 
disponibili le informazioni su Internet. Documenti con testo, 
grafica, suono e video sono facilmente reperibili con 
un'interfaccia immediata da usare anche con il solo mouse.

ZIP File compressi da un particolare programma (winzip) per 
essere trasmessi più velocemente.
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 home  ricerca  community  news  sport  finanza  business  intrattenimento  shopping  canali  città telefonino internet

 In Italia

 Nel mondo

Ricerca avanzata
Serve aiuto?

Cerca su:      web MP3 immagini video newsgroup catalogo shopping

  FILI DI ARIANNA

LE OASI DEL 
PIACERE

I fili della settimana

  SERVIZI

>> Arianna come home

>> Arianna nel tuo sito

>> Inserisci il tuo sito

>> Scopri le novità

>> Scrivi ad Arianna

>> Traduzioni

   ALTRE RICERCHE

>>Aziende
Annunci Business | Elenco Aziende | 
Lavoro | Traduzioni

>>Notizie
News2000 | Musica | Spettacolo | 
Sport

>>Casa & Tempo libero
Affitti | Cinema | Collezionismo | 
Cucina | Libri | Motori | Vendita | 
Videogiochi

>>Persone
Amici in Digiland | Annunci | Elenco 
Telefonico | Oroscopo | Pagine 
Personali

>>Eros
Arianna Sexy | Spicy

>>Sport
Calcio | Fitness | Formula 1

>>Finanza
Azioni&Fondi | Mutui | Notizie | Prestiti

>>Tecnologia
Siti WAP | SW Download | Sfondi

>>Musica
InSideSound | MP3Sonica

>>Viaggi
Alberghi | Città | Mappe | Meteo | 
Percorsi | Prenotazioni | Voli

 Repubblica Extra
 

 

Abbonati all'Edicola di 
Libero e scopri il 
piacere di leggere il 
giornale online....
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Home Cerca E-mail Chat Mobile Love@Lycos Il tuo sito

Servizi

 Win@Lycos 

 T-shirt mania 

 SMS & MMS Gratis 

 Fightclub 

 Quiz Show 

 Loghi & Suonerie 

 Carta Lycos 

 Astrologia 

 Traduzioni 

 Antivirus online 

 Hosting & Domini 

 B2B Directory 

Guide

 Notizie 

 Business 

 Tech 

 Viaggi & Vacanze 

 Studio & Lavoro 

 Casa 

 Eros 

 Motori 

 Benessere 

 Giochi 

 Cinema 

 Programmi Tv 

 Arte & Mostre 

 Musica 

 Fantascommetti 

 

Cerca:   

 Siti italiani    In tutto il web      

Directories: siti consigliati | Ricerca avanzata | Aiuto | Segnala un sito
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In Evidenza

Lycos Credit Card
fino al 31 dicembre puoi richiederla gratis! 

Community

Permette una domanda?
QuizShow parla di musica, sport, tv... sfida&sfotti 
subito i tuoi amici! 

Novità

XXX game
Vinci un viaggio a Praga e fantastiche t-shirt XXX 

Lycos Shopping »

 

Offerte Speciali 
 
Palmari
Profumi
Elettronica
PC Giochi
Cellulari
Libri Scontati 

Altre categorie di shopping 
 
PC | DVD e video | Cellulari | Videogiochi 

 

Attualità e notizie »

primo piano

FINANZIARIA, STORACE DA BERLUSCONI: ''SERVE CONCRETEZZA''. VELTRONI: S...

altre news...

 

Ultim'ora 
 
Lun - 11/11/102 - FIAT: TERMINI IMERESE, PER LA PRIMA VOLTA ARRIVANO I 'QUADRI'...

Altre notizie 
 
Meteo | Sport | Economia 

Calendari 2003 »

 

 
Bellezza e Seduzione
E' già iniziata la sfida per il calendario del prossimo anno. 

Personalizza il tuo PC 
 
Giochi online | SMS animati | Offerte online | Calendari | 
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T-shirt mania »

 

 
La vuoi unica? 
maglietta, felpa, mousepad: personalizzali come ti pare! 

La musica che vuoi 
 
Guida agli MP3 | Webcam Party | Live Chat | Karaoke | Dediche | Loghi e Suonerie 

Community

Iscriviti - Dati personali 

Vai su:   

Dimenticato la password?

Utenti Online

Chat: 1418 online 

Love@Lycos: 1793 online 

Mobile: 164 online 

Fightclub: 259 online 

Lycos Partners

 • donne@SpazioDonna 

 • multilingue@systran 

 • libri@bol 

 • usato@autoscout24 

 • loghi-gratis@mrtones 

 • toni-gratis@mrtones 

Sponsor

 

Europa: Austria, Belgio, Danimarca, Francia, Gran Bretagna, Germania, Olanda, Norvegia, Russia, Svezia, Spagna, Svizzera 
 

Nel Mondo: Stati Uniti, Asia

Chi siamo | Pubblicità su Lycos | Aiuto 
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VIRGILIO

   

Notizie Meteo Sport Soldi Business Shopping Community Tutto Virgilio

 @virgilio.it @tin.it 

 Abbonati ora ¬ 
  tin.it Free   tin.it ADSL 

 ultime notizie¬ 

» Usa-Iraq, scadenza 8 
dicembre 

» Route du Rhum, Soldini: 
"Penso di ritirarmi" 

» Contributi Adsl, sì della 
Camera 

» Polemiche sugli arbitri, 
possibili azioni legali 

Video » Tg La7 

» Corriere.virgilio.it 
» Virgilio Notizie 

Alla scoperta del franchising 
Le opportunità per diventare imprenditori sfruttando 
un marchio già collaudato. In LAVORO 

» La Terra dal satellite » Spie contro spie 

 Shopping ¬ 

» Grandi offerte: 
lettori di DVD col 
massimo risparmio

VOTA IL TEMA LA7

» La guerra a Saddam 
può essere d'aiuto 
nella lotta contro il 
terrorismo?

Da non perdere ¬ 

Bendati e in catene
Catturati in Afghanistan e in 
volo verso Guantanamo: le 
foto.

» Coppa America

» Etiopia, il reportage

» Vino novello

» Il bello della 
tecnologia

» Oggi in Rete
In collaborazione con il 
Corriere della Sera

» Tutti allenatori

» L'aumento

» Il favoloso mondo 
dei DVD

Community
Newsgroup,  Atlantide,  Genio, Crea 
sito,  Superfighetto,  Chat 

Sport
Ultime notizie,  Calcio, Basket 
Formula1,  Coppa America 

Donne
Moda,  Trovaricette,  Bellezza,  
Oroscopo,  Antonella Boralevi 

Shopping e Casa
Telefonini,  Moda,  ,  Mutui,  
Internet,  Foto 

Soldi
Fondi,  Assicurazioni,  
Ventiquattrore.tv,  Miaeconomia 

Giochi
Sal@ Giochi,  Gamespot, 
Videogiochi 

Broadband e Adsl
MTV live,  Webcam,  My-tv,  
LifeGate Radio Live 

Salute e benessere
Siti utili,  Farmaci 

Notizie
Attualità,  Tg La7,
Corriere.virgilio.it 

Viaggi
Destinazioni,  Prenotazioni,  Orario 
treni 

Computer e telefonia
Suonerie,  SMS,  Download,  Tools,  
ZDNet 

Musica
Artisti,  Mp3 e video, 
Testi e spartiti 

Sociale
Ambiente,  Consumatori, 
Stranieri,  Disabili 

Lavoro e Business
Guadagna con Internet, 
PMI news,  Fiere,  Traduzioni 

Motori
Listino,  Polizze auto 

Cinema e spettacolo
Virgelio,  Tv La7 
Programmazione Cinema 

Sapere e libri
Enciclopedia,  Corso di inglese,  
Parole,  Trovalibri 

Junior
Siti per bambini,  Super!,  Cartoon 
Network 

Iulm
Scopri l'università dove 
nasce la comunicazione
a cura di: Iulm 

Super Natale
Scegli i tuoi cinque regali a 
soli 299 €
a cura di: Mondialcasa 

 Segnala un sito
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 Yahoo! Notizie: il quotidiano aggiornato 24 ore su 24 

  
 • Ricerca avanzata
 • Ricerca aziende

Servizi Yahoo!

Novità! Gioca e Vinci con The Bourne Identity  · Speciale U2 

Informati Finanza · Lotto · Mappe · Meteo · Notizie · Sport · TV 
Acquista Annunci · Auto · B2B · Casa · Lavoro · Pagine Gialle · Shopping 
Comunica Cartoline · Chat · Forum · Gruppi · Mail · Messenger · Rubrica 

Divertiti Cinema · Giochi · Musica · Oroscopo · Ristoranti · Viaggi 
Accedi ADSL · Cellulari · MegaInternet · SatADSL · Y! Online 
Organizza Agenda · Blocco note · Bookmark · Foto · Geocities

Insieme · Mio · Valigetta   Altro...

 Computers - Elettronica - DVD e video - Altro

 Fai Shopping per
Categoria:  

Negozio:  

Cerca: Tutto per l'informatica
per casa e ufficio

Directory siti Web - I siti ordinati per argomento.

Economia e aziende
B2B, Shopping, Lavoro, Finanza... 

Aree geografiche
Europa, Paesi, Città italiane... 

Medicina e salute
Benessere, Fitness, Gravidanza... 

Attualità e media
In primo piano, Giornali, TV, Meteo... 

Istruzione e formazione
Università, Scuole, Tesi... 

Politica e istituzioni
Governo, Diritto, Fisco, Partiti... 

Risorse
Biblioteche, Dizionari, Libri... 

Società e culture
Sesso, Calendari, A tavola, Ambiente... 

Divertimento e spettacolo
Novità, Fumetti, Cinema, Musica... 

Informatica e internet
Internet, Software, Computer, Giochi... 

Sport e tempo libero
Calcio, Sport, Motori, Viaggi... 

Scienze umane e sociali
Economia, Storia, Psicologia... 

Scienza e tecnologia
Animali, Astronomia, Telefonia... 

Arte e cultura
Letteratura, Moda, Architettura... 

   Personal Assistant Entra

Registrati per personalizzare Yahoo!

  Nelle notizie

Medio Oriente
Kibbutz: Arafat condanna attacco; creata 
commissione d'inchiesta per valutare 
operazione

· Finanziaria: via libera Camera a prima parte maxi 
emendamento 

· Iraq: oggi Parlamento convocato su risoluzione 
Onu 

· Fiat: Luttwak sonderà Toyota su Termini Imerese 
· Serie A: la Juve batte il Milan e si porta a meno 

uno dall'Inter 
· Louis Vuitton Cup: le ultime su Luna Rossa 

Indici: MIB 30  -0.88% NUMTEL  -2.66% 

Notizie - Finanza - Sport - Meteo 

  Shopping

Louis Vuitton Cup
Tutte le regate in 3D con Virtual Spectator

· Shopping - I prodotti migliori, il massimo della 

sicurezza in Rete

· Viaggi - crociere, Last Minute, occasioni, guide

Shopping - Viaggi - Annunci - Pagine Gialle 

  Comunica

Chat
Musica, 4 Chiacchere, Viaggi
Sesso e relazioni altre...

Cartoline
Amore e amicizia, Compleanni, Fiori
Playboy, e molto altro...

Gruppi
Programmi TV, Musica, Cinema, 
Videogiochi, altro...

Mail - Chat - Gruppi - Cartoline - Forum 

http://it.yahoo.com/ (1 of 2) [11/11/2002 14.46.19]

http://it.yahoo.com/home/logo/?http://it.yahoo.com
http://it.yahoo.com/r/t6/help
http://it.yahoo.com/r/t5/my
http://it.yahoo.com/r/t4/novi
http://it.yahoo.com/r/t3/mail
http://it.yahoo.com/r/t2/chat
http://it.yahoo.com/r/t1/game
http://it.yahoo.com/r/ctr/noti
http://it.yahoo.com/r/bg
http://it.yahoo.com/r/az
http://it.yahoo.com/r/new/mega
http://it.yahoo.com/r/new/tit2
http://it.yahoo.com/r/nb/fina
http://it.yahoo.com/r/nb/lot
http://it.yahoo.com/r/nb/maps
http://it.yahoo.com/r/nb/weat
http://it.yahoo.com/r/nb/news
http://it.yahoo.com/r/nb/spor
http://it.yahoo.com/r/nb/tv
http://it.yahoo.com/r/nb/clas
http://it.yahoo.com/r/nb/car
http://it.yahoo.com/r/nb/b2b
http://it.yahoo.com/r/nb/casa
http://it.yahoo.com/r/nb/work
http://it.yahoo.com/r/nb/pgol
http://it.yahoo.com/r/nb/shop
http://it.yahoo.com/r/nb/gree
http://it.yahoo.com/r/nb/chat
http://it.yahoo.com/r/nb/boar
http://it.yahoo.com/r/nb/grup
http://it.yahoo.com/r/nb/mail
http://it.yahoo.com/r/nb/mess
http://it.yahoo.com/r/nb/rubr
http://it.yahoo.com/r/movi
http://it.yahoo.com/r/nb/game
http://it.yahoo.com/r/nb/musi
http://it.yahoo.com/r/nb/astr
http://it.yahoo.com/r/nb/rist
http://it.yahoo.com/r/nb/trav
http://it.yahoo.com/r/nb/adsl
http://it.yahoo.com/r/nb/mobi
http://it.yahoo.com/r/nb/mega
http://it.yahoo.com/r/nb/sata
http://it.yahoo.com/r/nb/onli
http://it.yahoo.com/r/nb/agen
http://it.yahoo.com/r/nb/note
http://it.yahoo.com/r/nb/book
http://it.yahoo.com/r/nb/phot
http://it.yahoo.com/r/nb/geoc
http://it.yahoo.com/r/nb/comp
http://it.yahoo.com/r/nb/my
http://it.yahoo.com/r/nb/vali
http://it.yahoo.com/r/jc
http://it.yahoo.com/r/mk/shop
http://it.yahoo.com/r/mn/shco
http://it.yahoo.com/r/mnt/cesh
http://it.yahoo.com/r/shdv
http://it.yahoo.com/r/mk/shop
http://it.yahoo.com/r/mn/shco
http://it.yahoo.com/r/mn/shco
http://it.yahoo.com/r/mn/shco
http://it.yahoo.com/r/xt
http://it.yahoo.com/r/btb
http://it.yahoo.com/r/sh
http://it.yahoo.com/r/je
http://it.yahoo.com/r/jf
http://it.yahoo.com/r/jg
http://it.yahoo.com/r/jh
http://it.yahoo.com/r/ji
http://it.yahoo.com/r/jj
http://it.yahoo.com/r/df
http://it.yahoo.com/r/b
http://it.yahoo.com/r/ft
http://it.yahoo.com/r/gv
http://it.yahoo.com/r/ce
http://it.yahoo.com/r/ch
http://it.yahoo.com/r/cf
http://it.yahoo.com/r/cg
http://it.yahoo.com/r/mt
http://it.yahoo.com/r/db
http://it.yahoo.com/r/dc
http://it.yahoo.com/r/ie
http://it.yahoo.com/r/is
http://it.yahoo.com/r/kh
http://it.yahoo.com/r/ki
http://it.yahoo.com/r/kj
http://it.yahoo.com/r/fs
http://it.yahoo.com/r/da
http://it.yahoo.com/r/dj
http://it.yahoo.com/r/ea
http://it.yahoo.com/r/eb
http://it.yahoo.com/r/li
http://it.yahoo.com/r/ek
http://it.yahoo.com/r/fb
http://it.yahoo.com/r/er
http://it.yahoo.com/r/fa
http://it.yahoo.com/r/fc
http://it.yahoo.com/r/ka
http://it.yahoo.com/r/bb
http://it.yahoo.com/r/ci
http://it.yahoo.com/r/kb
http://it.yahoo.com/r/cj
http://it.yahoo.com/r/ck
http://it.yahoo.com/r/ir
http://it.yahoo.com/r/kd
http://it.yahoo.com/r/kf
http://it.yahoo.com/r/kg
http://it.yahoo.com/r/fd
http://it.yahoo.com/r/fe
http://it.yahoo.com/r/sf
http://it.yahoo.com/r/fg
http://it.yahoo.com/r/fh
http://it.yahoo.com/r/eg
http://it.yahoo.com/r/eh
http://it.yahoo.com/r/ei
http://it.yahoo.com/r/ej
http://it.yahoo.com/r/ec
http://it.yahoo.com/r/ee
http://it.yahoo.com/r/ef
http://it.yahoo.com/r/ed
http://it.yahoo.com/r/jk
http://it.yahoo.com/r/cb
http://it.yahoo.com/r/cc
http://it.yahoo.com/r/rc
http://it.yahoo.com/r/pa/sin
http://it.yahoo.com/r/pa/sup
http://it.yahoo.com/r/fu/isra
http://it.yahoo.com/r/fu/isra
http://it.yahoo.com/r/fu/econ
http://it.yahoo.com/r/fu/econ
http://it.yahoo.com/r/fu/iraq
http://it.yahoo.com/r/fu/iraq
http://it.yahoo.com/r/fu/fiat
http://it.yahoo.com/r/2a
http://it.yahoo.com/r/2a
http://it.yahoo.com/r/vela
http://it.yahoo.com/r/fimo/fina
http://it.yahoo.com/r/m30
http://it.yahoo.com/financehp/hp/*http://it.finance.yahoo.com/q?s=^NUMTEL&d=t
http://it.yahoo.com/r/base/news
http://it.yahoo.com/r/base/fina
http://it.yahoo.com/r/base/spor
http://it.yahoo.com/r/base/weat
http://it.yahoo.com/r/shop/ac3d
http://it.yahoo.com/r/shop/ac3d
http://it.yahoo.com/r/shop/shop
http://it.yahoo.com/r/shop/trav
http://it.yahoo.com/r/shop/sho2
http://it.yahoo.com/r/shop/tra2
http://it.yahoo.com/r/shop/clas
http://it.yahoo.com/r/shop/yell
http://it.yahoo.com/r/com/fot1
http://it.yahoo.com/r/com/cha1
http://it.yahoo.com/r/com/cha2
http://it.yahoo.com/r/com/cha3
http://it.yahoo.com/r/com/cha4
http://it.yahoo.com/r/com/cha5
http://it.yahoo.com/r/com/fot2
http://it.yahoo.com/r/com/gre1
http://it.yahoo.com/r/com/gre2
http://it.yahoo.com/r/com/gre3
http://it.yahoo.com/r/com/gre4
http://it.yahoo.com/r/com/gre6
http://it.yahoo.com/r/com/fot3
http://it.yahoo.com/r/com/gro1
http://it.yahoo.com/r/com/gro2
http://it.yahoo.com/r/com/gro3
http://it.yahoo.com/r/com/gro4
http://it.yahoo.com/r/com/gro5
http://it.yahoo.com/r/com/sub1
http://it.yahoo.com/r/com/sub2
http://it.yahoo.com/r/com/sub3
http://it.yahoo.com/r/com/sub4
http://it.yahoo.com/r/com/sub5


Yahoo! Italia

Siti di: Svizzera - San Marino - Vaticano

Novità - Proponi un sito - Un link a Yahoo!

Il meglio della settimana 

Pubblicità

Fai diventare Yahoo! la tua homepage

  Cosa trovi su Yahoo! Italia?

Sport Cellulari Acquista Rubriche Accedi ad Internet Enterprise

• Calcio
• Formula 1
• Tennis
• Auto/Moto 

• Loghi & suonerie
• Schede tecniche
• Servizi Wap
• Wap browser 

• Pagine gialle
• Shopping
• Lavoro
• Viaggi 

• Novitá
• Il meglio della 
  settimana
• Temi d'attualitá
• Siti da vedere

• Modem dial-up
• ADSL
• Satellite
• Fibra ottica

• Enterprise
• Webcast
• NetRoadshow
• Portal Software

  Yahoo! nel mondo

Europa America Asia e Oceania

• In catalano
• Danimarca
• Francia
• Germania
• Grecia 

• Norvegia
• Spagna
• Svezia
• UK e Irlanda 

• Argentina
• Brasile
• Canada
• Messico

• Yahoo.com
• U.S. in Cinese
• U.S. in Spagnolo 

• Asia
• Australia e NZ
• Cina
• Corea
• Giappone

• Hong Kong
• India
• Singapore
• Taiwan 

Città Italiane:  Bari - Bologna - Firenze - Genova - Milano - Napoli - Palermo - Roma - Torino - Venezia 

 
 • Ricerca avanzata
 • Ricerca aziende

100% di sicurezza con 

Assistenza - Proporre un sito - Info su Yahoo! - Pubblicità su Yahoo! - Yahoo! assume - Yahoo! e la tua Privacy

Copyright © 2002 Yahoo! Inc. Tutti i diritti riservati.
Condizioni per l'utilizzo del servizio 
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Tornadoes Kill at Least 27
Line of tornadoes kill dozens in three 
states....

Iraqi Parliament to Meet on U.N. Vote
Iraqi President Saddam Hussein has 
called a special parliamentary session 
to...

EXCLUSIVE: Did J.Lo Say Yes to 
Affleck?
J.Lo answers the Affleck question....

Bush Honors Vets, Refines Iraq Plans
As he refines plans for a possible 
invasion of Iraq, President Bush is 
honoring...

See all headlines

  My ABCNEWS.com

Enter zip code to get your local 
news, sports and weather.
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  MONEYScope - Market snapshot
SYMBOL PRICE CHANGE
DJIA 8537.100 +0.0
S&P 500 894.740 +0.0
NASDAQ 1359.280 +0.0

get quote
         Create custom portfolio

Headlines

Vick rallies Falcons to unusual tie with 
Steelers
Michael Vick rallied Atlanta from 17 
points down in the fourth quarter and 
the...

Boston not Beane-town: GM stays 
with Oakland
Just when it appeared Oakland would 
have a new manager and a general 
mana...

Jets beat Dolphins to further scramble 
AFC East race
The New York Jets further scrambled the 
AFC East race Sunday night, handing 
the...

Bonds expected to win fifth MVP on 
Monday
Barry Bonds probably will pick up a big 
postseason honor Monday, just not the...

Find great deals on holiday decor, 
ornaments and gifts at Disney Auctions!

Bid on great sports product from your 
favorite player or team.

To celebrate the release of Disney's "The 
Santa Clause 2," DisneyHand will donate 
a toy to Toys for...

 
Find showtimes in your area:

Enter ZIP

EXCLUSIVE: J.Lo to Marry Ben Affleck
Rumors have been swirling, but now 
Jennifer Lopez is making it official: she 
is...

         

digital cameras
car rentals
genealogy

cars
mp3
dsl

cruises
shoes
bankruptcy
gift baskets
ski vacations

toys
coupons
term life
equity loans
weight loss

 Practical Advice

Holiday Movie Guide
Looking for a movie the whole family can 
enjoy? Check out this year's...

Thanksgiving Countdown Calendar
Get ready for the big day with this 
printable planner.

Best Gifts of 2002
We've got the very best in books, videos, 
audio, software, and toys for kids...

Game Finder
Find 100s of fun, unique games to play.

Send a Free E-Card
From great Thanksgiving greetings to best 
birthday wishes, we've got every...

  Places to Visit

Disney on MSN Internet Service
Sign up and get your first month FREE*! 

"a bug's land" -- A New Land for Kids!
NOW OPEN at DISNEY'S CALIFORNIA 
ADVENTURE(tm) Park 

DisneyStore.com
Holiday Preview 

Beauty on Broadway!
See Jamie-Lynn Sigler on Broadway! 
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2000
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creazione 
guidata
Creare una 
query riepilogo 

Access 2000

Introduzione

Che cos'è un Database

Il modo migliore per spiegarlo è attraverso un esempio: Una rubrica telefonica

Nome Indirizzo Città CAP PR Tel

Centro Internazionale 
Reiki Via Lonate 6 Turbigo 20029 MI 0331891111

Ritorante San Pietro
Via Alzaia 
Naviglio Grande 
18

Robecchetto con 
Induno 20020 MI 0331875402

Silvio Crispiatico Via Lonate 6 Turbigo 20029 MI 0331891111

Rubrica

Un database quindi non è altro che una raccolta di dati. Tutti i i dati sono ordinati 
alfabeticamente. 

Alcune definizioni in base all'esempio

Campo Si intende "nome", "indirizzo", "città", "CAP", "PR", "Tel"

Record Ogni utente nella rubrica

Nella progettazione di un database si parte dalla definizione dei Campi che fanno parte del 
database. Ogni utente che verrà aggiunto al database ne modificherà la dimensione, ma 
non la struttura.

Un database quindi è formato da una tabella. Nell'esempio precedente si può notare che ci 
sono dei dati ripetuti. Le informazioni Città, CAP e PR sono strettamente collegate. Quindi si 
potrebbe creare una tabella città: 

NumeroCIttà Città CAP PR

1 Robecchetto con Induno 20020 MI

2 Turbigo 20029 MI
città

e la tabella Rubrica diventerebbe 

Nome Indirizzo NumeroCIttà Tel

Centro Internazionale Reiki Via Lonate 6 2 0331891111

Ritorante San Pietro Via Alzaia Naviglio Grande 18 1 0331875402

Silvio Crispiatico Via Lonate 6 2 0331891111

Rubrica
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Vantaggi di questa tecnica:

●     Riduzione dello spazio accupato
●     Congruenza dei dati: Turbigo sarà sempre in provincia di Milano e avrà sempre lo 

stesso CAP
●     Riduzione degli errori di scrittura: con una tabella unica si potrebbero creare 

"Robecchetto con Induno", "Robecchetto c/I", "Robecchetto con I.", e questo 
complicherebbe la ricerca di tutti gli utenti che sono nella stessa città.

In termini informatici tutto questo si dice normalizzare il database : Ogni dato compare 
una sola volta.

Acces consente lavorare a un database database in tre modi

1.  Utilizzando un database esistente. Il database Nortwind è un esempio di tutte le 
possibilità offerte dal programma per la gestione dei dati e può essere installato come 
esempio.

2.  Utilizzando progetti di database. In questo caso si utilizzano dei database 
preimpostati scegliendo quello che più si avvicina a ciò che vogliamo creare noi

3.  Creando il database dal nulla. In questo caso una volta pianificato il database si 
passera alla costruzione degli elementi principali che lo compongono: 

❍     Tabelle
❍     Query
❍     Maschere
❍     Report

Il primo modo è utile per vedere tutte le possibilità offerte da un database. E' possibile in 
questo modo prendere spunti per il proprio progetto. Il secondo modo è utile se non si ha 

molto tempo e se il modello scelto è molto vicino al database che si vuole creare.

Prenderemo in considerazione il terzo modo per avere una completa gestione del database.

 
database Northwind

Elementi principali di un database

Tabelle 
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ESEMPI DI 
QUERY
Query per la 
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UTILITA'
Operazioni nei 
report e nelle 
sottomaschere
I Folgi secondari
Creazione della 
maschera con 
sottomeschere
Creazione di un 
report con i 
sottoreport

APPENDICE

SCRIVICI

 

Contengono tutti i dati del database. Sono strutturate in righe e colonne come i fogli Excel. 
Esistono due modi per operare sulle tabelle:

Apri: In questo caso si vedono i dati contenuti nella tabella. E' possibile aggiundere dei 
valori o righe e modificare i dati.

Struttura: Per ogni campo è possibile deinire il tipo di dati che contiene ed eventualmente 
delle regole per l'immissione dei dati. Può essere comodo aggiungere una descrizione che 
spiega più chiaramente il significato del campo.

Struttura 

 

Maschere

Facilitano l'inserimento dei dati in una o in più tabelle. Consentono di inserire dei controlli o 
addirittura di visualizzare dei risultati ottenduti lavorando sui dti
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Maschera complessa

 

Report

Consentono di stampare i dati presenti database secondo una certa struttura. 

 
Report 

 

Query

Sono interrogazioni che permettono di estrarre dei dati dal database socondo vari criteri. 
Le più utilizzate sono le query di selezione che estraggono solo alcuni dati eventualmente 
messi in relazione con altre tabelle.

 

 
Query 
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Le Tabelle

Creazione di una nuova tabella partendo da zero

Una volta attivato Access, si sceglie di creare un database vuoto. A questo punto bisogna 
indicare dove salvare il database e che nome avrà. Questo perchè Access provvede, a 
differenza di altri programmi, a salvare automaticamente le modifiche.

Dal menù Tabelle si sceglie Crea una tabella in visualizzazione struttura.

Finestra database

Ora bisogna inserire i seguenti elementi:

●     Nome Campo: identifica il campo e il nome può anche arrivare a 64 caratteri. E' bene 
utilizzare nomi senza spazi

●     Tipo Dati: sono il tipo di informazioni contenute. Verrnnno maggiormente descritte in 
"Tipi di dati e proprietà dei campi"

●     Descrizione: opzionale. Consente di dare una descrizione più completa al contenuto e 
al significato del campo.
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Impostazione tipi di dati

 

Tipi di dati e proprietà dei campi

Campo descrizione

Testo Caratteri alfanumerici (nomi, indirizzi, cap, ...), max 255

Memo Testo molto lungo con caratteri alfanumerici, max 65.535

Numerico numeri su cui devono essere eseguiti calcoli

Data e ora date e orari compresi tra 100 e 9999

Valuta Utile per Euro e altre monete. Precisione 15 cifre + 4 dopo la virgola

Contatore Numero progressivo univoco gestito da Access

Sì/No Valori Sì / No oppure Vero / Falso

Oggetto OLE Oggetto, Immagine collegato o incorporato in una tabella Access

Collegamento
Ipertestuale Collegamento a indirizzi URL

Ricerca
Guidata 

consente la grazione di un elenco deve è possibile selezionare un valore 
per ogni record.

Vediamo ora le proprietà più importanti descritte nella scheda Generale

Generale nome

Dimensione
Campo 

Lunghezza massima di un campo di testo o numerico. Limita la 
dimensione del database

Formato Indica l'aspetto dei dati
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Etichetta
Nome visualizzato come titolo della colonna. Utile perchè il nome del 
campo normalmente non ha spazi bianchi e soprattutto per la 
creazione delle maschere e dei report

Valore predefinito Valore inserito automaticamente ogni volta che viene creato un 
nuovo record

Posizioni decimali Indica per i campi numerici e valuta il numero di cifre decimali

Richiesto Se impostato su Sì obbligherà l'utente a inserire sempre un valore 
nel campo

Se vogliamo creare una tabella che descriva degli articoli possiamo avere i seguenti campi

Generale nome

CodiceArticolo Testo 10 caratteri

Articolo Testo 10 caratteri

Descrizione Testo 20 caratteri

Prezzo Valuta in Euro con 2 cifre decimali

 

 
Creazione Tabella

 NOTA: Nell'inserire i dati di un campo Data occorre fare attenzione che Access non 
riconosce 1/1/02 come 1 gennaio 0002! Per evitare spiacevoli sorprese occorre inserire 
01/01/2002

 

Chiave primaria

Ogni tabella deve contenere un campo che consenta di identificare ogni dato in un modo 
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univoco. Questo campo viene definito chiave primaria. Nell'esempio non possono esistere 
due o più articoli che hanno lo stesso CodiceArticolo. Si imposterà questo campo come 
Chiave primaria. 

 

Creazione di una chiave primaria:

1.  Selezionare il campo

2.  Fare click sul pulsante  Chiave Primaria

A questo punto sulla sinistra del campo compare una piccola chiave

 

CONVENZIONI

Per rendere maggiormente leggibili le informazioni presenti nel database si preferisce 
aggiungere ID prima del nome di ogni campo chiave. Quindi CodiceArticolo diventerà 
IDCodiceArticolo. 

A questo punto si può salvare la tabella dandogli il nome Articoli.

 
Tabella Articoli

 

Verifica e modifica di una tabella

Prima di passare all'inserimento dei dati conviene verificare che la tabella soddisfi il nostro 
progetto. Apportare delle modifiche a una tabella con dati inseriti può portare spiacevoli 
conseguenze:

●     Campo testo diventa campo numerico - Tutte le lettere saranno eliminate e 
rimarranno solo i numeri

●     Riduzione della dimensione di un campo numerico - I dati che oltrepassano la nuova 
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dimensione saranno tagliati.

 

Modifica di una tabella

Conviene sempre lavorare in visualizzazione struttura. Per lavorare con una tabella chiusa 

basta farvi click sopra e utilizzare il bottone .

 

Inserimento di un campo.

Per inserire un campo nuovo si può proseguire dopo l'ultimo campo presente in tabella. Se 
il nuovo campo deve essere inserito sopra a uno esistente basta fare:

1.  Click sul campo esistente con il tasto destro del mouse
2.  Scegliere Inserisci righe. La nuova riga verrà inserita sopra al campo esistente

 
Inserire righe

 

Eliminazione di un campo.

Per eliminare un campo basta fare:

1.  Click sul campo da eliminare con il tasto destro del mouse
2.  Scegliere Elimina righe. 
3.  Dire di Sì per confermare l'eliminazione.

 

Inserimento dei dati in una tabella
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Una volta creata la struttura della tabella è possibile inserire i dati attraverso la 
visualizzazione Foglio dati.

Durante l'inserimento dei dati Access inserisce automaticamente le righe nuove. Per 
spostarsi da un campo all'altro è molto comodo utilizzare il tasto TAB. 

 
Inserimento dei dati

Note

Se il campo chiave è di tipo contatore, verrà incrementato automaticamente.

Durante la visualizzazione sono presenti i seguenti indicatori:

●      indica il record corrente
●      nuovo record (riga)
●      bottoni per spostarsi velocemente tra i record.

 

Tasti di scelta rapida

La seguente tabella mostra i tasti a scelta rapida comodi per l'inserimento dei dati:

Tasto Significato

CTRL + ' Copia nel campo il contenuto del campo che si trova immediatamente 
sopra

TAB Campo successivo

MAIUSC + TAB Campo precedente

HOME Primo campo record corrente

FINE Ultimo campo record corrente

CTRL + HOME Primo campo del primo record

CTRL + FINE Ultimo campo dell'ultimo record

CTRL + A Seleziona tutta la tabella

F2 Seleziona il contenuto di un campo
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Maiusc + F2 Zoom: visualizza l'inero contenuto del campo in una finestra 

 

Salvare un record

Ogni nuovo record od ogni modifica viene atuomaticamente salvata da Access

 

Eliminare un record

1.  Selezionare il record da aliminare

2.  Premere CANC o 
3.  Confermare con Sì

I record eliminati non possono essere recupertati con il tasto annulla (o CTRL + Z)

 

Funzioni avanzate con i dati in tabella

Cercare i dati con lo strumento Trova

Utilizzando il pulsante  si attiva lo strumento Trova. E' possibile così attivare la ricerca di 
un testo all'interno della tabella ed eventualmente sostituirlo.

 
Lo strumento Trova e Sostituisci

 

Ordinare i dati

Quando il numero dei dati cresce non è semplice individuare i dati che interessano. Per 
ordinare i dati basta fare:

1.  Click sulla colonna in base alla quale si vuole fare l'ordinamento
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Selezione di una colonna

2.  Utilizzare i bottoni di ordinamento crescente / decrescente 

E' possibile selezionare contemporaneamente più campi. L'ordinamento verrà eseguito 
prima sul campo di sinistra e successivamente sugli altri.

 

Filtrare i dati

Un filtro consente di visualizzare determinati record in base a un criterio. I filtri sono di due 
tipi:

●      Filtro in base a selezione

●     Filtro in base a maschera

 

Filtro in base a selezione

E' molto semplice e consiste nell'indicare valore del campo che determina il filtro. I passi 
sono i seguenti:

1.  Click sul valore (ES Prato)
2.  Click sul bottone Filtro in base a selezione

Dati filtrati in base a selezione 

E' possibile selezionare un ulteriore dato e riapplicare il filtro. Quindi i dati visualizzati 
risponderanno a più criteri. 

 

http://www.centroreiki.org/abaco/manuali/F_Access.htm (12 of 80) [11/11/2002 14.52.37]



Corsi di Informatica - Manuale Corso Access 2000

Rimuovere il filtro

Basta premere il tasto  e i dati nascosti riappariranno.

 

Filtro in base a maschera

Questo filtro consente di filtrare più colone contemporanteamente, inserire espressioni 
logiche e specificare alternative

Quando si attiva il filtro in base a maschera compare un foglio dati vuoto contenente tutte 
le colonne della tabella. In ogni colonna compare una freccia che indica la possibilità di 
utilizzare un elenco di tutti i valori presenti nel campo. Per ricercare tutti gli articoli con 
prezzo minore o uguale a € 2,50 bisognerà inserire il testo <=2,50 nel campo Prezzo.

 
Filtro in base a maschera

Gli operatori di controllo che si possono utilizzare sono i seguenti

Operatore Significato

< minore

> maggiore

<= minore o uguale

>= maggiore o uguale

<> diverso

= uguale

AND entrambe le condizioni devono essere vere

OR almento una condizione deve essere vera

NOT nega la condizione

BETWEEN x AND y Tra il valore x e il voalore y compresi

Per filtrare date dell'intero anno 2002 si scriverà: 

(>#01/01/02#) AND (<#31/12/02#) 

oppure

between #01/01/02# AND #31/12/02# 

 

LE MASHERE

Inserire i dati direttamente in tabella non è agevole. Questa operazione normalmente viene 
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svolta utilizzando le maschere. I vantaggi offerti dalle maschere sono:

●     Aspetto grafico più accattivante
●     Possibilità di effetturare controlli sui dati immessi.
●     Visualizzare i dati un record alla volta.
●     Visualizzazione dell'intero campo. Se i campi della tabella sono tanti, il rischio è di 

vedere solo i dati troncati.

Le possibilità offerte per creare le maschere sono le seguenti:

1.  Maschera standard. Soluzione rapida per immettere i dati in tutti i campi della 
tabella.

2.  Creazione guidata. Consente di personalizzare la maschera utilizzando già 
un'impostazione costruita automaticamente in base ai campi della tabella.

3.  Visualizzazione struttura. Permette di intervenire su tutti gli elemementi della 
tabella.

 

Maschera standard

I passi sono i seguenti:

1.  Nel menu Tabelle, si fa click sulla tabella a cui associare la maschera.

2.  Con il bottone Nuovo Oggetto  si seleziona Maschera Standard.

Maschera standard

La maschera viene creata immediatamente.

 
Maschera semplice

Questa mascherà peò non consente di nascondere alcuni campi e visualizza i record uno ad 
uno.

 

Creazione guidata di una maschera

Consente di creare la maschera in base a una serie di passaggi.

Nel menù Maschere selezionare Crea una maschera mediante una creazione guidata, 
e seguire i passaggi:
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1.  Selezionare la tabella su cui si vuole costruire la maschera

2.  Spostare sulla destra i campi che si vuole visualizzare. Il bottone  sposta un solo 

campo mentre il bottone  li sposta tutti. Proseguire con Avanti.

Creazione guidata maschera

Selezionare per esempio tutti i campi e fare Click su Avanti

3.  Scegliere il tipo di Layout e dare Avanti

Scelta del layout

Le possibilità sono 

❍     A colonne: ogni riga contiene un campo. Ogni videata mostra un solo record.
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a colonne

❍     Tabulare: if formato tabella ogni colonna contiene un campo e ogni riga un 
record.

Tabulare

❍     Foglio dati: lo stile e quello già visto nell'immissione dei dati in tabella

Foglio dati

Con il cursore  posizionato nella zona grigia tra un nome di un campo e l'altro è 
possibile, trascinando, modificare la dimensione del campo. Un doppio click 
adatta nella maniera ottimale la dimensione della colonna.

❍     Giustificato. i campi vengono visualizzati in righe identiche per tutta la 
maschera. Ogni videata mostra un solo record.
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Giustificato

4.  Si sceglie lo stile da utilizzare e si passa Avanti

Scelta stile

5.  L'ultimo passaggio consiste nel dare un nome alla maschera. A quato punto è possibile 
aprire la maschera in visualizzazione per visualizzare o inserire i dati oppure 
modificare la struttura della maschera.

Ultimo passaggio
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NOTE. La creazione guidata di una maschera non è perfetta. Nell'esempio la visualizzazione 
tabulare non consente di vedere chiaramente il codice. Una volta creata la maschera 
bisognerà intervenire modificando la struttura.

 

Visualizzazione struttura

Con questa modalità è possibile modificare tutti i parametri della maschera: formattazione 
carattere, allineamento dei campi, ecc.

 

 
Visualizzazione Struttura

Gli elementi che costituisco una maschera sono

●     Intestazione maschera: Può contenere il titolo, il logo ecc.
●     Il corpo: contiene i vari campi
●     Il piè di pagina: può contenere il numero di pagina e eventuali totali 

Per inserire elementi nell'intestazione nel piè di pagina occorre trascinare in giù il bordo con 
il cursore 

 

Modifica degli elementi di una maschera

Gli elementi di una maschera vengono definiti controlli. 

Se si fa click solo sul nome del campo si 
modificherà solo l'etichetta.

Se si fa click sulla parte valore, si 
modifichera tutto il controllo

Quando compare il cursore  significa che si può spostare il controllo. 

il cursore  che compare nell'angolo in alto a sinistra consente di agire solo su 
una parte del controllo (etichetta / valore) 
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Modifica delle dimensioni

Utilizzare i quadratini neri che appaiono sulla cornice del controllo.

 

Modifica della formattazione

Utilizzare la barra degli strumenti formattazione

 
Barra degli strumenti formattazione 

Alcuni comandi sono quelli classici di Word. Vediamoli comunque:

Bottone Significato

Oggetto selezionato o da selezionare

Seleziona il tipo di carattere

Modifica la dimensione del carattere

Applica lo stile grassetto

Applica lo stile corsivo

Applica lo stile sottolineato

Allinea il testo a sinistra

Allinea il testo al centro

Allinea il testo a destra

Applica il colore di sfondo al controllo

Applica il colore al carattere

Applica il colore al bordo del controllo

Modifica lo spessore del bordo del controllo

Modifica l'aspetto del controllo (ombra, 3D, ecc)

 

Barra casella degli strumenti

Barra casella degli strumenti 
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Attraverso questa barra, attivabile con il bottone , è possibile inserire tutti i vari elementi 
che costituiscono una maschera.

 

Inserimento di testi

Per inserire un testo, per esempio un titolo, selezionare il bottone  e 
tracciare un rettangolo nel punto in cui si vuole inserire il testo. Se il testo 
non è visibile occorre allargare la casella di controllo.

 

Inserimento di Caselle di testo

Una casella di testo normalmente fa riferimento ad un campo. 

Il modo più semplice per inserire una casella di testo è utilizzare l'elenco campi attivabile 

con il bottone  A questo punto si seleziona il campo e lo si trascina all'interno della 
maschera

 
Creazione di una casella di testo

Non rimane che allineare opportunamente l'etichetta e la casella.

Un modo più complesso consiste nell'utilizzare il bottone . In questo caso occorre dare 
un nome all'etichetta e collegare opportunamente la casella di testo utilizzando la finestra 

proprietà attivabile con il bottone . Utilizzando l'origine controllo si definisce quale campo 
dovrà essere visualizzato nella casella.

 

 
Definizione della casella di controllo 
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Inserimento di Immagini.

Per inserire un immagine utilizzare il bottone . Tracciare un rettangolo che conterrà 
l'immagine e selezionarla attraverso la finestra inserisci immagine. Per attattare 
perfettamente il rettangolo all'immagine selezionare Formato > Allinea > alla griglia.

 

Inserimento di linee e di rettangoli

Utilizzare rispettivamente i bottoni  e  tracciare.

 

Allineamenti

Per semplificare il posizionamento e il ridimensionamento delle caselle di controllo si 
utilizzano gli strumenti di allineamento. 

1.  Selezionare le caselle di controllo da allineare

2.  Selezionare per esempio Formato > Allinea > In alto.

1.  Selezionare le caselle di controllo da restringere
2.  Selezionare per esempio Formato > Dimensione > Al più stretto.

 

LE QUERY

Una Query è una visualizzazione dei dati contenuti su una o più tabelle, filtrati e/o 
aggregati secondo vari criteri. La traduzione letterale sarebbe "interrogazione", infatti la 
query è il risultato di una domanda posta al database. esistono due tipi di query:

●     dettaglio : vengono visualizzati tutti i campi di tutti i record
●     riepilogo: consente di effettuare calcoli sui campi numerici (somma, media, minimo, 

massimo) oppure di scegliere raggruppamenti di date 

Access semplifica la costruzione delle query mediante la creazione guidata.

Creare una query dettaglio mediante una creazione guidata

1.  Selezionare la tabella su cui si vuole costruire la maschera

2.  Spostare sulla destra i campi che si vuole visualizzare. Il bottone  sposta un solo 

campo mentre il bottone  li sposta tutti. Proseguire con Avanti
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Creare una query mediante una creazione guidata

3.  Scegliere il tipo di query dettaglio e dare Avanti

Scelta dettaglio

4.  Dare un nome alla query. Si può utilizzare la convenzione di far precedere i nomi delle 
query da "Q_". Questo permette di distinguerle facilmente dalle tabelle.
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Impostazione del nome della query

5.  A questo punto è possibile visualizzare il risultato dei dati raccolti.

Creare una query riepilogo mediante una creazione guidata

I passi 1 e 2 sono i medesimi. 

1.  Nel terzo passo si scelgierà riepilogo e Opzioni di riepilogo. 

Scelta Riepilogo

2.  Si sceglie il tipo di risultato che si vuole ottenere: somma, media, minimo, massimo, o 
solo il conteggio dei record
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Scelta delle opzioni di riepilogo

3.  Dare un nome alla query e fare click su Fine.

 

Modifica alla struttura di una query

Con il bottone  è possibile modificare la struttura di una query. Appare la seguente 
videata:

 
Struttura di una query

Il riquadro in alto visualizza la tabella o le tabelle utilizzate nella query. Il riquadro in basso 
visualizza i campi nel seguente modo:

●     Campo: nome del campo (la freccia consente di scegliere altri campi)
●     Tabella: Tabella da cui vengono prelevati i dati relativi al campo
●     Ordinamento: consente di ordinare i risultati della query in modo crescente o 

decrescente
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●     Mostra: consente di visualizzare o nascondere un campo nel foglio di risposta. Per 
esempio può essere utilizzato un campo nascosto per ordinare i dati.

●     Criteri: consente di indicare i criteri per la selezione dei dati.
●     Oppure: consente di aggiungere criteri

Una volta inseriti i dati nella struttura per vedere i risultati occorre fare click sul bottone 

 

Elenco degli articoli in base al prezzo cerscente

La query verrà impostata nel seguente modo

 
Articoli con prezzo crescente

E il risultato sarà

 
Risultato 

Vedremo più avanti come ricavare la somma dei prezzi in base all'articolo. Per fare questo 
però ci occorrono più tabelle.

 

STRUMENTI

Analisi dei dati nelle tabelle
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La nostra tabella articoli non è efficente. Il nome dell'articolo viene ripetuto più volte con i 
problemi già descritti all'inizio della trattazione. 

●     Se il nome di un articolo dovesse cambiare occorre cercare tutti i record con lo stesso 
nome e sostituirlo

●     Si possono creare errori: Prato, prato, Prati
●     Viene occupato spazio inutilmente.

Lo strumento analisi dei dati consente di creare tabelle secondarie collegate alla prima e di 
generare automaticamente una query per semplificare la selezione dei dati.

1.  Selezionare Strumenti > Analizza > Tabella
2.  Compare la seguente finestra. Fare click su Avanti due volte e scegliere la tabella da 

analizzare.

Analizzatore tabelle

3.  Utilizzare il sistema personalizzato di analisi. Questo consente di controllare meglio 
la generazione delle tabelle.

4.  Trascinare Articolo fuori dalla tabella e chiamare le nuove tabelle rispettivamente 
T_Articoli e T_NomeArticoli facendo doppio click sul nome della tabella. Access 
provvederà a collegare automaticamente le due relazioni cerando i campi adeguati. 
Proseguire con Avanti
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Creazione delle tabelle secondarie

5.  Consentire la creazione della query e proseguire con Avanti.
6.  Togliere la selezione "visualizza la guida sulla funzionalità" e dare Fine.

A questo punto viene visualizzata la query di selezione generata automaticamente per 
collegare le due nuove tabelle.

 
Query di selezione creata automaticamente

Passando in modalità struttura è possibile modificare la query.

Visualizzazione delle relazioni

Quando si lavora con un database grande conviene visualizzare tutte le tabelle che lo 
costituiscono e le relazioni che ci sono tra i vari dati. Per attivare la visualizzazione si fa 

click sul bottone relazioni . Il risultato è il seguente:
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Visualizzazioni delle relazioni

Come si può notare esiste un collegamento tra la tabella T_NomeArticolo e T_Articoli. 
Questo collegamento si chiama relazione. Il simbolo  significa che più record nella 
tabella T_Articoli hanno un unica corrispodenza in un record della tavella 
T_NomeArticolo. La relazione è costruita attraverso il campo T_NomeArticoli_ID e il 
campo IDArticolo. Quesuti campi contengono semplicemente dei numeri e sono stati 
generati automaticamente attraverso lo strumento di analisi delle tabelle.

Vedremo in seguito come creare relazioni tra altre tabelle.

 

Esempi

Somma del prezzi per ogni articolo

Ora che sono state create due tabelle è possibile costruire la query per ricavare la somma 
dei prezzi per ogni articolo.

Si utilizza la creazione guidata della query.

1.  Si utilizza la tabella T_Articoli e si inseriscono i campi T_NomeArticoli_ID, Prezzo e 
si prosegue con Avanti.

Creazione guidata query
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2.  Si sceglie il tipo di query per riepilogo e nelle opzioni si sceglie la somma. Si 
prosegue con Avanti.

3.  Si da il nome Q_SommaArticoli alla query e si da Fine.

Il risultato ottenuto è il seguente:

 
Query somma Articoli

I prezzi in euro non sono soddisfacenti. Occorre modificare la struttura della query.

Selezionando la seconda colonna è possibile modificarne le proprietà in modo da inserire 
due cifre decimali nella visualizzazione della somma. 

Modifica della struttura della query

Per agire sulle prorietà del campo occorre premere il bottone . E' anche possibile 
cambiare l'etichetta del campo in Totale: Prezzo in modo che nel risultato compaia la 
scritta Totale.

Le query di riepilogo hanno in più la riga Formula. Serve a indicare con raggruppamento 
che non saranno visualizzati tutti i dati ma saranno raggruppati in base allo stesso nome. 
Somma sta a indicare che sul campo prezzo saranno sommati tutti gli importi.

 

Prezzo più alto, più basso per ogni articolo

La stessa query può essere modificata per sapere il prezzo più alto e più basso di ogni 
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articolo. Trascinando il campo prezzo dalla tabella sulla griglia della query è possibile 
aggiungere altri due criteri.

Inserimento di un campo nella query

Si aggiungono i nomi MAX:Prezzo e MIN:prezzo e nei campi formula si inserirsce 
rispettivamente MAX e MIN.

 
Scelta della formula

  

Indicare per entrambi i campi come proprietà formato:euro e posizione decimali:2 

Il risultato della query è il seguente:
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Risultato query

Si potrà a questo punto salvare il risultato finale della query.

  

Query per la Visualizzazione di un solo articolo

Si può costruire una query per la visualizzazione di un solo articolo. In questo caso si può 
procedere con la creazione in visualizzazione struttura.

1.  Selezionare Creare una query in visualizzazione struttura
2.  Scegliere la tabella T_Articoli e T_NomeArticoli e fare click su Aggiungi. Chiudere la 

finestra con Chiudi.

Scelta delle tabella T_Articoli e T_NomeArticoli

3.  Inserire i campi come in figura e aggiungere il criterio "Agrumi" nella prima colonna.
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Impostazione dei campi

4.  Provare la query con il bottone . Il risultato sarà il seguente:

Risultato di tutti gli articoli Agrumi

 

 

UTILITA' QUERY

Utilità per creare, modificare le query

Per inserire un campo nella griglia si può

●     fare doppio click sul campo
●     trascinarlo dalla tabella sulla griglia.

Per selezionare più campi contigui: si fa click sul primo e con il tasto MAIUSC premuto 
si fa click sull'ultimo.

Per selezionare più campi non contigui: si fa click sul primo e con il tasto CTRL premuto 
si fa click sugli altri campi.

Per portare tutti i campi nella griglia: basta fare doppio click sul nome della tabella. 

Per selezionare campi da una tabella che non è visibile occorre selezionarla. Facendo click 

sul bottone  apparirà la seguente finestra che consente di scelgliere le tabelle da 
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aggiungere:

 
Mostra tabella

Applicare i criteri

E' importante sapere che è possibile scrivere indifferentemente "Agrumi", "agrumi", 
"AGRUMI", nel criterio di ricerca. Access non fa differenza tra maiuscole e minuscole.

Per visualizzare articoli con nome "Agrumi" oppure "Prato" basta indicare il criterio "Prato" 
nella riga oppure

 
Aggiunta del criterio "Prato"

Il risultato sarà il seguente:
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Articoli "Agrumi" e "Prato"

Per visualizzare articoli con prezzo maggiore a € 2,50 si aggiungerà il criterio >2,5 nelle 
righe Criteri e Oppure della colonna Prezzo in questo modo:

Aggiunta del criterio > 2,5

 

Formati

Operatore Significato Esempio

"criterio" si tratta di un testo "Agrumi"

criterio si tratta di un numero 2

#criterio# si tratta di una data #01/01/2002#

 

Operatori

Operatore Significato Esempio

=valore Uguale =2

>valore Maggiore >2

>=valore Maggiore o uguale >=2
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<valore Minore <2

<=valore
Minore o uguale

<=2

<>valore Diverso <>2

condizione1 and condizione2
Entrambe le condizioni
devono essere verificare

>=#01/01/2001# AND
<=#31/12/2001#

condizione1 or condizione2 Almeno una condizione 
devono essere verificata "Agrumi" OR "Prato"

Not condizione La condizione non deve 
essere verificata not "Prato"

Is Null Il campo non contiene valori  

Between valore1 
and valore2

I valori sono compresi tra 
valore1 e valore2

between 2 and 5

Like "L*" I valori iniziano con la lettera L like "a*"

Like "*/mese/*" Tutte le date iniziano nel mese Like "*/03/*"

  

Primi valori

Normalmente la query visualizza tutti i risultati ottenuti. Con la casella di riepilogo primi 
valori è possibile indicare:

●     i primi 5 valori
●     i primi 25 valori
●     i primi 100 valori
●     il 5% dei risultati
●     il 25% dei risultati
●     tutte (valore predefinito)

 

 

Calcoli nelle query

Supponiamo che i prezzi indicati nella tabella T_Articoli siano senza IVA (20%). Potremmo 
inserire una colonna colonna in cui scrivere il prezzo lordo ma questo non è conveniente per 
due ragioni:

1.  Questa colonna occupa spazio
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2.  Il dato può essere calcolato automaticamente evitando errori

Per fare questo ci occorre una query in cui calcolare il prezzo lordo.

Innanzitutto si definisce la query Q_Articoli che contiene codice, articolo, descrizione e 
prezzo:

Creazione query Q_Articoli

Per inserire il prezzo Lordo si può utilizzare il generatore di espressioni attivabile con il 

bottone:  

 

Generatore di Espressioni

 

L'espressione da inserire è la seguente:

Lordo: [Prezzo]*1,2 

dove:
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Lordo è il nome dell'etichetta del campo

[Prezzo] fa riferimento al campo Prezzo

*1,2 calcola e somma l'IVA del 20%

In questo modo il prezzo lordo verrà calcolato correttamente. Dopo aver impostato il campo 
proprietà in modo da visualizzare il Formato Euro con due cifre decimali 

 
Proprietà del campo Lordo

Il risultato della query sarà il seguente:

 
Risultato query con il campo prezzo lordo

 

 

 

I REPORT

Sono lo strumento per creare stampe di qualità. Tramite questo strumento si possono 
stampare elenchi, statistiche, grafici, raggruppare i dati con totali parziali scegliendo stili, 
caratteri, impaginazioni e così via. 

Esistono tre modi per creare i report:

●     Automatico: crea in modo automatico il report. Il risultato non è mai soddisfacente e 
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va ritoccato.
●     Creazione guidata Report: la creazione viene guidata attraverso una serie di 

domande.
●     Visualizzazione struttura: Consente di agire su tutti gli elementi per una creazione 

personalizzata e precisa del report.

 

Creare un report automatico 

1.  Dal menù oggetti si seleziona la tabella.

2.  Con il bottone Nuovo Oggetto  si sceglie Report.

Creazione Report 

3.  Si può scegliere tra report standard a colonne o tabulare.

Scelta del Report Standard

4.  Il report così ottenuto può essere modificato mediante la visualizzazione struttura.
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Risultato del Report a Colonne

 

Creazione del report mediante la creazione guidata

1.  Dal menu Report scegliere Creazione del report mediante la creazione guidata 
2.  Come per le maschere scegliere i campi da visualizzare nel report e andare Avanti.

Scelta dei campi

3.  Se le tabelle sono collegate è possibile scegliere vari modi per raggruppare i dati. Si 
sceglie il modo e si da Avanti.
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Scelta del raggruppamento dei dati

4.  Si sceglie eventualmente il tipo di ordinamento.

Scelta del tipo di ordinamento 

5.  Si sceglie il tipo di Layot e si prosegue.
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Scelta tipo di Layout

6.  Si sceglie il tipo di stile da utilizzare e si prosegue con Avanti.

Scelta dello stile

7.  Si da il nome al report e si termina con Fine. Per convenzione si può decidere che il 
nome di tutti i report inizi con R_

Il risultato finale è il seguente:
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report R-Articoli

Nella visualizzazione del report, prima di essere stampato, sono disponibili i seguenti 
bottoni:

 

Bottone Significato

Passa alla visualizzazione struttura e Anteprima di stampa

Stampa il report

Zoom della pagina

Visualizzazione di una pagina, due pagine, più pagine (4 x 5 Max)

Viausaliizzione al 10%, 25%, 50%, 75%, 100%, 150%, 200% 
o adattata allo schermo (pagina intera)

Chiude la visualizzazione del report

Esporta il report in formato Word o Excel

Apre la finestra database

Crea un nuovo oggetto database

 

Visualuzzazione Struttura Report

La visualizzazione della struttura consente di modificare il report creato automaticamente. 
Non solo, è anche un buon metodo per imparare a utilizzare questa modalità.
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Struttura Report R_Articoli

Come si vede sono presenti cinque aree:

●     Intestazione report: Il contenuto viene stampato solo una volta e serve a dare 
informazioni introduttive o il titolo.

●     Intestazione Pagina: Il contenuto viene ripetuto nell'area superiore di ogni pagina. 
Nel report di tipo tabulare può contenere i titoli delle colonne.

●     Intestazione Articolo: Nel caso di report per raggruppamento contiene le 
informazioni relative al raggruppamento dei dati.

●     Corpo: contiene i record da stampare
●     Piè di pagina pagina: Il contenuto viene ripetuto in fondo ad ogni pagina.
●     Piè di pagina report: Il contenuto viene stampato alla fine del report

 

Funzioni particolari

Come si può notare alla fine della pagina sono presenti delle funzioni particolari. Vediamone 
il significato

Funzione Significato Risultato

=Now() Calcola la data corrente lunedì 13 maggio 2002

="Pagina "&[Page]&" di "&[Pages]
indica il numero della pagina corrente 
[Page] e il numero di pagine totali 
[Pages]

Pagina 1 di 1

 

Creazione del report mediante la visualizzazione struttura

1.  Nella finestra database, selezionare Report e fare click sul bottone Nuovo  
2.  Scelgiere Visualizzazione Struttura e La tabella su cui costruire il report. In questo 

modo sarà semplice inserire i campi relativi alla tabella.
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Creazione Nuovo Report

3.  Inserire nell'intestazione pagina titolo utilizzando il bottone Etichetta . In questo 
caso è stato inserito il testo "Articoli", il tipo di carattere è stato impostato Comic 
Sans MS a 24 punti in colore Blu. Per modificare la dimensione della casella di testo si 
usa Formato > Dimensione > Al contenuto.

Etichetta Articoli

4.  A questo punto si possono inserire i campi usando la finestra Elenco Campi attivabile 
con il bottone . Si selezionano tutti i campi facendo click sul primo e MAIUS + click 
sull'ultimo, e si trascinano nell'area Corpo.

Inserimento campi dalla tabella

5.  Sistemare l'allineamento dei vari campi.
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Allineamento dei campi

Se si prova il report con l'anteprima di stampa  si ottiene il seguente risultato:

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Anteprima di stampa

 

Creare il report in forma di tabella

Per spostare le etichette nella parte di Intestazione pagina utilizzare il seguente metodo

1.  Selezionare le etichette a sinistra.
2.  Tagliarle con Modifica > Taglia o CTRL + X
3.  Allargare l'area intestazione trascinando in giù il cursore  posizionato sopra l'area 

corpo fino a 5,5 cm indicati sul righello di sinistra
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4.  Incollare le etichette con Modifica > Incolla o CTRL + V e posizionarle

 
Incolla le etichette

5.  Spostando le etichette si può arrivare al segunete formato del report:

Impostazione del report a colonne

6.  Inserire la data utilizzando Inserisci > Data e ora
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Inserire la data e l'ora

7.  Inserire i numeri di pagina utilizzando Inserisci > Numeri di pagina, specificando il 
formato e la posizione.

Inserire i numeri di pagina

Il risultato finale della struttura del report sarà la seguente:

 
Struttura finale del report

E l'anteprima di stampa sarà
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

Report Finale

 

Funzioni particolari

Per la data e l'ora sono state inserite automaticamente la funzioni

Funzione Significato Risultato

Format(Date();"Data breve") Calcola la data corrente nel formato "Data Breve" 13-mag-02

Format(Time();"Ora breve 12h" Calcola l'ora nel formato "Ora breve 12h" 8:30

 

 

Utilità per il posizionamento dei campi

●     Per selezionare oggetti sulla stessa riga utilizzare la freccia nera sul righello di sinistra

Selezione di una riga

●     Per selezionare oggetti sulla stessa colonna utilizzare la freccia nera sul righello in alto

Selezione di una colonna
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●     Per selezionare oggetti nella stessa area tracciare un rettangolo. E' sufficiente che 
l'oggetto venga toccato dal rettangolo per essere selezionato

 
Selezione di un'area

LE RELAZIONI

Vediamo come creare le relazioni fra tabelle. Per fare questo ci occorre definire una tabella 
T_Acquisti in cui inseriremo la data di acquisto e la quantità per ogni articolo. Per fare 
questo ci occorre modificare la tabella T_Articoli e creare un nuovo campo chiave 
IDCodice. Questo perchè se nella tabella T_Acquisti volessimo fare riferimento al codice 
dovremmo definire un campo di tipo testo come per T_Articoli con le conseguenze:

●     occupazione di spazio inutile
●     problemi nella modifica del codice articolo.

La tabella T_Articoli diventa

La nuova tabella T_Articoli

 

La nuova tabella T_Acquisti sarà invece:
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Tabella T_Acquisti

 

Vediamo ora come creare il collegamento tra le due tabelle definendo la relazione.

 NOTA: Una relazione può essere creata solo fra due campi di identici tipi e dimensioni.

 

Definizione delle relazioni

Per definire le relazioni occorre utilizzare il bottone . Apparirà la seguente schermata:

 
La finestra delle Relazioni

1.  Per aggiungere la relazione T_Acquisti occorre premere il bottone . A questo 
punto compare la finestra Mostra tabella 
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Finestra Mostra tabella

2.  Selezionare la tabella T_Acquisti e fare click su Aggiungi. Chiudere la finestra. Ora la 
nuova relazione appare inseme alle altre.

Tabella T_Acquisti inserita

3.  Ora vogliamo creare una relazione tra e IDCodice in T_Articoli e IDCodice in 
T_Acquisti. Per fare questo semplicemente facciamo click su IDCodice in T_Articoli 
e trasciniamo il puntatore sulla tabella T_Acquisti. 

Creazione della relazione

4.  A questo punto bisogna dare una serie di indicazioni nella finestra Modifica relazioni. 
❍     Applica integrità referenziale 
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❍     Aggiorna campi correlati a catena

Finestra Modifica relazioni

5.  Terminare facendo click su Crea. La relazione è stata creata.
6.  Salvare il layout delle relazioni Attraverso File > Salva.

 
Relazione tra T_Articoli e T_Acquisti

 

 

Relazione 1 a N

Significa che un record in una tabella ha più corrispondenze in un'altra tabella. Infatti 
possono essere fatti più acquisti con lo stesso codice articolo. Per definizione la tabella 
T_Articoli si definisce principale , mentre la tabella T_Acquisti viene definita correlata. Il 
fatto che la relazione sia 1 a molti è dovuto anche dal fatto che IDCodice è un campo 
chiave nella relazione T_Articoli.

 

Integrità refernziale

Significa che nel database non potranno esistere record orfani. In pratica Access fa in modo 
che nella tabella correlata non si creino record che non hanno corrispondenze con un record 
nella tabella principale. Non potrà esistere un acquisto che fa riferimento a un codice 
inesistente.
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Aggiorna i campi correlati a catena

Se attivo significa che se si modifica il campo chiave nella tabella principale, i record 
associati nella tabella correlata verranno automaticamente modificati.

Se non è attivo impedisce l'operazione di modifica.

 

Elimina i campi correlati a catena (da usare con molta cautela)

Se attivo significa che se si elimina il campo chiave nella tabella principale, i record 
associati nella tabella correlata verranno automaticamente eliminati.

Se non è attivo impedisce l'operazione di cancellazione.

 

Nell'esempio si è scelto di non eliminare gli articoli. 

 

Ricerca 

Quando si lavora con i campi chiave numerici diventa scomodo aprire una tabella, per 
esempio T_Articoli per sapere qual'e in numero IDCodice corrispondente per poi inserirlo 

nella tabella T_Acquisti. Per lavorare unicamente con i codici degli articoli bisogna 
utilizzare le ricerche che vengono definite nella struttura della tabella. 

1.  Si seleziona in questo caso la tabella T_Acquisti e la si apre in modalità struttura con 

2.  Selezionare il campo IDCodice 
3.  Si utilizza la scheda Ricerca e si imposta la Casella combinata 

Scelta della casella combinata per la ricerca
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4.  In Origine riga si fa click sul bottone  per creare la query di ricerca. 

Bottone per la definizione della ricerca dei dati

5.  Attraverso la finestra Mostra tabella si inserisce la tabella T_Articoli 
6.  Vengono inseriti i campi Codice e IDCodice. In questo modo verranno visualizzati i 

codici in chiaro e il risultato della selezione sarà il valore del campo chiave IDcodice

 
Creazione della query di ricerca

7.  Si può salvare la query con il nome Q_CodiceArticolo
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Risultato di Q_CodiceArticolo

8.  Chiudere il generatore di query con la X e dire di si per salvare le modifiche. La Query 
creata ora si trova come Origine riga.

Q_CodiceArticolo in Origine riga

9.  A questo punto bisogna indicare che il risultato della ricerca va preso dalla seconda 
colonna della query (IDCodice)indicando come colonna associata 2 

Impostazione finale della ricerca

10.  Una volta salvata la tabella si può passare alla visualizzazione del foglio dati con . 
Come si noterà è semplice la scelta del codice articolo.

http://www.centroreiki.org/abaco/manuali/F_Access.htm (55 of 80) [11/11/2002 14.52.37]



Corsi di Informatica - Manuale Corso Access 2000

Immissione dei dati in T_Acquisti facilitata

Se si volesse vedere anche IDCodice occorrerebbe cambiare il numero di colonne e 
portarlo a 2

Altre utili opzioni

●     Righe in elenco 
Indica quante righe possono essere visualizzate nel menù a discesa

●     Solo in elenco
Impostato a Sì significa che non è possibile scrivere direttamente un valore nel 
campo, ma va scelto tra quelli in elenco.

 

ESEMPI DI QUERY

Query per la tabella T_Aquisti

Questa tabella ha anche un campo data. Per questo è possibile impostare una query di 
riepilogo sulle date.

1.  Creare una query mediante una creazione guidata
2.  Sceglie re Riepilogo e nelle Opzioni di riepilogo impostare Somma
3.  Scegliere di raggruppare le date per mese 
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Scelta dell'ordine per le date

4.  Salvare la Query con il nome Q_Acquisti

Il risultato della query è il seguente

 
Query di riepilogo sulle date

Come si può notare c'è un raggruppamento per mesi ma questi ultimi non sono in ordine 
cronologico. Per creare un ordine occorre inserire nella query anche il campo data con 
criterio crescente e con Mostra disattivato.
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Aggiunta del campo Data

Per le Note il sistema ha scelto di visualizzare la prima delle note con Primo. 

Per il raggruppamento delle date è stata inserita la formula 

Data per mese: Format$([T_Acquisti].[Data];'mmmm aaaa') 

Dal campo Data della tabella T_Acquisti la data viene rappresentata con anno e mese. 
Con questo valore viene costruito il raggruppamento

Per in campo anno la data viene trasformata in un numero: l'anno viene moltiplicato per 12 
e a questo numero viene sommato il mese-1:

Year([T_Acquisti].[Data])*12+DatePart('m';[T_Acquisti].[Data])-1) 

Per visualizzare la situazione per ese può essere opportuno visualizzare solo i dati seguenti:

Impostazione finale della query

Il risutato è il seguente
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Risultato 

Perchè tutto questo funzioni correttamente il campo Data nella tabella T_Acquisti deve 
essere indicizzato

Campo Data indicizato

 

GLI INDICI

Servono a tenere la tabella ordinata. Un indice è una piccola tabella sempre ordinata 
costituita da riferimenti ai record della tabella principale. Questa tecnica permette di poter 
ordinare la tabella secondo vari criteri. Nel caso della tabella T_Acquisti le ricerce possono 
essere fatte per data o per Articolo. Costruire un indice su questi campi semplifica la ricerca 
dei record. 

Per creare un indice si lavora in modalità struttura con la tabella 

1.  Si seleziona il campo, nell'esempio è stato scelto data
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Creazione di un indice

2.  Si imposta in campo indicizzato a 
❍     Sì (Duplicati ammessi)
❍     Sì (duplicati non ammessi)

Nel caso della data i duplicati sono ammessi: più acquisti possono essere fatti nella stessa 
data.

Se un indice non ammette duplicati, per esempio il codice articolo, il sistema garantisce che 
non possano esserci due valori uguali.

 NOTA: Per ogni record inserito, modificato, cancellato, gli indici devono essere aggiornati. 
E per questo che per evitare rallentamenti nell'utilizzo del database l'uso degli indici deve 
essere fatto con cura.

 

UTILITA'

Operazioni nei report e nelle sottomaschere 

Si costruisce la query Q_TotaleAcquisti definita come segue:
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Query Q_TotaleAcquisti

Il risultato della query è il seguente:

 
Risultato 

Vogliamo costruire ora una maschera M_TotaleAcquisti per visualizzare il risultato della 
query e fare una somma di tutto quello che è stato acquistato.

1.  Mediante la creazione guidata si costruisce la maschrea sulla query Q_TotaleAcquisti 
inserendo tutti i campi. 

Cosrtuzione della maschera M_TotaleAcquisti
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2.  Si sceglie il formato Tabulare, lo stile e si slava con il nome M_TotaleAcquisti. Il 
risultato è il seguente:

Maschera M_TotaleAcquisti

3.  Lavorando nella modalità Struttura apportiamo le seguenti modifiche: L'etichetta 
SommadiQuantità viene modificata in Totale

4.  Si allarga lo spazio del Piè di pagina e attraverso la casella degli strumenti attivabile 

con  si crea una casella di testo con il bottone . 

Creazione della casella di testo

5.  Facendo clic sulla parte di testo si cancella l'eticetta con CANC

6.  Utilizzando la finestra proprieta per la casella di testo attivabile con  si imposta 
l'origine del controllo al valore

=Somma([SommaDiQuantità]) 

Origine del controllo per la casella di testo

Per facilitare l'immissone dei dati si può utilizzare anche la maschera di zoom 
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attivabile con MAIUSC + F2

7.  Si può aggiundere un'intestazione e il risultato è il seguente.

 
Inserimento del titolo

La maschera visualizzata è :

Risultato 

 

I Folgi secondari 

Quando due o più tabelle sono collegate tramite una relazione si possono utilizzare i folgi 
secondari. Avendo colledato la tabella degli acquisti agli articoli, ogni volta che si apre la 
T_Articoli appare la seguente schermata:
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Tabella T_Articoli

Il segno  che compare a sinistra significa che facendovi è possibile espandere il foglio 
associato:

 
Foglio associato a T_Articoli

Facendo click sul segno meno il foglio associato verrà chiuso.

 

Creazione della maschera con sottomeschere

Utilizzando una maschera è possibile rappresentare questi dati un un formato più semplice: 
per ogni articolo si avrà il dettaglio degli acquisti.

1.  In Maschere utilizzare Crea una maschera mediante una creazione guidata.
2.  Dalla tabella T_Articoli inserire: Codice, Descrizione, Prezzo

Dalla tabella T_NomeArticoli inserire: Articolo
Dalla tabella T_Acquisti inserire: Data, Quantità, Note
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Inserimento dei campi

3.  Scegliere di visualizzare i dati in base a T_Articoli in modo da avere la mashera con 
sottomaschere

Visualizzazione in base a T_Articoli

4.  Scegliere il layout tabulare e proseguire
5.  Scelgiere lo stile e proseguire
6.  Dare i nomi M_Articoli e SM_Acquisti ripsettivamente alla maschera e alla 

sottomaschera
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Scelta dei titoli delle maschere

7.  Terminare con Fine

Il risultato, è come sempre, da sistemare in modalità struttura

Maschera M_Articoli

 

1.  L'etichetta SM_Acquisti può essere cancellata
2.  La sottomaschera si può spostare a sinistra
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Agendo opportunamente sui vari campi la maschera può diventare:

Nuovo formato della maschera M_Articoli

E verrà visualizzata come
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Risultato finale

Inserimento della somma delle quantità acquistate

E' possibile aggiungere la somma delle quantità acquistate inserendo un totale nella 
sottomaschera. per fare questo occorre

1.  Chiudere tutte le maschrere e aprire la sottomaschera SM_Acquisti
2.  Allargare lo spazio del piè di pagina
3.  Inserire una casella di testo e mettere come etichetta Totale:
4.  Nella casella di testo inserire come origine controllo

=Somma([Quantità])

Aggiunta del Totale

5.  Salvare la sottomaschera. il risultato sarà
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Nuova maschera M_Articoli

 

Inserire il totale acquistato

Volgiamo ilserire il totale acquistato dato dal totale moltiplicato per il prezzo.

1.  Lavorando con la sottomaschera SM_Acquisti occorre dare un'etichetta al totale. 
Attraverso la finestra proprietà viene inserita l'etichetta TotaleArticoli. 

 
Aggiunta dell'etichetta TotaleArticoli

2.  Aggiungi una casella di testo e nell'etichetta si inserisce Totale Acquistato
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Aggiunta della casella di testo 

3.  Utilizzando la finestra proprietà si inserisce la formula 

=[Prezzo]*[SM_Acquisti]!TotaleArticoli

Per il Formato si utilizza Euro con due cifre decimali

Proprietà della casella di testo

4.  Il risultato è il seguente:
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Risultato finale con il Totale Acquistato 

 

Migliorie grafiche

Si può eliminare la barra di scorrimento orizzontale della sottomaschera. Per fare questo 
occorre lavorare con la sottomaschera visualizzata dalla maschera M_Articoli. 

1.  Fare click sul quadratino nero della sottomaschera SM_Acquisti

Selezione della sottomaschera SM_Acquisti

2.  In barre di scorrimento selezionare Verticale
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Eliminazione delle barre di scorrimento

3.  Per eliminare i pulsanti che consentono la selezione dei record si seleziona No per i 
Pulsanti spostamento.

4.  Si imposta a No anche Linee di divisione e Selettori record.

5.  Il risultato è il seguente:
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Maschera migliorata 

La barra verticale consente di scorrere l'elenco di più acquisti.

 

Utilizzo della maschera solo per l'introduzione degli acquisti.

Se la maschera M_Articoli deve essere utilizzata solo per inserire gli acquisti, bisogna 
evitare che l'utente possa modificare il codice, la descrizione, l'Articolo, il Prezzo e il 
Totale Acquistato. In questo caso bisogna impostare nella finestra proprietà, scheda Dati:

●     Bloccato Sì
●     Abilitato No

E' importante l'ordine in cui dare queste due impostazioni.

Blocco dei campi 
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In questo modo non è possibile modificare questi campi utilizzando la maschera 
M_Articoli. Può per questo scopo essere creata un'altra maschera per modificare tutti i 
dati relativi ai singoli articoli.

 

Creazione di un report con i sottoreport

Vogliamo inserire le stesse informazioni della maschera M_Articoli in un report. In questo 
modo verrà visualizzato il dettaglio di tutto ciò che è stato acquistato. 

1.  Si attiva la Creazione guidata dei Report
2.  Si inseriscono i seguenti campi: 

❍     Codice dalla tabella T_Articoli
❍     Articolo dalla tabella T_NomeArticoli
❍     Descrizione dalla tabella T_Articoli
❍     Prezzo dalla tabella T_Articoli
❍     Data dalla tabella T_Acquisti
❍     Quantità dalla tabella T_Acquisti
❍     Note dalla tabella T_Acquisti

3.  Si sceglie la visualizzazione in base a T_Articoli

Visualizzazione dei dati in base a T_Articoli

4.  Non si aggiungono livelli di gruppo e si prosegue
5.  Per quanto riguarda il report di dettaglio si ordinano gli acquisti in base alla Data
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Ordinamento in base alla data del report di dettaglio

6.  Si sceglie il layout Allineato a sinistra 2 e il foglio orientato verticalmente.

Scelta del layout

7.  Si sceglie lo stile da utilizzare (Es Società) 
8.  Si attrubuisce il nome al report R_Articoli.
9.  Si temina con Fine. Il risultato è il seguente:
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report R_Articoli

Per ogni articolo compare il dettaglio di ciò che è stato acquistato. Utilizzando la modalità 
struttura è possibile migliorare il report.

 

Inserire il totale acquistato per ogni articolo

Come per la maschera si vuole inserire il tiotale acquistato. 

1.  Si attiva la modalità struttura.
2.  Attraverso Visualizza > Ordinamento e raggruppamento, si attiva il Piè di pagina 

pe IDCodice 

Attivazione piè di pagina

3.  Si disegna con il bottone  una casella di testo. Si inserisce l'etichetta Totale

http://www.centroreiki.org/abaco/manuali/F_Access.htm (76 of 80) [11/11/2002 14.52.37]



Corsi di Informatica - Manuale Corso Access 2000

Nuova casella di testo Totale

4.  Attraverso la maschera proprietà si imposta l'origine del controllo a 

=Somma([Quantità])

Casella di testo TotaleArticoli

5.  Il risultato con opportune modifiche per la disposizione dei campi è il seguente: 
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
Stampa dei totali 

 

Inserire il Totale Acquistato

Per inserire il totale acquistato occorre anche qui inserire una nuova casella di testo

1.  Inserire una casella di testo e nel campo etichetta scrivere Totale Acquistato
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Nuova casella di testo

2.  Attraverso la finestra proprietà si inserisce come origine dei dati

=[Prezzo]*[TotaleArticoli]

si imposta il formato Euro con due cifre decimali

 
Proprietà per la casella di testo TotaleAcquistato

3.  Il report diventa
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report con il totale acquistato

 

 

 

Appendice

 

Tasto Significato

MAIUSC + F2 finestra di zoom
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Access 2000

Introduzione

Che cos'è un Database

Il modo migliore per spiegarlo è attraverso un esempio: Una rubrica telefonica

Nome Indirizzo Città CAP PR Tel

Centro Internazionale 
Reiki Via Lonate 6 Turbigo 20029 MI 0331891111

Ritorante San Pietro
Via Alzaia 
Naviglio Grande 
18

Robecchetto con 
Induno 20020 MI 0331875402

Silvio Crispiatico Via Lonate 6 Turbigo 20029 MI 0331891111

Rubrica

Un database quindi non è altro che una raccolta di dati. Tutti i i dati sono ordinati 
alfabeticamente. 

Alcune definizioni in base all'esempio

Campo Si intende "nome", "indirizzo", "città", "CAP", "PR", "Tel"

Record Ogni utente nella rubrica

Nella progettazione di un database si parte dalla definizione dei Campi che fanno parte del 
database. Ogni utente che verrà aggiunto al database ne modificherà la dimensione, ma 
non la struttura.

Un database quindi è formato da una tabella. Nell'esempio precedente si può notare che ci 
sono dei dati ripetuti. Le informazioni Città, CAP e PR sono strettamente collegate. Quindi si 
potrebbe creare una tabella città: 

NumeroCIttà Città CAP PR

1 Robecchetto con Induno 20020 MI

2 Turbigo 20029 MI
città

e la tabella Rubrica diventerebbe 
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Nome Indirizzo NumeroCIttà Tel

Centro Internazionale Reiki Via Lonate 6 2 0331891111

Ritorante San Pietro Via Alzaia Naviglio Grande 18 1 0331875402

Silvio Crispiatico Via Lonate 6 2 0331891111

Rubrica

Vantaggi di questa tecnica:

●     Riduzione dello spazio accupato
●     Congruenza dei dati: Turbigo sarà sempre in provincia di Milano e avrà sempre lo 

stesso CAP
●     Riduzione degli errori di scrittura: con una tabella unica si potrebbero creare 

"Robecchetto con Induno", "Robecchetto c/I", "Robecchetto con I.", e questo 
complicherebbe la ricerca di tutti gli utenti che sono nella stessa città.

In termini informatici tutto questo si dice normalizzare il database : Ogni dato compare 
una sola volta.

Acces consente lavorare a un database database in tre modi

1.  Utilizzando un database esistente. Il database Nortwind è un esempio di tutte le 
possibilità offerte dal programma per la gestione dei dati e può essere installato come 
esempio.

2.  Utilizzando progetti di database. In questo caso si utilizzano dei database 
preimpostati scegliendo quello che più si avvicina a ciò che vogliamo creare noi

3.  Creando il database dal nulla. In questo caso una volta pianificato il database si 
passera alla costruzione degli elementi principali che lo compongono: 

❍     Tabelle
❍     Query
❍     Maschere
❍     Report

Il primo modo è utile per vedere tutte le possibilità offerte da un database. E' possibile in 
questo modo prendere spunti per il proprio progetto. Il secondo modo è utile se non si ha 

molto tempo e se il modello scelto è molto vicino al database che si vuole creare.

Prenderemo in considerazione il terzo modo per avere una completa gestione del database.
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database Northwind

Elementi principali di un database

Tabelle 

Contengono tutti i dati del database. Sono strutturate in righe e colonne come i fogli Excel. 
Esistono due modi per operare sulle tabelle:

Apri: In questo caso si vedono i dati contenuti nella tabella. E' possibile aggiundere dei 
valori o righe e modificare i dati.

Struttura: Per ogni campo è possibile deinire il tipo di dati che contiene ed eventualmente 
delle regole per l'immissione dei dati. Può essere comodo aggiungere una descrizione che 
spiega più chiaramente il significato del campo.
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Struttura 

 

Maschere

Facilitano l'inserimento dei dati in una o in più tabelle. Consentono di inserire dei controlli o 
addirittura di visualizzare dei risultati ottenduti lavorando sui dti
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Maschera complessa

 

Report

Consentono di stampare i dati presenti database secondo una certa struttura. 
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Report 

 

Query

Sono interrogazioni che permettono di estrarre dei dati dal database socondo vari criteri. 
Le più utilizzate sono le query di selezione che estraggono solo alcuni dati eventualmente 
messi in relazione con altre tabelle.

 

 
Query 

 

Le Tabelle

Creazione di una nuova tabella partendo da zero

Una volta attivato Access, si sceglie di creare un database vuoto. A questo punto bisogna 
indicare dove salvare il database e che nome avrà. Questo perchè Access provvede, a 
differenza di altri programmi, a salvare automaticamente le modifiche.

Dal menù Tabelle si sceglie Crea una tabella in visualizzazione struttura.
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Finestra database

Ora bisogna inserire i seguenti elementi:

●     Nome Campo: identifica il campo e il nome può anche arrivare a 64 caratteri. E' bene 
utilizzare nomi senza spazi

●     Tipo Dati: sono il tipo di informazioni contenute. Verrnnno maggiormente descritte in 
"Tipi di dati e proprietà dei campi"

●     Descrizione: opzionale. Consente di dare una descrizione più completa al contenuto e 
al significato del campo.
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Impostazione tipi di dati

 

Tipi di dati e proprietà dei campi

Campo descrizione

Testo Caratteri alfanumerici (nomi, indirizzi, cap, ...), max 255

Memo Testo molto lungo con caratteri alfanumerici, max 65.535

Numerico numeri su cui devono essere eseguiti calcoli

Data e ora date e orari compresi tra 100 e 9999

Valuta Utile per Euro e altre monete. Precisione 15 cifre + 4 dopo la virgola

Contatore Numero progressivo univoco gestito da Access

Sì/No Valori Sì / No oppure Vero / Falso

Oggetto OLE Oggetto, Immagine collegato o incorporato in una tabella Access

Collegamento
Ipertestuale Collegamento a indirizzi URL

Ricerca
Guidata 

consente la grazione di un elenco deve è possibile selezionare un valore 
per ogni record.

Vediamo ora le proprietà più importanti descritte nella scheda Generale

Generale nome

Dimensione
Campo 

Lunghezza massima di un campo di testo o numerico. Limita la 
dimensione del database

Formato Indica l'aspetto dei dati

Etichetta
Nome visualizzato come titolo della colonna. Utile perchè il nome del 
campo normalmente non ha spazi bianchi e soprattutto per la 
creazione delle maschere e dei report

Valore predefinito Valore inserito automaticamente ogni volta che viene creato un 
nuovo record

Posizioni decimali Indica per i campi numerici e valuta il numero di cifre decimali

Richiesto Se impostato su Sì obbligherà l'utente a inserire sempre un valore 
nel campo
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Se vogliamo creare una tabella che descriva degli articoli possiamo avere i seguenti campi

Generale nome

CodiceArticolo Testo 10 caratteri

Articolo Testo 10 caratteri

Descrizione Testo 20 caratteri

Prezzo Valuta in Euro con 2 cifre decimali

 

 
Creazione Tabella

 NOTA: Nell'inserire i dati di un campo Data occorre fare attenzione che Access non 
riconosce 1/1/02 come 1 gennaio 0002! Per evitare spiacevoli sorprese occorre inserire 
01/01/2002

 

Chiave primaria

Ogni tabella deve contenere un campo che consenta di identificare ogni dato in un modo 
univoco. Questo campo viene definito chiave primaria. Nell'esempio non possono esistere 
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due o più articoli che hanno lo stesso CodiceArticolo. Si imposterà questo campo come 
Chiave primaria. 

 

Creazione di una chiave primaria:

1.  Selezionare il campo

2.  Fare click sul pulsante  Chiave Primaria

A questo punto sulla sinistra del campo compare una piccola chiave

 

CONVENZIONI

Per rendere maggiormente leggibili le informazioni presenti nel database si preferisce 
aggiungere ID prima del nome di ogni campo chiave. Quindi CodiceArticolo diventerà 
IDCodiceArticolo. 

A questo punto si può salvare la tabella dandogli il nome Articoli.

 
Tabella Articoli
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Verifica e modifica di una tabella

Prima di passare all'inserimento dei dati conviene verificare che la tabella soddisfi il nostro 
progetto. Apportare delle modifiche a una tabella con dati inseriti può portare spiacevoli 
conseguenze:

●     Campo testo diventa campo numerico - Tutte le lettere saranno eliminate e 
rimarranno solo i numeri

●     Riduzione della dimensione di un campo numerico - I dati che oltrepassano la nuova 
dimensione saranno tagliati.

 

Modifica di una tabella

Conviene sempre lavorare in visualizzazione struttura. Per lavorare con una tabella chiusa 

basta farvi click sopra e utilizzare il bottone .

 

Inserimento di un campo.

Per inserire un campo nuovo si può proseguire dopo l'ultimo campo presente in tabella. Se 
il nuovo campo deve essere inserito sopra a uno esistente basta fare:

1.  Click sul campo esistente con il tasto destro del mouse
2.  Scegliere Inserisci righe. La nuova riga verrà inserita sopra al campo esistente

http://www.centroreiki.org/abaco/manuali/T_Access.htm (11 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

 
Inserire righe

 

Eliminazione di un campo.

Per eliminare un campo basta fare:

1.  Click sul campo da eliminare con il tasto destro del mouse
2.  Scegliere Elimina righe. 
3.  Dire di Sì per confermare l'eliminazione.

 

Inserimento dei dati in una tabella

Una volta creata la struttura della tabella è possibile inserire i dati attraverso la 
visualizzazione Foglio dati.

Durante l'inserimento dei dati Access inserisce automaticamente le righe nuove. Per 
spostarsi da un campo all'altro è molto comodo utilizzare il tasto TAB. 
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Inserimento dei dati

Note

Se il campo chiave è di tipo contatore, verrà incrementato automaticamente.

Durante la visualizzazione sono presenti i seguenti indicatori:

●      indica il record corrente
●      nuovo record (riga)
●      bottoni per spostarsi velocemente tra i record.

 

Tasti di scelta rapida

La seguente tabella mostra i tasti a scelta rapida comodi per l'inserimento dei dati:

Tasto Significato

CTRL + ' Copia nel campo il contenuto del campo che si trova immediatamente 
sopra

TAB Campo successivo

MAIUSC + TAB Campo precedente

HOME Primo campo record corrente

FINE Ultimo campo record corrente

CTRL + HOME Primo campo del primo record

CTRL + FINE Ultimo campo dell'ultimo record

CTRL + A Seleziona tutta la tabella

F2 Seleziona il contenuto di un campo
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Maiusc + F2 Zoom: visualizza l'inero contenuto del campo in una finestra 

 

Salvare un record

Ogni nuovo record od ogni modifica viene atuomaticamente salvata da Access

 

Eliminare un record

1.  Selezionare il record da aliminare

2.  Premere CANC o 
3.  Confermare con Sì

I record eliminati non possono essere recupertati con il tasto annulla (o CTRL + Z)

 

Funzioni avanzate con i dati in tabella

Cercare i dati con lo strumento Trova

Utilizzando il pulsante  si attiva lo strumento Trova. E' possibile così attivare la ricerca di 
un testo all'interno della tabella ed eventualmente sostituirlo.

 
Lo strumento Trova e Sostituisci

 

Ordinare i dati
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Quando il numero dei dati cresce non è semplice individuare i dati che interessano. Per 
ordinare i dati basta fare:

1.  Click sulla colonna in base alla quale si vuole fare l'ordinamento

Selezione di una colonna

2.  Utilizzare i bottoni di ordinamento crescente / decrescente 

E' possibile selezionare contemporaneamente più campi. L'ordinamento verrà eseguito 
prima sul campo di sinistra e successivamente sugli altri.

 

Filtrare i dati

Un filtro consente di visualizzare determinati record in base a un criterio. I filtri sono di due 
tipi:

●      Filtro in base a selezione

●     Filtro in base a maschera

 

Filtro in base a selezione

E' molto semplice e consiste nell'indicare valore del campo che determina il filtro. I passi 
sono i seguenti:

1.  Click sul valore (ES Prato)
2.  Click sul bottone Filtro in base a selezione
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Dati filtrati in base a selezione 

E' possibile selezionare un ulteriore dato e riapplicare il filtro. Quindi i dati visualizzati 
risponderanno a più criteri. 

 

Rimuovere il filtro

Basta premere il tasto  e i dati nascosti riappariranno.

 

Filtro in base a maschera

Questo filtro consente di filtrare più colone contemporanteamente, inserire espressioni 
logiche e specificare alternative

Quando si attiva il filtro in base a maschera compare un foglio dati vuoto contenente tutte 
le colonne della tabella. In ogni colonna compare una freccia che indica la possibilità di 
utilizzare un elenco di tutti i valori presenti nel campo. Per ricercare tutti gli articoli con 
prezzo minore o uguale a € 2,50 bisognerà inserire il testo <=2,50 nel campo Prezzo.

 
Filtro in base a maschera

Gli operatori di controllo che si possono utilizzare sono i seguenti

Operatore Significato

< minore

> maggiore
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<= minore o uguale

>= maggiore o uguale

<> diverso

= uguale

AND entrambe le condizioni devono essere vere

OR almento una condizione deve essere vera

NOT nega la condizione

BETWEEN x AND y Tra il valore x e il voalore y compresi

Per filtrare date dell'intero anno 2002 si scriverà: 

(>#01/01/02#) AND (<#31/12/02#) 

oppure

between #01/01/02# AND #31/12/02# 

 

LE MASHERE

Inserire i dati direttamente in tabella non è agevole. Questa operazione normalmente viene 
svolta utilizzando le maschere. I vantaggi offerti dalle maschere sono:

●     Aspetto grafico più accattivante
●     Possibilità di effetturare controlli sui dati immessi.
●     Visualizzare i dati un record alla volta.
●     Visualizzazione dell'intero campo. Se i campi della tabella sono tanti, il rischio è di 

vedere solo i dati troncati.

Le possibilità offerte per creare le maschere sono le seguenti:

1.  Maschera standard. Soluzione rapida per immettere i dati in tutti i campi della 
tabella.

2.  Creazione guidata. Consente di personalizzare la maschera utilizzando già 
un'impostazione costruita automaticamente in base ai campi della tabella.

3.  Visualizzazione struttura. Permette di intervenire su tutti gli elemementi della 
tabella.

 

http://www.centroreiki.org/abaco/manuali/T_Access.htm (17 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

Maschera standard

I passi sono i seguenti:

1.  Nel menu Tabelle, si fa click sulla tabella a cui associare la maschera.

2.  Con il bottone Nuovo Oggetto  si seleziona Maschera Standard.

Maschera standard

La maschera viene creata immediatamente.

 
Maschera semplice

Questa mascherà peò non consente di nascondere alcuni campi e visualizza i record uno ad 
uno.

 

Creazione guidata di una maschera

Consente di creare la maschera in base a una serie di passaggi.

Nel menù Maschere selezionare Crea una maschera mediante una creazione guidata, 
e seguire i passaggi:

1.  Selezionare la tabella su cui si vuole costruire la maschera

2.  Spostare sulla destra i campi che si vuole visualizzare. Il bottone  sposta un solo 

campo mentre il bottone  li sposta tutti. Proseguire con Avanti.
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Creazione guidata maschera

Selezionare per esempio tutti i campi e fare Click su Avanti

3.  Scegliere il tipo di Layout e dare Avanti

Scelta del layout

Le possibilità sono 
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❍     A colonne: ogni riga contiene un campo. Ogni videata mostra un solo record.

a colonne

❍     Tabulare: if formato tabella ogni colonna contiene un campo e ogni riga un 
record.

Tabulare

❍     Foglio dati: lo stile e quello già visto nell'immissione dei dati in tabella
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Foglio dati

Con il cursore  posizionato nella zona grigia tra un nome di un campo e l'altro è 
possibile, trascinando, modificare la dimensione del campo. Un doppio click 
adatta nella maniera ottimale la dimensione della colonna.

❍     Giustificato. i campi vengono visualizzati in righe identiche per tutta la 
maschera. Ogni videata mostra un solo record.

Giustificato

4.  Si sceglie lo stile da utilizzare e si passa Avanti
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Scelta stile

5.  L'ultimo passaggio consiste nel dare un nome alla maschera. A quato punto è possibile 
aprire la maschera in visualizzazione per visualizzare o inserire i dati oppure 
modificare la struttura della maschera.

Ultimo passaggio

http://www.centroreiki.org/abaco/manuali/T_Access.htm (22 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

NOTE. La creazione guidata di una maschera non è perfetta. Nell'esempio la visualizzazione 
tabulare non consente di vedere chiaramente il codice. Una volta creata la maschera 
bisognerà intervenire modificando la struttura.

 

Visualizzazione struttura

Con questa modalità è possibile modificare tutti i parametri della maschera: formattazione 
carattere, allineamento dei campi, ecc.

 

 
Visualizzazione Struttura

Gli elementi che costituisco una maschera sono

●     Intestazione maschera: Può contenere il titolo, il logo ecc.
●     Il corpo: contiene i vari campi
●     Il piè di pagina: può contenere il numero di pagina e eventuali totali 

Per inserire elementi nell'intestazione nel piè di pagina occorre trascinare in giù il bordo con 
il cursore 

 

Modifica degli elementi di una maschera

Gli elementi di una maschera vengono definiti controlli. 
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Se si fa click solo sul nome del campo si 
modificherà solo l'etichetta.

Se si fa click sulla parte valore, si 
modifichera tutto il controllo

Quando compare il cursore  significa che si può spostare il controllo. 

il cursore  che compare nell'angolo in alto a sinistra consente di agire solo su 
una parte del controllo (etichetta / valore) 

 

Modifica delle dimensioni

Utilizzare i quadratini neri che appaiono sulla cornice del controllo.

 

Modifica della formattazione

Utilizzare la barra degli strumenti formattazione

 
Barra degli strumenti formattazione 

Alcuni comandi sono quelli classici di Word. Vediamoli comunque:

Bottone Significato

Oggetto selezionato o da selezionare

Seleziona il tipo di carattere

Modifica la dimensione del carattere

Applica lo stile grassetto

Applica lo stile corsivo

Applica lo stile sottolineato

Allinea il testo a sinistra
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Allinea il testo al centro

Allinea il testo a destra

Applica il colore di sfondo al controllo

Applica il colore al carattere

Applica il colore al bordo del controllo

Modifica lo spessore del bordo del controllo

Modifica l'aspetto del controllo (ombra, 3D, ecc)

 

Barra casella degli strumenti

Barra casella degli strumenti 

Attraverso questa barra, attivabile con il bottone , è possibile inserire tutti i vari elementi 
che costituiscono una maschera.

 

Inserimento di testi

Per inserire un testo, per esempio un titolo, selezionare il bottone  e 
tracciare un rettangolo nel punto in cui si vuole inserire il testo. Se il testo 
non è visibile occorre allargare la casella di controllo.

 

Inserimento di Caselle di testo

Una casella di testo normalmente fa riferimento ad un campo. 

Il modo più semplice per inserire una casella di testo è utilizzare l'elenco campi attivabile 

con il bottone  A questo punto si seleziona il campo e lo si trascina all'interno della 
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maschera

 
Creazione di una casella di testo

Non rimane che allineare opportunamente l'etichetta e la casella.

Un modo più complesso consiste nell'utilizzare il bottone . In questo caso occorre dare 
un nome all'etichetta e collegare opportunamente la casella di testo utilizzando la finestra 

proprietà attivabile con il bottone . Utilizzando l'origine controllo si definisce quale campo 
dovrà essere visualizzato nella casella.

 

 
Definizione della casella di controllo 

 

Inserimento di Immagini.

Per inserire un immagine utilizzare il bottone . Tracciare un rettangolo che conterrà 
l'immagine e selezionarla attraverso la finestra inserisci immagine. Per attattare 
perfettamente il rettangolo all'immagine selezionare Formato > Allinea > alla griglia.
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Inserimento di linee e di rettangoli

Utilizzare rispettivamente i bottoni  e  tracciare.

 

Allineamenti

Per semplificare il posizionamento e il ridimensionamento delle caselle di controllo si 
utilizzano gli strumenti di allineamento. 

1.  Selezionare le caselle di controllo da allineare

2.  Selezionare per esempio Formato > Allinea > In alto.

1.  Selezionare le caselle di controllo da restringere
2.  Selezionare per esempio Formato > Dimensione > Al più stretto.

 

LE QUERY

Una Query è una visualizzazione dei dati contenuti su una o più tabelle, filtrati e/o 
aggregati secondo vari criteri. La traduzione letterale sarebbe "interrogazione", infatti la 
query è il risultato di una domanda posta al database. esistono due tipi di query:

●     dettaglio : vengono visualizzati tutti i campi di tutti i record
●     riepilogo: consente di effettuare calcoli sui campi numerici (somma, media, minimo, 

massimo) oppure di scegliere raggruppamenti di date 

Access semplifica la costruzione delle query mediante la creazione guidata.

Creare una query dettaglio mediante una creazione guidata

1.  Selezionare la tabella su cui si vuole costruire la maschera

2.  Spostare sulla destra i campi che si vuole visualizzare. Il bottone  sposta un solo 

campo mentre il bottone  li sposta tutti. Proseguire con Avanti
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Creare una query mediante una creazione guidata

3.  Scegliere il tipo di query dettaglio e dare Avanti

Scelta dettaglio

4.  Dare un nome alla query. Si può utilizzare la convenzione di far precedere i nomi delle 
query da "Q_". Questo permette di distinguerle facilmente dalle tabelle.
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Impostazione del nome della query

5.  A questo punto è possibile visualizzare il risultato dei dati raccolti.

Creare una query riepilogo mediante una creazione guidata

I passi 1 e 2 sono i medesimi. 

1.  Nel terzo passo si scelgierà riepilogo e Opzioni di riepilogo. 
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Scelta Riepilogo

2.  Si sceglie il tipo di risultato che si vuole ottenere: somma, media, minimo, massimo, o 
solo il conteggio dei record

Scelta delle opzioni di riepilogo

3.  Dare un nome alla query e fare click su Fine.
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Modifica alla struttura di una query

Con il bottone  è possibile modificare la struttura di una query. Appare la seguente 
videata:

 
Struttura di una query

Il riquadro in alto visualizza la tabella o le tabelle utilizzate nella query. Il riquadro in basso 
visualizza i campi nel seguente modo:

●     Campo: nome del campo (la freccia consente di scegliere altri campi)
●     Tabella: Tabella da cui vengono prelevati i dati relativi al campo
●     Ordinamento: consente di ordinare i risultati della query in modo crescente o 

decrescente
●     Mostra: consente di visualizzare o nascondere un campo nel foglio di risposta. Per 

esempio può essere utilizzato un campo nascosto per ordinare i dati.
●     Criteri: consente di indicare i criteri per la selezione dei dati.
●     Oppure: consente di aggiungere criteri

Una volta inseriti i dati nella struttura per vedere i risultati occorre fare click sul bottone 

 

Elenco degli articoli in base al prezzo cerscente
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La query verrà impostata nel seguente modo

 
Articoli con prezzo crescente

E il risultato sarà

 
Risultato 

Vedremo più avanti come ricavare la somma dei prezzi in base all'articolo. Per fare questo 
però ci occorrono più tabelle.

 

STRUMENTI

Analisi dei dati nelle tabelle
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La nostra tabella articoli non è efficente. Il nome dell'articolo viene ripetuto più volte con i 
problemi già descritti all'inizio della trattazione. 

●     Se il nome di un articolo dovesse cambiare occorre cercare tutti i record con lo stesso 
nome e sostituirlo

●     Si possono creare errori: Prato, prato, Prati
●     Viene occupato spazio inutilmente.

Lo strumento analisi dei dati consente di creare tabelle secondarie collegate alla prima e di 
generare automaticamente una query per semplificare la selezione dei dati.

1.  Selezionare Strumenti > Analizza > Tabella
2.  Compare la seguente finestra. Fare click su Avanti due volte e scegliere la tabella da 

analizzare.

Analizzatore tabelle

3.  Utilizzare il sistema personalizzato di analisi. Questo consente di controllare meglio 
la generazione delle tabelle.

4.  Trascinare Articolo fuori dalla tabella e chiamare le nuove tabelle rispettivamente 
T_Articoli e T_NomeArticoli facendo doppio click sul nome della tabella. Access 
provvederà a collegare automaticamente le due relazioni cerando i campi adeguati. 
Proseguire con Avanti
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Creazione delle tabelle secondarie

5.  Consentire la creazione della query e proseguire con Avanti.
6.  Togliere la selezione "visualizza la guida sulla funzionalità" e dare Fine.

A questo punto viene visualizzata la query di selezione generata automaticamente per 
collegare le due nuove tabelle.

 
Query di selezione creata automaticamente

Passando in modalità struttura è possibile modificare la query.

http://www.centroreiki.org/abaco/manuali/T_Access.htm (34 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

Visualizzazione delle relazioni

Quando si lavora con un database grande conviene visualizzare tutte le tabelle che lo 
costituiscono e le relazioni che ci sono tra i vari dati. Per attivare la visualizzazione si fa 

click sul bottone relazioni . Il risultato è il seguente:

 
Visualizzazioni delle relazioni

Come si può notare esiste un collegamento tra la tabella T_NomeArticolo e T_Articoli. 
Questo collegamento si chiama relazione. Il simbolo  significa che più record nella 
tabella T_Articoli hanno un unica corrispodenza in un record della tavella 
T_NomeArticolo. La relazione è costruita attraverso il campo T_NomeArticoli_ID e il 
campo IDArticolo. Quesuti campi contengono semplicemente dei numeri e sono stati 
generati automaticamente attraverso lo strumento di analisi delle tabelle.

Vedremo in seguito come creare relazioni tra altre tabelle.

 

Esempi

Somma del prezzi per ogni articolo

Ora che sono state create due tabelle è possibile costruire la query per ricavare la somma 
dei prezzi per ogni articolo.

Si utilizza la creazione guidata della query.

1.  Si utilizza la tabella T_Articoli e si inseriscono i campi T_NomeArticoli_ID, Prezzo e 
si prosegue con Avanti.
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Creazione guidata query

2.  Si sceglie il tipo di query per riepilogo e nelle opzioni si sceglie la somma. Si 
prosegue con Avanti.

3.  Si da il nome Q_SommaArticoli alla query e si da Fine.

Il risultato ottenuto è il seguente:

 
Query somma Articoli

I prezzi in euro non sono soddisfacenti. Occorre modificare la struttura della query.

Selezionando la seconda colonna è possibile modificarne le proprietà in modo da inserire 
due cifre decimali nella visualizzazione della somma. 
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Modifica della struttura della query

Per agire sulle prorietà del campo occorre premere il bottone . E' anche possibile 
cambiare l'etichetta del campo in Totale: Prezzo in modo che nel risultato compaia la 
scritta Totale.

Le query di riepilogo hanno in più la riga Formula. Serve a indicare con raggruppamento 
che non saranno visualizzati tutti i dati ma saranno raggruppati in base allo stesso nome. 
Somma sta a indicare che sul campo prezzo saranno sommati tutti gli importi.

 

Prezzo più alto, più basso per ogni articolo

La stessa query può essere modificata per sapere il prezzo più alto e più basso di ogni 
articolo. Trascinando il campo prezzo dalla tabella sulla griglia della query è possibile 
aggiungere altri due criteri.
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Inserimento di un campo nella query

Si aggiungono i nomi MAX:Prezzo e MIN:prezzo e nei campi formula si inserirsce 
rispettivamente MAX e MIN.

 
Scelta della formula
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Indicare per entrambi i campi come proprietà formato:euro e posizione decimali:2 

Il risultato della query è il seguente:

 
Risultato query

Si potrà a questo punto salvare il risultato finale della query.

  

Query per la Visualizzazione di un solo articolo

Si può costruire una query per la visualizzazione di un solo articolo. In questo caso si può 
procedere con la creazione in visualizzazione struttura.

1.  Selezionare Creare una query in visualizzazione struttura
2.  Scegliere la tabella T_Articoli e T_NomeArticoli e fare click su Aggiungi. Chiudere la 

finestra con Chiudi.

Scelta delle tabella T_Articoli e T_NomeArticoli

3.  Inserire i campi come in figura e aggiungere il criterio "Agrumi" nella prima colonna.
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Impostazione dei campi

4.  Provare la query con il bottone . Il risultato sarà il seguente:

Risultato di tutti gli articoli Agrumi

 

 

UTILITA' QUERY

Utilità per creare, modificare le query

Per inserire un campo nella griglia si può

●     fare doppio click sul campo
●     trascinarlo dalla tabella sulla griglia.
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Per selezionare più campi contigui: si fa click sul primo e con il tasto MAIUSC premuto 
si fa click sull'ultimo.

Per selezionare più campi non contigui: si fa click sul primo e con il tasto CTRL premuto 
si fa click sugli altri campi.

Per portare tutti i campi nella griglia: basta fare doppio click sul nome della tabella. 

Per selezionare campi da una tabella che non è visibile occorre selezionarla. Facendo click 

sul bottone  apparirà la seguente finestra che consente di scelgliere le tabelle da 
aggiungere:

 
Mostra tabella

Applicare i criteri

E' importante sapere che è possibile scrivere indifferentemente "Agrumi", "agrumi", 
"AGRUMI", nel criterio di ricerca. Access non fa differenza tra maiuscole e minuscole.

Per visualizzare articoli con nome "Agrumi" oppure "Prato" basta indicare il criterio "Prato" 
nella riga oppure

http://www.centroreiki.org/abaco/manuali/T_Access.htm (41 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

 
Aggiunta del criterio "Prato"

Il risultato sarà il seguente:

 
Articoli "Agrumi" e "Prato"

Per visualizzare articoli con prezzo maggiore a € 2,50 si aggiungerà il criterio >2,5 nelle 
righe Criteri e Oppure della colonna Prezzo in questo modo:
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Aggiunta del criterio > 2,5

 

Formati

Operatore Significato Esempio

"criterio" si tratta di un testo "Agrumi"

criterio si tratta di un numero 2

#criterio# si tratta di una data #01/01/2002#

 

Operatori

Operatore Significato Esempio

=valore Uguale =2

>valore Maggiore >2

>=valore Maggiore o uguale >=2

<valore Minore <2

<=valore
Minore o uguale

<=2
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<>valore Diverso <>2

condizione1 and condizione2
Entrambe le condizioni
devono essere verificare

>=#01/01/2001# AND
<=#31/12/2001#

condizione1 or condizione2 Almeno una condizione 
devono essere verificata "Agrumi" OR "Prato"

Not condizione La condizione non deve 
essere verificata not "Prato"

Is Null Il campo non contiene valori  

Between valore1 
and valore2

I valori sono compresi tra 
valore1 e valore2

between 2 and 5

Like "L*" I valori iniziano con la lettera L like "a*"

Like "*/mese/*" Tutte le date iniziano nel mese Like "*/03/*"

  

Primi valori

Normalmente la query visualizza tutti i risultati ottenuti. Con la casella di riepilogo primi 
valori è possibile indicare:

●     i primi 5 valori
●     i primi 25 valori
●     i primi 100 valori
●     il 5% dei risultati
●     il 25% dei risultati
●     tutte (valore predefinito)

 

 

Calcoli nelle query

Supponiamo che i prezzi indicati nella tabella T_Articoli siano senza IVA (20%). Potremmo 
inserire una colonna colonna in cui scrivere il prezzo lordo ma questo non è conveniente per 
due ragioni:

1.  Questa colonna occupa spazio
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2.  Il dato può essere calcolato automaticamente evitando errori

Per fare questo ci occorre una query in cui calcolare il prezzo lordo.

Innanzitutto si definisce la query Q_Articoli che contiene codice, articolo, descrizione e 
prezzo:

Creazione query Q_Articoli

Per inserire il prezzo Lordo si può utilizzare il generatore di espressioni attivabile con il 

bottone:  
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Generatore di Espressioni

 

L'espressione da inserire è la seguente:

Lordo: [Prezzo]*1,2 

dove:

Lordo è il nome dell'etichetta del campo

[Prezzo] fa riferimento al campo Prezzo

*1,2 calcola e somma l'IVA del 20%

In questo modo il prezzo lordo verrà calcolato correttamente. Dopo aver impostato il campo 
proprietà in modo da visualizzare il Formato Euro con due cifre decimali 
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Proprietà del campo Lordo

Il risultato della query sarà il seguente:

 
Risultato query con il campo prezzo lordo

 

 

 

I REPORT

Sono lo strumento per creare stampe di qualità. Tramite questo strumento si possono 
stampare elenchi, statistiche, grafici, raggruppare i dati con totali parziali scegliendo stili, 
caratteri, impaginazioni e così via. 

Esistono tre modi per creare i report:
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●     Automatico: crea in modo automatico il report. Il risultato non è mai soddisfacente e 
va ritoccato.

●     Creazione guidata Report: la creazione viene guidata attraverso una serie di 
domande.

●     Visualizzazione struttura: Consente di agire su tutti gli elementi per una creazione 
personalizzata e precisa del report.

 

Creare un report automatico 

1.  Dal menù oggetti si seleziona la tabella.

2.  Con il bottone Nuovo Oggetto  si sceglie Report.

Creazione Report 

3.  Si può scegliere tra report standard a colonne o tabulare.

Scelta del Report Standard
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4.  Il report così ottenuto può essere modificato mediante la visualizzazione struttura.

Risultato del Report a Colonne

 

Creazione del report mediante la creazione guidata

1.  Dal menu Report scegliere Creazione del report mediante la creazione guidata 
2.  Come per le maschere scegliere i campi da visualizzare nel report e andare Avanti.
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Scelta dei campi

3.  Se le tabelle sono collegate è possibile scegliere vari modi per raggruppare i dati. Si 
sceglie il modo e si da Avanti.

Scelta del raggruppamento dei dati

4.  Si sceglie eventualmente il tipo di ordinamento.
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Scelta del tipo di ordinamento 

5.  Si sceglie il tipo di Layot e si prosegue.

Scelta tipo di Layout

6.  Si sceglie il tipo di stile da utilizzare e si prosegue con Avanti.
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Scelta dello stile

7.  Si da il nome al report e si termina con Fine. Per convenzione si può decidere che il 
nome di tutti i report inizi con R_

Il risultato finale è il seguente:
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- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report R-Articoli

Nella visualizzazione del report, prima di essere stampato, sono disponibili i seguenti 
bottoni:

 

Bottone Significato

Passa alla visualizzazione struttura e Anteprima di stampa

Stampa il report

Zoom della pagina

Visualizzazione di una pagina, due pagine, più pagine (4 x 5 Max)

Viausaliizzione al 10%, 25%, 50%, 75%, 100%, 150%, 200% 
o adattata allo schermo (pagina intera)

Chiude la visualizzazione del report

Esporta il report in formato Word o Excel
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Apre la finestra database

Crea un nuovo oggetto database

 

Visualuzzazione Struttura Report

La visualizzazione della struttura consente di modificare il report creato automaticamente. 
Non solo, è anche un buon metodo per imparare a utilizzare questa modalità.

 
Struttura Report R_Articoli

Come si vede sono presenti cinque aree:

●     Intestazione report: Il contenuto viene stampato solo una volta e serve a dare 
informazioni introduttive o il titolo.

●     Intestazione Pagina: Il contenuto viene ripetuto nell'area superiore di ogni pagina. 
Nel report di tipo tabulare può contenere i titoli delle colonne.

●     Intestazione Articolo: Nel caso di report per raggruppamento contiene le 
informazioni relative al raggruppamento dei dati.

●     Corpo: contiene i record da stampare
●     Piè di pagina pagina: Il contenuto viene ripetuto in fondo ad ogni pagina.
●     Piè di pagina report: Il contenuto viene stampato alla fine del report

 

Funzioni particolari
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Come si può notare alla fine della pagina sono presenti delle funzioni particolari. Vediamone 
il significato

Funzione Significato Risultato

=Now() Calcola la data corrente lunedì 13 maggio 2002

="Pagina "&[Page]&" di "&[Pages]
indica il numero della pagina corrente 
[Page] e il numero di pagine totali 
[Pages]

Pagina 1 di 1

 

Creazione del report mediante la visualizzazione struttura

1.  Nella finestra database, selezionare Report e fare click sul bottone Nuovo  
2.  Scelgiere Visualizzazione Struttura e La tabella su cui costruire il report. In questo 

modo sarà semplice inserire i campi relativi alla tabella.

Creazione Nuovo Report

3.  Inserire nell'intestazione pagina titolo utilizzando il bottone Etichetta . In questo 
caso è stato inserito il testo "Articoli", il tipo di carattere è stato impostato Comic 
Sans MS a 24 punti in colore Blu. Per modificare la dimensione della casella di testo si 
usa Formato > Dimensione > Al contenuto.
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Etichetta Articoli

4.  A questo punto si possono inserire i campi usando la finestra Elenco Campi attivabile 
con il bottone . Si selezionano tutti i campi facendo click sul primo e MAIUS + click 
sull'ultimo, e si trascinano nell'area Corpo.

Inserimento campi dalla tabella

5.  Sistemare l'allineamento dei vari campi.

Allineamento dei campi

http://www.centroreiki.org/abaco/manuali/T_Access.htm (56 of 100) [11/11/2002 14.52.59]



Corsi di Informatica - Manuale Corso

Se si prova il report con l'anteprima di stampa  si ottiene il seguente risultato:

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Anteprima di stampa

 

Creare il report in forma di tabella

Per spostare le etichette nella parte di Intestazione pagina utilizzare il seguente metodo

1.  Selezionare le etichette a sinistra.
2.  Tagliarle con Modifica > Taglia o CTRL + X
3.  Allargare l'area intestazione trascinando in giù il cursore  posizionato sopra l'area 

corpo fino a 5,5 cm indicati sul righello di sinistra

4.  Incollare le etichette con Modifica > Incolla o CTRL + V e posizionarle
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Incolla le etichette

5.  Spostando le etichette si può arrivare al segunete formato del report:

Impostazione del report a colonne

6.  Inserire la data utilizzando Inserisci > Data e ora
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Inserire la data e l'ora

7.  Inserire i numeri di pagina utilizzando Inserisci > Numeri di pagina, specificando il 
formato e la posizione.

Inserire i numeri di pagina

Il risultato finale della struttura del report sarà la seguente:
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Struttura finale del report

E l'anteprima di stampa sarà

 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

Report Finale

 

Funzioni particolari

Per la data e l'ora sono state inserite automaticamente la funzioni

Funzione Significato Risultato

Format(Date();"Data breve") Calcola la data corrente nel formato "Data Breve" 13-mag-02

Format(Time();"Ora breve 12h" Calcola l'ora nel formato "Ora breve 12h" 8:30
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Utilità per il posizionamento dei campi

●     Per selezionare oggetti sulla stessa riga utilizzare la freccia nera sul righello di sinistra

Selezione di una riga

●     Per selezionare oggetti sulla stessa colonna utilizzare la freccia nera sul righello in alto

Selezione di una colonna

●     Per selezionare oggetti nella stessa area tracciare un rettangolo. E' sufficiente che 
l'oggetto venga toccato dal rettangolo per essere selezionato

 
Selezione di un'area

LE RELAZIONI

Vediamo come creare le relazioni fra tabelle. Per fare questo ci occorre definire una tabella 
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T_Acquisti in cui inseriremo la data di acquisto e la quantità per ogni articolo. Per fare 
questo ci occorre modificare la tabella T_Articoli e creare un nuovo campo chiave 
IDCodice. Questo perchè se nella tabella T_Acquisti volessimo fare riferimento al codice 
dovremmo definire un campo di tipo testo come per T_Articoli con le conseguenze:

●     occupazione di spazio inutile
●     problemi nella modifica del codice articolo.

La tabella T_Articoli diventa

La nuova tabella T_Articoli

 

La nuova tabella T_Acquisti sarà invece:
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Tabella T_Acquisti

 

Vediamo ora come creare il collegamento tra le due tabelle definendo la relazione.

 NOTA: Una relazione può essere creata solo fra due campi di identici tipi e dimensioni.

 

Definizione delle relazioni

Per definire le relazioni occorre utilizzare il bottone . Apparirà la seguente schermata:
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La finestra delle Relazioni

1.  Per aggiungere la relazione T_Acquisti occorre premere il bottone . A questo 
punto compare la finestra Mostra tabella 

Finestra Mostra tabella

2.  Selezionare la tabella T_Acquisti e fare click su Aggiungi. Chiudere la finestra. Ora la 
nuova relazione appare inseme alle altre.
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Tabella T_Acquisti inserita

3.  Ora vogliamo creare una relazione tra e IDCodice in T_Articoli e IDCodice in 
T_Acquisti. Per fare questo semplicemente facciamo click su IDCodice in T_Articoli 
e trasciniamo il puntatore sulla tabella T_Acquisti. 

Creazione della relazione

4.  A questo punto bisogna dare una serie di indicazioni nella finestra Modifica relazioni. 
❍     Applica integrità referenziale 
❍     Aggiorna campi correlati a catena
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Finestra Modifica relazioni

5.  Terminare facendo click su Crea. La relazione è stata creata.
6.  Salvare il layout delle relazioni Attraverso File > Salva.

 
Relazione tra T_Articoli e T_Acquisti

 

 

Relazione 1 a N

Significa che un record in una tabella ha più corrispondenze in un'altra tabella. Infatti 
possono essere fatti più acquisti con lo stesso codice articolo. Per definizione la tabella 
T_Articoli si definisce principale , mentre la tabella T_Acquisti viene definita correlata. Il 
fatto che la relazione sia 1 a molti è dovuto anche dal fatto che IDCodice è un campo 
chiave nella relazione T_Articoli.
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Integrità refernziale

Significa che nel database non potranno esistere record orfani. In pratica Access fa in modo 
che nella tabella correlata non si creino record che non hanno corrispondenze con un record 
nella tabella principale. Non potrà esistere un acquisto che fa riferimento a un codice 
inesistente.

 

Aggiorna i campi correlati a catena

Se attivo significa che se si modifica il campo chiave nella tabella principale, i record 
associati nella tabella correlata verranno automaticamente modificati.

Se non è attivo impedisce l'operazione di modifica.

 

Elimina i campi correlati a catena (da usare con molta cautela)

Se attivo significa che se si elimina il campo chiave nella tabella principale, i record 
associati nella tabella correlata verranno automaticamente eliminati.

Se non è attivo impedisce l'operazione di cancellazione.

 

Nell'esempio si è scelto di non eliminare gli articoli. 

 

Ricerca 

Quando si lavora con i campi chiave numerici diventa scomodo aprire una tabella, per 
esempio T_Articoli per sapere qual'e in numero IDCodice corrispondente per poi inserirlo 

nella tabella T_Acquisti. Per lavorare unicamente con i codici degli articoli bisogna 
utilizzare le ricerche che vengono definite nella struttura della tabella. 

1.  Si seleziona in questo caso la tabella T_Acquisti e la si apre in modalità struttura con 

2.  Selezionare il campo IDCodice 
3.  Si utilizza la scheda Ricerca e si imposta la Casella combinata 
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Scelta della casella combinata per la ricerca

4.  In Origine riga si fa click sul bottone  per creare la query di ricerca. 

Bottone per la definizione della ricerca dei dati

5.  Attraverso la finestra Mostra tabella si inserisce la tabella T_Articoli 
6.  Vengono inseriti i campi Codice e IDCodice. In questo modo verranno visualizzati i 
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codici in chiaro e il risultato della selezione sarà il valore del campo chiave IDcodice

 
Creazione della query di ricerca

7.  Si può salvare la query con il nome Q_CodiceArticolo

Risultato di Q_CodiceArticolo

8.  Chiudere il generatore di query con la X e dire di si per salvare le modifiche. La Query 
creata ora si trova come Origine riga.
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Q_CodiceArticolo in Origine riga

9.  A questo punto bisogna indicare che il risultato della ricerca va preso dalla seconda 
colonna della query (IDCodice)indicando come colonna associata 2 

Impostazione finale della ricerca

10.  Una volta salvata la tabella si può passare alla visualizzazione del foglio dati con . 
Come si noterà è semplice la scelta del codice articolo.
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Immissione dei dati in T_Acquisti facilitata

Se si volesse vedere anche IDCodice occorrerebbe cambiare il numero di colonne e 
portarlo a 2

Altre utili opzioni

●     Righe in elenco 
Indica quante righe possono essere visualizzate nel menù a discesa

●     Solo in elenco
Impostato a Sì significa che non è possibile scrivere direttamente un valore nel 
campo, ma va scelto tra quelli in elenco.

 

ESEMPI DI QUERY

Query per la tabella T_Aquisti

Questa tabella ha anche un campo data. Per questo è possibile impostare una query di 
riepilogo sulle date.

1.  Creare una query mediante una creazione guidata
2.  Sceglie re Riepilogo e nelle Opzioni di riepilogo impostare Somma
3.  Scegliere di raggruppare le date per mese 
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Scelta dell'ordine per le date

4.  Salvare la Query con il nome Q_Acquisti

Il risultato della query è il seguente

 
Query di riepilogo sulle date

Come si può notare c'è un raggruppamento per mesi ma questi ultimi non sono in ordine 
cronologico. Per creare un ordine occorre inserire nella query anche il campo data con 
criterio crescente e con Mostra disattivato.
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Aggiunta del campo Data

Per le Note il sistema ha scelto di visualizzare la prima delle note con Primo. 

Per il raggruppamento delle date è stata inserita la formula 

Data per mese: Format$([T_Acquisti].[Data];'mmmm aaaa') 

Dal campo Data della tabella T_Acquisti la data viene rappresentata con anno e mese. 
Con questo valore viene costruito il raggruppamento

Per in campo anno la data viene trasformata in un numero: l'anno viene moltiplicato per 12 
e a questo numero viene sommato il mese-1:

Year([T_Acquisti].[Data])*12+DatePart('m';[T_Acquisti].[Data])-1) 

Per visualizzare la situazione per ese può essere opportuno visualizzare solo i dati seguenti:
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Impostazione finale della query

Il risutato è il seguente

Risultato 

Perchè tutto questo funzioni correttamente il campo Data nella tabella T_Acquisti deve 
essere indicizzato
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Campo Data indicizato

 

GLI INDICI

Servono a tenere la tabella ordinata. Un indice è una piccola tabella sempre ordinata 
costituita da riferimenti ai record della tabella principale. Questa tecnica permette di poter 
ordinare la tabella secondo vari criteri. Nel caso della tabella T_Acquisti le ricerce possono 
essere fatte per data o per Articolo. Costruire un indice su questi campi semplifica la ricerca 
dei record. 

Per creare un indice si lavora in modalità struttura con la tabella 

1.  Si seleziona il campo, nell'esempio è stato scelto data
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Creazione di un indice

2.  Si imposta in campo indicizzato a 
❍     Sì (Duplicati ammessi)
❍     Sì (duplicati non ammessi)

Nel caso della data i duplicati sono ammessi: più acquisti possono essere fatti nella stessa 
data.

Se un indice non ammette duplicati, per esempio il codice articolo, il sistema garantisce che 
non possano esserci due valori uguali.

 NOTA: Per ogni record inserito, modificato, cancellato, gli indici devono essere aggiornati. 
E per questo che per evitare rallentamenti nell'utilizzo del database l'uso degli indici deve 
essere fatto con cura.

 

UTILITA'

Operazioni nei report e nelle sottomaschere 

Si costruisce la query Q_TotaleAcquisti definita come segue:
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Query Q_TotaleAcquisti

Il risultato della query è il seguente:

 
Risultato 

Vogliamo costruire ora una maschera M_TotaleAcquisti per visualizzare il risultato della 
query e fare una somma di tutto quello che è stato acquistato.

1.  Mediante la creazione guidata si costruisce la maschrea sulla query Q_TotaleAcquisti 
inserendo tutti i campi. 
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Cosrtuzione della maschera M_TotaleAcquisti

2.  Si sceglie il formato Tabulare, lo stile e si slava con il nome M_TotaleAcquisti. Il 
risultato è il seguente:

Maschera M_TotaleAcquisti

3.  Lavorando nella modalità Struttura apportiamo le seguenti modifiche: L'etichetta 
SommadiQuantità viene modificata in Totale

4.  Si allarga lo spazio del Piè di pagina e attraverso la casella degli strumenti attivabile 

con  si crea una casella di testo con il bottone . 
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Creazione della casella di testo

5.  Facendo clic sulla parte di testo si cancella l'eticetta con CANC

6.  Utilizzando la finestra proprieta per la casella di testo attivabile con  si imposta 
l'origine del controllo al valore

=Somma([SommaDiQuantità]) 

Origine del controllo per la casella di testo

Per facilitare l'immissone dei dati si può utilizzare anche la maschera di zoom 
attivabile con MAIUSC + F2

7.  Si può aggiundere un'intestazione e il risultato è il seguente.
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Inserimento del titolo

La maschera visualizzata è :

Risultato 

 

I Folgi secondari 

Quando due o più tabelle sono collegate tramite una relazione si possono utilizzare i folgi 
secondari. Avendo colledato la tabella degli acquisti agli articoli, ogni volta che si apre la 
T_Articoli appare la seguente schermata:
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Tabella T_Articoli

Il segno  che compare a sinistra significa che facendovi è possibile espandere il foglio 
associato:

 
Foglio associato a T_Articoli

Facendo click sul segno meno il foglio associato verrà chiuso.

 

Creazione della maschera con sottomeschere

Utilizzando una maschera è possibile rappresentare questi dati un un formato più semplice: 
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per ogni articolo si avrà il dettaglio degli acquisti.

1.  In Maschere utilizzare Crea una maschera mediante una creazione guidata.
2.  Dalla tabella T_Articoli inserire: Codice, Descrizione, Prezzo

Dalla tabella T_NomeArticoli inserire: Articolo
Dalla tabella T_Acquisti inserire: Data, Quantità, Note

Inserimento dei campi

3.  Scegliere di visualizzare i dati in base a T_Articoli in modo da avere la mashera con 
sottomaschere
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Visualizzazione in base a T_Articoli

4.  Scegliere il layout tabulare e proseguire
5.  Scelgiere lo stile e proseguire
6.  Dare i nomi M_Articoli e SM_Acquisti ripsettivamente alla maschera e alla 

sottomaschera
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Scelta dei titoli delle maschere

7.  Terminare con Fine

Il risultato, è come sempre, da sistemare in modalità struttura

Maschera M_Articoli

 

1.  L'etichetta SM_Acquisti può essere cancellata
2.  La sottomaschera si può spostare a sinistra
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Agendo opportunamente sui vari campi la maschera può diventare:

Nuovo formato della maschera M_Articoli
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E verrà visualizzata come

 
Risultato finale

Inserimento della somma delle quantità acquistate

E' possibile aggiungere la somma delle quantità acquistate inserendo un totale nella 
sottomaschera. per fare questo occorre

1.  Chiudere tutte le maschrere e aprire la sottomaschera SM_Acquisti
2.  Allargare lo spazio del piè di pagina
3.  Inserire una casella di testo e mettere come etichetta Totale:
4.  Nella casella di testo inserire come origine controllo

=Somma([Quantità])

Aggiunta del Totale
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5.  Salvare la sottomaschera. il risultato sarà

 
Nuova maschera M_Articoli

 

Inserire il totale acquistato

Volgiamo ilserire il totale acquistato dato dal totale moltiplicato per il prezzo.

1.  Lavorando con la sottomaschera SM_Acquisti occorre dare un'etichetta al totale. 
Attraverso la finestra proprietà viene inserita l'etichetta TotaleArticoli. 

 
Aggiunta dell'etichetta TotaleArticoli
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2.  Aggiungi una casella di testo e nell'etichetta si inserisce Totale Acquistato

Aggiunta della casella di testo 

3.  Utilizzando la finestra proprietà si inserisce la formula 

=[Prezzo]*[SM_Acquisti]!TotaleArticoli

Per il Formato si utilizza Euro con due cifre decimali
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Proprietà della casella di testo

4.  Il risultato è il seguente:

Risultato finale con il Totale Acquistato 

 

Migliorie grafiche

Si può eliminare la barra di scorrimento orizzontale della sottomaschera. Per fare questo 
occorre lavorare con la sottomaschera visualizzata dalla maschera M_Articoli. 

1.  Fare click sul quadratino nero della sottomaschera SM_Acquisti
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Selezione della sottomaschera SM_Acquisti

2.  In barre di scorrimento selezionare Verticale

Eliminazione delle barre di scorrimento

3.  Per eliminare i pulsanti che consentono la selezione dei record si seleziona No per i 
Pulsanti spostamento.

4.  Si imposta a No anche Linee di divisione e Selettori record.
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5.  Il risultato è il seguente:

Maschera migliorata 

La barra verticale consente di scorrere l'elenco di più acquisti.

 

Utilizzo della maschera solo per l'introduzione degli acquisti.
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Se la maschera M_Articoli deve essere utilizzata solo per inserire gli acquisti, bisogna 
evitare che l'utente possa modificare il codice, la descrizione, l'Articolo, il Prezzo e il 
Totale Acquistato. In questo caso bisogna impostare nella finestra proprietà, scheda Dati:

●     Bloccato Sì
●     Abilitato No

E' importante l'ordine in cui dare queste due impostazioni.

Blocco dei campi 

 

In questo modo non è possibile modificare questi campi utilizzando la maschera 
M_Articoli. Può per questo scopo essere creata un'altra maschera per modificare tutti i 
dati relativi ai singoli articoli.

 

Creazione di un report con i sottoreport

Vogliamo inserire le stesse informazioni della maschera M_Articoli in un report. In questo 
modo verrà visualizzato il dettaglio di tutto ciò che è stato acquistato. 

1.  Si attiva la Creazione guidata dei Report
2.  Si inseriscono i seguenti campi: 

❍     Codice dalla tabella T_Articoli
❍     Articolo dalla tabella T_NomeArticoli
❍     Descrizione dalla tabella T_Articoli
❍     Prezzo dalla tabella T_Articoli
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❍     Data dalla tabella T_Acquisti
❍     Quantità dalla tabella T_Acquisti
❍     Note dalla tabella T_Acquisti

3.  Si sceglie la visualizzazione in base a T_Articoli

Visualizzazione dei dati in base a T_Articoli

4.  Non si aggiungono livelli di gruppo e si prosegue
5.  Per quanto riguarda il report di dettaglio si ordinano gli acquisti in base alla Data
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Ordinamento in base alla data del report di dettaglio

6.  Si sceglie il layout Allineato a sinistra 2 e il foglio orientato verticalmente.

Scelta del layout

7.  Si sceglie lo stile da utilizzare (Es Società) 
8.  Si attrubuisce il nome al report R_Articoli.
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9.  Si temina con Fine. Il risultato è il seguente:

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report R_Articoli

Per ogni articolo compare il dettaglio di ciò che è stato acquistato. Utilizzando la modalità 
struttura è possibile migliorare il report.

 

Inserire il totale acquistato per ogni articolo

Come per la maschera si vuole inserire il tiotale acquistato. 

1.  Si attiva la modalità struttura.
2.  Attraverso Visualizza > Ordinamento e raggruppamento, si attiva il Piè di pagina 

pe IDCodice 
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Attivazione piè di pagina

3.  Si disegna con il bottone  una casella di testo. Si inserisce l'etichetta Totale

Nuova casella di testo Totale

4.  Attraverso la maschera proprietà si imposta l'origine del controllo a 

=Somma([Quantità])
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Casella di testo TotaleArticoli

5.  Il risultato con opportune modifiche per la disposizione dei campi è il seguente: 

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
Stampa dei totali 
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Inserire il Totale Acquistato

Per inserire il totale acquistato occorre anche qui inserire una nuova casella di testo

1.  Inserire una casella di testo e nel campo etichetta scrivere Totale Acquistato

Nuova casella di testo

2.  Attraverso la finestra proprietà si inserisce come origine dei dati

=[Prezzo]*[TotaleArticoli]

si imposta il formato Euro con due cifre decimali
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Proprietà per la casella di testo TotaleAcquistato

3.  Il report diventa

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Report con il totale acquistato
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Appendice

 

Tasto Significato

MAIUSC + F2 finestra di zoom
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I MANUALI 

CORSO FLASH

PROGETTO 1

Creazione di un 
progetto molto 
semplice: una 
stella che ruota

I PANNELLI
Pannello Info
Pannello 
Trasformazione
Pannello Stroke
Pannello Fill
Pannello Istanza
Pannello Effect
Pannello Frame
Pannello Sound
Pannello Mixer
Pannello 
Swatches
Pannello Libreria

I TESTI
Testo Mobile
Testo Statico
Testo Dinamico

LE MASCHERE
Creazione delle 
maschere
Come fare 
apparire una 
scritta
Fare scorrere il 
testo all'interno 
di un rettangolo
Fare apparire 
una luce dietro 
al testo

FLASH 5

PROGETTO 1

Creazione di un progetto molto semplice: una stella che 
ruota

Come progetto si crea una stella che ruota controllata da un pulsante. Con 
questo esempio si analizzeranno le caratteristiche principali di FLASH.

 

Impostare le proprietà del filmato

1) Aprire FLASH 

2) Controllare le proprietà del filmato con Modify > Movie (CTRL + M)

 
Proprietà di un filmato

●     Frame Rate - Frequenza fotogrammi. L'impostazione a 12 è ottimale 
per rendere il filmato veloce e snello

●     Dimension - Dimensioni. Per uno schermo 800 x 600 le dimensioni 
ottimali sono 670 x 490. E' possibile impostare le dimensioni in modo da 
adattarsi alla risoluzione usata dall'utente. Inoltre con Dreamweaver è 

http://www.centroreiki.org/abaco/manuali/F_Flash.htm (1 of 29) [11/11/2002 14.54.26]



Corsi di Informatica - Manuale Corso Base

Fare illuminare 
con una luce il 
testo

L'OGGETTO 
MOUSE
Creazione di 
oggetti che si 
spostano con il 
mouse

UTILITA'
Creazione di un 
preloader

SI PUBBLICA!
Pubblicazione dei 
filmati su 
internet

 

SCRIVICI

 

possibile modificare le dimensioni quando si inserisce un filmato in una 
pagina WEB

●     Backgroud Color - Colore di sfondo del filmato. (Non è possibile 
impostare la trasparenza)

Salvare con OK

 

Lavorare con lo stage

Quello che ora appare e lo stage vuoto dove compariranno i vari "attori" 
(disegni, bottoni, immagini, ...) che si muoveranno o meno in base a un 
copione descritto dalla linea temporale.

 
Gli elementi di Flash

Ogni rettangolo sulla linea temporale rappresenta un fotogramma (frame). 
Con l'impostazione che è stata data precedentemente il fotogramma 12 
apparirà dopo 1 secondo dall'inizio del filmato.

 

FLASH permette di lavorare su più livelli (layers) sui quali è possibile 
posizionare i vari oggetti che compongono il filmato. E' possibile anche 
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inserire commenti, etichette, suoni ed azioni per spostarsi lungo la linea 
temporale. Gli elementi posizionati sui livelli superiori (in alto) coprono quelli 
sottostanti.

 

 
L'uso dei livelli

 

Il rettangolo rosso associato a una linea indica qual è il fotogramma 
attualmente visualizzato ed è l'indicatore di riproduzione. Questo indicatore 
può essere spostato trascinandolo o attraverso la tastiera:

Tasto Significato

, (virgola) indietro

. (punto) avanti

Consigli per la progettazione di un filmato

●     Assegnare sempre un nome significativo ai livelli 
●     Utilizzare un livello per ogni elemento del filmato 
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I Livelli (layers)

I livelli sempre presenti nella progettazione di un filmato sono:

●     Etichette: livello che contiene le etichette dei fotogrammi utili 
soprattutto per eseguire azioni

●     Commenti: osservazioni per rendere più leggibile il filmato ma ignorati 
da FLASH

●     Azioni: tutte le azioni è meglio concentrarle su un unico livello
●     Contenuto: uno o più livelli che si trovano sotto quelli descritti sopra 

con il contenuto del filmato

 
Impostazione ideale dei livelli

 

Come creare un livello 

1.  Fare click sul livello che dovrà risultare sotto a quello nuovo.
2.  Fare click sul bottone inserisci livello 

Come assegnare un nome a un livello

1.  Fare doppio click sul livello che si vuole rinominare
2.  Scrivere il nome del livello

http://www.centroreiki.org/abaco/manuali/F_Flash.htm (4 of 29) [11/11/2002 14.54.26]



Corsi di Informatica - Manuale Corso Base

3.  Confermare con un click in un altro punto

Come cancellare un livello

1.  Fare click sul livello che si vuole cancellare.
2.  Fare click sul bottone elimina livello 

Come spostare un livello

1.  Fare click sul livello che si vuole spostare.
2.  Facendo click e tenendo premuto trascinare il livello sopra o sotto 

Creare quindi i vari livelli in modo da avere la situazione in figura:

 
I livelli del filmato Stella

Salvare il filmato con il nome stella.

Durante la progettazione del filmato i livelli possono essere:

●     nascosti: nel livello fare click su  in corrispondenza di . Il livello non 
sarà visibile 

●     bloccati: nel livello fare click su  in corrispondenza di . Il livello non 
sarà bloccato e non sarà possibile modificarne il contenuto
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Nella figura precedente il livello etichette è bloccato, il livello commenti è 
nascosto, e il livello azioni è bloccato e nascosto.

Disegnare la stella

Disegneremo ora una stella a otto punte

1.  Fare click sul primo fotogramma del livello stella

2.  Fare click su quadrato dello strumento di riempimento  e 
selezionare il colore giallo

3.  Fate click su quadrato dello strumento di contorno  e selezionare 
il colore nero

4.  Con lo strumento rettangolo  disegnare un quadrato tenendo 
premuto il tasto di MAIUSC. Il quadrato ottenuto sarà composto da due 
parti: il riempimento giallo e il contorno

5.  Con lo strumento selezione  tracciare un rettangolo all'esterno del 
quadrato in modo da selezionare il bordo e il riempimento del quadrato.

Selezione di più oggetti

6.  Copiare il quadrato con Edit > Copy (CTRL + C)
7.  Incollare il quadrato sul posto con Edit > Paste in place (CTRL + 

MAIUSC + V)
8.  Ruotare il quadrato di 45° attraverso la finestra di trasformazione

9.  Eliminare i pezzi che non servono facendovi click sopra e CANC.

Dopo aver eliminato i quattro pezzi la stella 
risulta così
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10.  Fare click sull'immagine e trasformarla in un simbolo attraverso Insert 
> Convert to Symbol. Creare un simbolo Grafico con il nome Stella.

Finestra dei simboli

11.  Centrare il simbolo in mezzo allo stage attraverso il pannello di 
allineamento che può essere aperto attraverso Windows > Panels > 
Align (CTRL + K). Attivare l'allineamento rispetto allo Stage (To 
Stage) e fare click sull'allineamento centrale orizzontale e verticale.

Pannello Allineamento

12.  Partire dal livello più basso (Pulsante) e selezionare tutti i fotogramma 
20 fino al livello etichette e premere F5 per inserire fotogrammi.

Inserimento di fotogrammi

13.  Fare click sul livello stella e dare Insert > Create Motion Tween.
14.  Fare click sul fotogramma 20 del livello stella e inserire un fotogramma 

chiave con Insert > Keyframe (F6).
15.  Facendo click sul fotogramma 1 del livello stella con il pannello Frame 

attivabile attraverso Windows > Panels o (CTRL + F) inserire una 
rotazione in senso orario (Clock Wise)
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Pannello Frame

16.  Sul fotogramma 1 del livello azioni Aprire la finestra delle azioni con 
Windows > Actions (CTRL + ALT + A) e con le Basic Action aperte 
fare doppio click sull'azione di Stop. Chiudere la finestra Frame Action.

Pannello delle Azioni

17.  Aprire la libreria comune dei bottoni con Windows > Common Library 
> Button. Fare doppio click sul pulsante  per aprire (oval) Button 
Set. 
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Pannello Libreria

18.  Fare click sul fotogramma 1 del livello pulsante e trascinare sullo stage 
il bottone Oval-play. Centrarlo nello stage orizzontalmente. 

19.  Con il bottone selezionato Aprire la finestra delle Azioni (Windows > 
Actions oppure CTRL + ALT + A) e fare doppio click sull'azione di Play. 
Le istruzioni che verranno inserite saranno quelle appropriate. Quando 
verrà fatto click sul bottone che abbiamo inserito partirà il filmato e la 
stella ruoterà.

Azione Play su rilascio del pulsante mouse

20.  Fare click sul fotogramma 1 del livello testo e con lo strumento testo 

 inserire la scritta "Start filmato" vicino al bottone che è stato 
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inserito. Portare a 40 la dimensione del carattere con il pannello 
attivabile da Windows > Character (CTRL + T). 

Pannello testo

21.  Fare click sul fotogramma 1 del livello commenti e con il pannello 
Frame attivabile da Windows > Frane (CTRL + F) inserire il 
commento //filmato di prova.

Inserimento di un commento

Le doppie barrette "//" definiscono appunto i commenti.

22.  Fare click sul fotogramma 1 del livello etichette e con il pannello 
Frame attivabile da Windows > Frane (CTRL + F) inserire l'etichetta 
start. Il nostro filmato si presenta così:
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Filmato finale Stella

23.  Provare il filmato attraverso Windows > Testo Movie e chiudere con 
la X. Per vedere il risultato su una pagina WEB premere invece il tasto 
F12.

I PANNELLI

Servono a mostrare i dettagli degli oggetti su cui si sta lavorando. 

I pannelli si possono attivare con Windows > Panels. 

 NOTA: In ogni istante è possibile nascondere o fare riapparire i pannelli 
attraverso il tasto TAB.

Flash consente anche riposizionare i pannelli nella posizione predefinita 
attraverso Windows > Panel Sets > Default Layout.

Pannello Info
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Pannello Info

 

Questo pannello fornisce informazioni sulle dimensioni e sulla posizione 
dell'oggetto selezionato. E' anche possibile modificare la posizione e/o la 
dimensione digitando direttamente il valore.

Pannello Trasformazione

 
Pannello Trasformazione 

Questo pannello consente di ridimensionare l'elemento selezionato, di 
ruotarlo per gradi, di inclinarlo.

 

Pannello Stroke

 
Pannello Stroke 

Questo pannello consente di modificare lo spessore, il colore e lo stile del 
tratto (linea o bordo).
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Pannello Fill

Pannello Fill 

Il Pannello riempomento consente di difinire vari tipi di riempimento per un 
oggetto: 

●     None: nessun riempomento
●     Solid: un unico colore
●     Linear Gradient: sfunatura lineare attraverso più colori 
●     Radial Gradient: sfunatura radiale attraverso più colori 
●     Bitmap: utilizza un immagine.

 

Pannello Istanza

Pannello Istanza 

Questo pannello indica se l'elemnto selezionato è un pulsante, un clip filmato 
o un elemento grafico. Ognuno di questi elementi avra un nome che viene 
visualizzato. 

Pannello Effect (Effetti)

http://www.centroreiki.org/abaco/manuali/F_Flash.htm (13 of 29) [11/11/2002 14.54.26]



Corsi di Informatica - Manuale Corso Base

Pannello Effetti 

Questo pannello consente di modificare le prorpietà dell'istanza di un 
oggetto. 

●     Brightness: modifica la luminosità e il contrasto.
●     Tint: modifica il colore.
●     Alpha: modofica la trasparenza dell'oggetto
●     Advanced: permette di lavorare sui colori e sulla trasparenza

 

Pannello Frame (Fotogramma)

Pannello Frame 

Questo pannello consente di assegnare un nome al fotogramma in qualsiasi 
livello.

 NOTA: Conviene, per evitare confusione, dedicare un livello apposta in cui 
assegnare le etichette ai vari fotogrammi.

 

Pannello Sound
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Pannello Sound 

Questo pannello consente di definire tutti i parametri per l'impostazione dei 
suoni.

 

Pannello Mixer

Pannello Mixer 

Questo pannello consente di impostare i colori per il riempimento e per il 
tratto. 

 NOTA: Facendo click sul quadratino colorato compare una pipetta che 
consente di "campionare" il colore facendo click in qualunque punto dello 
schermo.

 

Pannello Swatches (Tavolozza)

Pannello Swatches (Tavolozza) 
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Normalmente Contiene la tavolozza dei colori WEB Safe e cioè quei colori che 
sicuramente sono visibili su tutti i computer.

 

Pannello Libreria

Pannello Libreria 

Mostra l'elenco di tutti i diversi tipi di elementi disponibili per la creazione del 
filmato. In libreria vengono portati tutti gli elementi che possono essere 
riutilizzati. Qualsiasi simbolo infatti può essere riutilizzato in più posizioni del 
filmato creando quella che viene chiamata istanza. La cosa importante che gli 
oggetti che si presentano nel filmato sottoforma di istanze possono avere 
caratteristiche diverse impostabili attraverso i pannelli Trasformazione, e 
Effetti 

 NOTA: Solo gli elementi della libreria che appaiono sullo stage verranno 
inclusi nel file finale. Per indicare a Flash di includere un elemento della 
libreria, anche se non sembra necessario occorre utilizzare le proprietà di 
collegamento. Facendo click sul bottone Opzion si seleziona Likage ed 
Export this symbol.

Proprietà di esportazione dei simboli 
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I TESTI

Per scrivere del basta seplicemente utilizzare lo strumento . Bisogna peò 
considerare che esistono tre tipi di testo:

●     testo mobile
●     testo statico
●     testo dinamico
●     testo di input

Testo Mobile

 

 

Una volta selezionato lo strumento di testo si fa click in un punto dello 
schermo e si comincia a scrivere. Il blocco che contiene il testo si allunga 
mentre si scrive. Questo testo è caratterizzato da avere un pallino rotondo in 
cima a destra.

Testo Statico

 

Una volta selezionato lo strumento di testo si traccia un rettangolo. Il testo 
andrà automaticamente a capo se non può essere contenuto all'interno dei 
margini definiti dal rettangolo. Questo testo è caratterizzato da avere un 
quadratino in cima a destra.

Testo Dinamico
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LE MASCHERE

Creazione delle maschere

Con Flash è possibile creare varie maschere. Per capire l'utilità delle 
maschere vediamo degli esempi.

Come fare apparire una scritta

Vediamo come realizzare la seguente sequenza

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

1.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5)

2.  Creare un secondo livello e rinominarlo con il nome maschera. 
Disegnare un rettagolo che copra il testo e che abbia lo stesso colore 
dello sfondo (nero).

3.  Applicare il riempimento lineare al rettangolo utilizzando due cursori e 
dando il colore di sfondo (Nero). Modificare la trasparenza (alfa) del 
cursore di sinistra portandola a 0%.
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Pannelli riempimento e Mixer colori

4.  Trasformare il rettangolo in un simbolo grafico (F8) e nominarlo con 
nome maschera

5.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra in modo da fare apparire la scritta.

Flimato Maschera1

6.  Provare il filmato con F12

 

Fare scorrere il testo all'interno di un rettangolo

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

2.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5). 
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3.  Creare un secondo livello e rinominarlo con il nome Maschera. Facendo 
clik con il tasto destro sul livello trasformarlo in maschera (mask)

4.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra in modo da fare apparire la scritta.

Filmato mashera2

5.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra dello stage

6.  Fare click con il destro sul livello Maschera e trasformarlo il maschera 
(Mask).

Filmato finale mashera2

7.  Provare il filmato con F12
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Fare apparire una luce dietro al testo

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

2.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5). 

3.  Creare un livello con il nome Luce e trasportarlo sotto al livello testo.
4.  Disegnare un cerchio 50x50. Eliminare il contorno del cerchio e 

posizionarlo in alto a sinistra.
5.  Dare un colore di riempimento radiale partendo dal giallo e sfumando 

fino a un giallo con alfa 0%

 
Pannello riempimento con Riempimento Radiale

6.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto luce tutta a destra dello stage. (Usale La finestra di Align)

7.  Fare click con il destro sul livello Maschera e trasformarlo il maschera 
(Mask).
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Filmato finale mashera3

8.  Provare il filmato con F12

 

Fare illuminare con una luce il testo

 

Utilizzare il filmato creato precedentemente.

1.  Ridimensionare la luce facendo click con il tasto destro e scegliendo 
Edit. Ridurre il simbolo del 50% attraverso la finestra Transform 
(attivare per comodità Constrain). 

Pannello Trasformazione

2.  Ritornare al filmato e allineare a sinistra e a destra le istanze del 
simbolo nel fotogramma 1 e 36.

3.  Inserire sopra il livello maschera un nuovo livello. Trasportarlo sotto il 
livello testo e rinominarlo con il nome Testochiaro.

4.  Copiare il frame del livello testo (CTRL + ALT + c) e incollarlo sul livello 
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Testochiaro (CTRL + ALT + v) e dare al testo il colore bianco.

Filmato maschera4 

5.  Provare il filmato con F12

 

L'Oggetto Mouse

Creazione di oggetti che si spostano con il mouse

Per creare un oggetto che si sposta con il mouse occorre: 

1.  Creare un clip filmato che contiene l'oggetto oppure l'animazione da 
spostare con il mouse.

2.  Inserire l'oggetto sullo stage.
3.  Associare al clip filmato le seguenti istruzioni in Action Script.

onClipEvent (enterFrame){
this._x = _root._xmouse;
this._y = _root._ymouse;
}

 

INTERPOLAZIONE (Motion Tween)

L'interpolazione consente di creare animazioni in modo rapido ed efficace. 
Tutto sta a disegnare il primo e l'ultimo fotogramma dell'azione e lasciare a 
Flash il compito di creare i fotogrammi intermedi. In questo modo le 
dimensioni dei file vengono ridotte al minimo.

Sono possibili due interpolazioni: 
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●     Interpolazione Forma 
●     Interpolazione Movimento

Interpolazione Forma

Consiste nel trasformare un'oggetto in un altro (morphing). Questo tipo di 
interpolazione può essere effettuato solo tra forme e non tra gruppi, simboli 
o testi dinamici. E' possibile eseguire l'interpolazione anche di colore. Per 
utilizzare al meglio questa caratteristica è meglio posizionare ogni forma da 
interpolare su un proprio livello. 

Morphing tra un quadrato e una lettera

 

1.  Disegnare un quadrato sul livello 1. Selezionare il bordo ed eliminarlo. 
Centrare l'oggetto nello stage

Disegno di un quadrato

2.  Creare un fotogramma vuoto sul fotoramma 30 (F7). Disegnare una 
lettera, ridimensionarla e dargli un colore. Nell'esempio è stata utilizzata 

la lettera S.
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3.  Affinchè l'interpolazione funzioni, bisogna trasformare la lettera un una 
forma. Con la lettera selezionata dare il comando Break Apart (CTRL-B)

4.  Utilizzando il pannello Frame sul fotogramma 1 scegliere Tweening 
Shape

5.  Provare il filmato (Control > Debug Movie - CTRL+MAIUSC+INVIO)
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Interpolazione Movimento

 

 

UTILITA'

Creazione di un preloader

Per evitare che il filmato si interrompa perchè un parte non è stata ancora 
caricata occorre costruire un preloader.

 

Creare un filmato 

1.  Rinominare il primo livello con il nome Testo e nel primo fotogramma 
inserire il testo Caricamento in corso.

2.  Prolungare il filmato fino al fotogramma 6 con F5
3.  Inserire un secondo livello con il nome percentuale. Inserire un testo 

di tipo dinamico e dare il nome percentuale. Aggiungere un testo con il 
simbolo "%".
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Creazione di un preloader

4.  Agguingere un livello e chiamarlo Etichette e aggiungere un 
fotogramma chiave nel fotogramma 2 con F6.

5.  Con il pannello Frame dare l'etichettta ripeti.
6.  Inserire un livello e chiamarlo Azioni.
7.  Creare una nuova scena e chiamarla foto con il pannello scene. Inserire 

sul primo fotogramma un immagine molto grossa. La nuova scena sarà 
il filmato che verrà visualizzato.

8.  Inserire un secondo livello e nel primo fotogramma inserire l'azione 
stop()

9.  Ritornare sulla scena 1 e nel livello creare un fotogramma chiave nel ft. 
6

10.  Con il pannello Azioni in modalità esperto inserire il codice:

LoadBytes = _root.getBytesLoaded();
TotalBytes = _root.getBytesTotal();
if (LoadBytes<TotalBytes) 
{
totali = TotalBytes;
caricati = LoadBytes;
percentuale = int((LoadBytes/TotalBytes)*100);
gotoAndPlay ("riperi");
} 
else 
{
gotoAndPlay ("Foto", 1);
}

11.  Provare il filmato con CTRL + ALT + INVIO
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12.  Selezionare View > Show Streaming in modo da vedere il 
caricamento simulato su internet.

 

SI PUBBLICA!

Pubblicazione dei filmati su internet

Una volta creato un filmato in flash lo si può pubblicare su internet.

Impostazione delle opzioni di pubblicazione.

In file > Publish Setting sono molte le opzioni che si possono impostare. 
Esaminiamo solo quelle più importanti.

Impostazione della qualità sonora.

Nella scheda Flash è possibile impostare la qualità sonora.
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E' possibile definire la velocità di campionamento del suono. Più la velocità è 
alta più il suono è preciso e fedele, eventualmente è anche possibile 
impostarlo in stereo. Bisogna tenere presente che aumentando la velocità 
aumenta anche la dimensione del file finale.

 
Pannello impostazione qualità sonora

La tabella seguente mostra la relazione tra velocità di campionamento in 
kiloByte al secondo e la Qualità.

Velocità Qualità
audio Uso ideale

8 Kbps molto scarsa
Suoni difficilmente riconoscibili

16 Kbps Appena Accettabile Solo per suoni semplici - bassa qualità

20,..,32 Kbps Accettabile Dialoghi e voce

48,56 Kbps Accettabile Grandi file musicali, suoni complessi per 
pulsanti

64 Kbps Buona Grandi file musicali, con una buona 
qualità audio

112,..,128 
Kbps Eccellente Quasi a livello CD

160 Kbps Ottima Quasi a livello CD

 

 

Segue ......................
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FLASH 5

PROGETTO 1

Creazione di un progetto molto semplice: una stella che 
ruota

Come progetto si crea una stella che ruota controllata da un pulsante. Con 
questo esempio si analizzeranno le caratteristiche principali di FLASH.

 

Impostare le proprietà del filmato

1) Aprire FLASH 

2) Controllare le proprietà del filmato con Modify > Movie (CTRL + M)
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Proprietà di un filmato

●     Frame Rate - Frequenza fotogrammi. L'impostazione a 12 è ottimale 
per rendere il filmato veloce e snello

●     Dimension - Dimensioni. Per uno schermo 800 x 600 le dimensioni 
ottimali sono 670 x 490. E' possibile impostare le dimensioni in modo da 
adattarsi alla risoluzione usata dall'utente. Inoltre con Dreamweaver è 
possibile modificare le dimensioni quando si inserisce un filmato in una 
pagina WEB

●     Backgroud Color - Colore di sfondo del filmato. (Non è possibile 
impostare la trasparenza)

Salvare con OK

 

Lavorare con lo stage

Quello che ora appare e lo stage vuoto dove compariranno i vari "attori" 
(disegni, bottoni, immagini, ...) che si muoveranno o meno in base a un 
copione descritto dalla linea temporale.
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Gli elementi di Flash

Ogni rettangolo sulla linea temporale rappresenta un fotogramma (frame). 
Con l'impostazione che è stata data precedentemente il fotogramma 12 
apparirà dopo 1 secondo dall'inizio del filmato.

 

FLASH permette di lavorare su più livelli (layers) sui quali è possibile 
posizionare i vari oggetti che compongono il filmato. E' possibile anche 
inserire commenti, etichette, suoni ed azioni per spostarsi lungo la linea 
temporale. Gli elementi posizionati sui livelli superiori (in alto) coprono quelli 
sottostanti.
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L'uso dei livelli

 

Il rettangolo rosso associato a una linea indica qual è il fotogramma 
attualmente visualizzato ed è l'indicatore di riproduzione. Questo indicatore 
può essere spostato trascinandolo o attraverso la tastiera:

Tasto Significato

, (virgola) indietro

. (punto) avanti
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Consigli per la progettazione di un filmato

●     Assegnare sempre un nome significativo ai livelli 
●     Utilizzare un livello per ogni elemento del filmato 

 

I Livelli (layers)

I livelli sempre presenti nella progettazione di un filmato sono:

●     Etichette: livello che contiene le etichette dei fotogrammi utili 
soprattutto per eseguire azioni

●     Commenti: osservazioni per rendere più leggibile il filmato ma ignorati 
da FLASH

●     Azioni: tutte le azioni è meglio concentrarle su un unico livello
●     Contenuto: uno o più livelli che si trovano sotto quelli descritti sopra 

con il contenuto del filmato
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Impostazione ideale dei livelli

 

Come creare un livello 

1.  Fare click sul livello che dovrà risultare sotto a quello nuovo.
2.  Fare click sul bottone inserisci livello 

Come assegnare un nome a un livello

1.  Fare doppio click sul livello che si vuole rinominare
2.  Scrivere il nome del livello
3.  Confermare con un click in un altro punto
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Come cancellare un livello

1.  Fare click sul livello che si vuole cancellare.
2.  Fare click sul bottone elimina livello 

Come spostare un livello

1.  Fare click sul livello che si vuole spostare.
2.  Facendo click e tenendo premuto trascinare il livello sopra o sotto 

Creare quindi i vari livelli in modo da avere la situazione in figura:

 
I livelli del filmato Stella
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Salvare il filmato con il nome stella.

Durante la progettazione del filmato i livelli possono essere:

●     nascosti: nel livello fare click su  in corrispondenza di . Il livello non 
sarà visibile 

●     bloccati: nel livello fare click su  in corrispondenza di . Il livello non 
sarà bloccato e non sarà possibile modificarne il contenuto

Nella figura precedente il livello etichette è bloccato, il livello commenti è 
nascosto, e il livello azioni è bloccato e nascosto.

Disegnare la stella

Disegneremo ora una stella a otto punte

1.  Fare click sul primo fotogramma del livello stella

2.  Fare click su quadrato dello strumento di riempimento  e 
selezionare il colore giallo

3.  Fate click su quadrato dello strumento di contorno  e selezionare 
il colore nero

4.  Con lo strumento rettangolo  disegnare un quadrato tenendo 
premuto il tasto di MAIUSC. Il quadrato ottenuto sarà composto da due 
parti: il riempimento giallo e il contorno

5.  Con lo strumento selezione  tracciare un rettangolo all'esterno del 
quadrato in modo da selezionare il bordo e il riempimento del quadrato.

Selezione di più oggetti

6.  Copiare il quadrato con Edit > Copy (CTRL + C)
7.  Incollare il quadrato sul posto con Edit > Paste in place (CTRL + 

MAIUSC + V)
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8.  Ruotare il quadrato di 45° attraverso la finestra di trasformazione

9.  Eliminare i pezzi che non servono facendovi click sopra e CANC.

Dopo aver eliminato i quattro pezzi la stella 
risulta così

10.  Fare click sull'immagine e trasformarla in un simbolo attraverso Insert 
> Convert to Symbol. Creare un simbolo Grafico con il nome Stella.

Finestra dei simboli

11.  Centrare il simbolo in mezzo allo stage attraverso il pannello di 
allineamento che può essere aperto attraverso Windows > Panels > 
Align (CTRL + K). Attivare l'allineamento rispetto allo Stage (To 
Stage) e fare click sull'allineamento centrale orizzontale e verticale.
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Pannello Allineamento

12.  Partire dal livello più basso (Pulsante) e selezionare tutti i fotogramma 
20 fino al livello etichette e premere F5 per inserire fotogrammi.

Inserimento di fotogrammi

13.  Fare click sul livello stella e dare Insert > Create Motion Tween.
14.  Fare click sul fotogramma 20 del livello stella e inserire un fotogramma 

chiave con Insert > Keyframe (F6).
15.  Facendo click sul fotogramma 1 del livello stella con il pannello Frame 

attivabile attraverso Windows > Panels o (CTRL + F) inserire una 
rotazione in senso orario (Clock Wise)

Pannello Frame
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16.  Sul fotogramma 1 del livello azioni Aprire la finestra delle azioni con 
Windows > Actions (CTRL + ALT + A) e con le Basic Action aperte 
fare doppio click sull'azione di Stop. Chiudere la finestra Frame Action.

Pannello delle Azioni

17.  Aprire la libreria comune dei bottoni con Windows > Common Library 
> Button. Fare doppio click sul pulsante  per aprire (oval) Button 
Set. 
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Pannello Libreria

18.  Fare click sul fotogramma 1 del livello pulsante e trascinare sullo stage 
il bottone Oval-play. Centrarlo nello stage orizzontalmente. 

19.  Con il bottone selezionato Aprire la finestra delle Azioni (Windows > 
Actions oppure CTRL + ALT + A) e fare doppio click sull'azione di Play. 
Le istruzioni che verranno inserite saranno quelle appropriate. Quando 
verrà fatto click sul bottone che abbiamo inserito partirà il filmato e la 
stella ruoterà.
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Azione Play su rilascio del pulsante mouse

20.  Fare click sul fotogramma 1 del livello testo e con lo strumento testo 

 inserire la scritta "Start filmato" vicino al bottone che è stato 
inserito. Portare a 40 la dimensione del carattere con il pannello 
attivabile da Windows > Character (CTRL + T). 

Pannello testo

21.  Fare click sul fotogramma 1 del livello commenti e con il pannello 
Frame attivabile da Windows > Frane (CTRL + F) inserire il 
commento //filmato di prova.
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Inserimento di un commento

Le doppie barrette "//" definiscono appunto i commenti.

22.  Fare click sul fotogramma 1 del livello etichette e con il pannello 
Frame attivabile da Windows > Frane (CTRL + F) inserire l'etichetta 
start. Il nostro filmato si presenta così:
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Filmato finale Stella

23.  Provare il filmato attraverso Windows > Testo Movie e chiudere con la 
X. Per vedere il risultato su una pagina WEB premere invece il tasto 
F12.

I PANNELLI

Servono a mostrare i dettagli degli oggetti su cui si sta lavorando. 

I pannelli si possono attivare con Windows > Panels. 

http://www.centroreiki.org/abaco/manuali/T_Flash.htm (15 of 39) [11/11/2002 14.54.35]



Corsi di Informatica - Manuale Corso

 NOTA: In ogni istante è possibile nascondere o fare riapparire i pannelli 
attraverso il tasto TAB.

Flash consente anche riposizionare i pannelli nella posizione predefinita 
attraverso Windows > Panel Sets > Default Layout.

Pannello Info

Pannello Info

 

Questo pannello fornisce informazioni sulle dimensioni e sulla posizione 
dell'oggetto selezionato. E' anche possibile modificare la posizione e/o la 
dimensione digitando direttamente il valore.

Pannello Trasformazione

 
Pannello Trasformazione 

Questo pannello consente di ridimensionare l'elemento selezionato, di 
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ruotarlo per gradi, di inclinarlo.

 

Pannello Stroke

 
Pannello Stroke 

Questo pannello consente di modificare lo spessore, il colore e lo stile del 
tratto (linea o bordo).

Pannello Fill

Pannello Fill 

Il Pannello riempomento consente di difinire vari tipi di riempimento per un 
oggetto: 

●     None: nessun riempomento
●     Solid: un unico colore
●     Linear Gradient: sfunatura lineare attraverso più colori 
●     Radial Gradient: sfunatura radiale attraverso più colori 
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●     Bitmap: utilizza un immagine.

 

Pannello Istanza

Pannello Istanza 

Questo pannello indica se l'elemnto selezionato è un pulsante, un clip filmato 
o un elemento grafico. Ognuno di questi elementi avra un nome che viene 
visualizzato. 

Pannello Effect (Effetti)

Pannello Effetti 

Questo pannello consente di modificare le prorpietà dell'istanza di un oggetto. 

●     Brightness: modifica la luminosità e il contrasto.
●     Tint: modifica il colore.
●     Alpha: modofica la trasparenza dell'oggetto
●     Advanced: permette di lavorare sui colori e sulla trasparenza
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Pannello Frame (Fotogramma)

Pannello Frame 

Questo pannello consente di assegnare un nome al fotogramma in qualsiasi 
livello.

 NOTA: Conviene, per evitare confusione, dedicare un livello apposta in cui 
assegnare le etichette ai vari fotogrammi.

 

Pannello Sound

Pannello Sound 

Questo pannello consente di definire tutti i parametri per l'impostazione dei 
suoni.
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Pannello Mixer

Pannello Mixer 

Questo pannello consente di impostare i colori per il riempimento e per il 
tratto. 

 NOTA: Facendo click sul quadratino colorato compare una pipetta che 
consente di "campionare" il colore facendo click in qualunque punto dello 
schermo.

 

Pannello Swatches (Tavolozza)

Pannello Swatches (Tavolozza) 

Normalmente Contiene la tavolozza dei colori WEB Safe e cioè quei colori che 
sicuramente sono visibili su tutti i computer.
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Pannello Libreria

Pannello Libreria 

Mostra l'elenco di tutti i diversi tipi di elementi disponibili per la creazione del 
filmato. In libreria vengono portati tutti gli elementi che possono essere 
riutilizzati. Qualsiasi simbolo infatti può essere riutilizzato in più posizioni del 
filmato creando quella che viene chiamata istanza. La cosa importante che gli 
oggetti che si presentano nel filmato sottoforma di istanze possono avere 
caratteristiche diverse impostabili attraverso i pannelli Trasformazione, e 
Effetti 

 NOTA: Solo gli elementi della libreria che appaiono sullo stage verranno 
inclusi nel file finale. Per indicare a Flash di includere un elemento della 
libreria, anche se non sembra necessario occorre utilizzare le proprietà di 
collegamento. Facendo click sul bottone Opzion si seleziona Likage ed 
Export this symbol.
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Proprietà di esportazione dei simboli 

 

I TESTI

Per scrivere del basta seplicemente utilizzare lo strumento . Bisogna peò 
considerare che esistono tre tipi di testo:

●     testo mobile
●     testo statico
●     testo dinamico
●     testo di input

Testo Mobile

 

 

Una volta selezionato lo strumento di testo si fa click in un punto dello 
schermo e si comincia a scrivere. Il blocco che contiene il testo si allunga 
mentre si scrive. Questo testo è caratterizzato da avere un pallino rotondo in 
cima a destra.

Testo Statico
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Una volta selezionato lo strumento di testo si traccia un rettangolo. Il testo 
andrà automaticamente a capo se non può essere contenuto all'interno dei 
margini definiti dal rettangolo. Questo testo è caratterizzato da avere un 
quadratino in cima a destra.

Testo Dinamico

 

 

 

 

LE MASCHERE

Creazione delle maschere

Con Flash è possibile creare varie maschere. Per capire l'utilità delle 
maschere vediamo degli esempi.
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Come fare apparire una scritta

Vediamo come realizzare la seguente sequenza

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

1.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5)

2.  Creare un secondo livello e rinominarlo con il nome maschera. 
Disegnare un rettagolo che copra il testo e che abbia lo stesso colore 
dello sfondo (nero).

3.  Applicare il riempimento lineare al rettangolo utilizzando due cursori e 
dando il colore di sfondo (Nero). Modificare la trasparenza (alfa) del 
cursore di sinistra portandola a 0%.

 
Pannelli riempimento e Mixer colori

4.  Trasformare il rettangolo in un simbolo grafico (F8) e nominarlo con 
nome maschera

5.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra in modo da fare apparire la scritta.
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Flimato Maschera1

6.  Provare il filmato con F12

 

Fare scorrere il testo all'interno di un rettangolo

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

2.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5). 

3.  Creare un secondo livello e rinominarlo con il nome Maschera. Facendo 
clik con il tasto destro sul livello trasformarlo in maschera (mask)

4.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra in modo da fare apparire la scritta.
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Filmato mashera2

5.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto rettangolo tutta a destra dello stage

6.  Fare click con il destro sul livello Maschera e trasformarlo il maschera 
(Mask).
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Filmato finale mashera2

7.  Provare il filmato con F12

 

Fare apparire una luce dietro al testo

 

1.  Creare un filmato e con Modify > Movie Properties dare le seguenti 
dimensioni: 200x70 e come colore di sfondo nero.

2.  Rinominare il primo livello con il nome Testo e inserire un testo (Testo 
che appare). Prolungare il filmato fino al fotogramma 36 (con F5). 

3.  Creare un livello con il nome Luce e trasportarlo sotto al livello testo.
4.  Disegnare un cerchio 50x50. Eliminare il contorno del cerchio e 

posizionarlo in alto a sinistra.
5.  Dare un colore di riempimento radiale partendo dal giallo e sfumando 

fino a un giallo con alfa 0%

 
Pannello riempimento con Riempimento Radiale

6.  Creare un movimento con Insert > Create Motion Tween. Inserire il 
fotogramma chiave (F6) al fotogramma 36 e spostare l'istanza 
dell'oggetto luce tutta a destra dello stage. (Usale La finestra di Align)

7.  Fare click con il destro sul livello Maschera e trasformarlo il maschera 
(Mask).
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Filmato finale mashera3

8.  Provare il filmato con F12

 

Fare illuminare con una luce il testo

 

Utilizzare il filmato creato precedentemente.

1.  Ridimensionare la luce facendo click con il tasto destro e scegliendo Edit. 
Ridurre il simbolo del 50% attraverso la finestra Transform (attivare per 
comodità Constrain). 
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Pannello Trasformazione

2.  Ritornare al filmato e allineare a sinistra e a destra le istanze del 
simbolo nel fotogramma 1 e 36.

3.  Inserire sopra il livello maschera un nuovo livello. Trasportarlo sotto il 
livello testo e rinominarlo con il nome Testochiaro.

4.  Copiare il frame del livello testo (CTRL + ALT + c) e incollarlo sul livello 
Testochiaro (CTRL + ALT + v) e dare al testo il colore bianco.

Filmato maschera4 

5.  Provare il filmato con F12
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L'Oggetto Mouse

Creazione di oggetti che si spostano con il mouse

Per creare un oggetto che si sposta con il mouse occorre: 

1.  Creare un clip filmato che contiene l'oggetto oppure l'animazione da 
spostare con il mouse.

2.  Inserire l'oggetto sullo stage.
3.  Associare al clip filmato le seguenti istruzioni in Action Script.

onClipEvent (enterFrame){
this._x = _root._xmouse;
this._y = _root._ymouse;
}

 

INTERPOLAZIONE (Motion Tween)

L'interpolazione consente di creare animazioni in modo rapido ed efficace. 
Tutto sta a disegnare il primo e l'ultimo fotogramma dell'azione e lasciare a 
Flash il compito di creare i fotogrammi intermedi. In questo modo le 
dimensioni dei file vengono ridotte al minimo.

Sono possibili due interpolazioni: 

●     Interpolazione Forma 
●     Interpolazione Movimento

Interpolazione Forma

Consiste nel trasformare un'oggetto in un altro (morphing). Questo tipo di 
interpolazione può essere effettuato solo tra forme e non tra gruppi, simboli 
o testi dinamici. E' possibile eseguire l'interpolazione anche di colore. Per 
utilizzare al meglio questa caratteristica è meglio posizionare ogni forma da 
interpolare su un proprio livello. 

Morphing tra un quadrato e una lettera
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1.  Disegnare un quadrato sul livello 1. Selezionare il bordo ed eliminarlo. 
Centrare l'oggetto nello stage

Disegno di un quadrato

2.  Creare un fotogramma vuoto sul fotoramma 30 (F7). Disegnare una 
lettera, ridimensionarla e dargli un colore. Nell'esempio è stata utilizzata 

la lettera S.
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3.  Affinchè l'interpolazione funzioni, bisogna trasformare la lettera un una 
forma. Con la lettera selezionata dare il comando Break Apart (CTRL-B)

4.  Utilizzando il pannello Frame sul fotogramma 1 scegliere Tweening 
Shape
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5.  Provare il filmato (Control > Debug Movie - CTRL+MAIUSC+INVIO)

 

Interpolazione Movimento

 

 

UTILITA'

Creazione di un preloader

Per evitare che il filmato si interrompa perchè un parte non è stata ancora 
caricata occorre costruire un preloader.
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Creare un filmato 

1.  Rinominare il primo livello con il nome Testo e nel primo fotogramma 
inserire il testo Caricamento in corso.

2.  Prolungare il filmato fino al fotogramma 6 con F5
3.  Inserire un secondo livello con il nome percentuale. Inserire un testo di 

tipo dinamico e dare il nome percentuale. Aggiungere un testo con il 
simbolo "%".
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Creazione di un preloader

4.  Agguingere un livello e chiamarlo Etichette e aggiungere un 
fotogramma chiave nel fotogramma 2 con F6.

5.  Con il pannello Frame dare l'etichettta ripeti.
6.  Inserire un livello e chiamarlo Azioni.
7.  Creare una nuova scena e chiamarla foto con il pannello scene. Inserire 

sul primo fotogramma un immagine molto grossa. La nuova scena sarà 
il filmato che verrà visualizzato.

8.  Inserire un secondo livello e nel primo fotogramma inserire l'azione 
stop()

9.  Ritornare sulla scena 1 e nel livello creare un fotogramma chiave nel ft. 
6

10.  Con il pannello Azioni in modalità esperto inserire il codice:

LoadBytes = _root.getBytesLoaded();
TotalBytes = _root.getBytesTotal();
if (LoadBytes<TotalBytes) 
{
totali = TotalBytes;
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caricati = LoadBytes;
percentuale = int((LoadBytes/TotalBytes)*100);
gotoAndPlay ("riperi");
} 
else 
{
gotoAndPlay ("Foto", 1);
}

11.  Provare il filmato con CTRL + ALT + INVIO
12.  Selezionare View > Show Streaming in modo da vedere il 

caricamento simulato su internet.

 

SI PUBBLICA!

Pubblicazione dei filmati su internet

Una volta creato un filmato in flash lo si può pubblicare su internet.

Impostazione delle opzioni di pubblicazione.

In file > Publish Setting sono molte le opzioni che si possono impostare. 
Esaminiamo solo quelle più importanti.

Impostazione della qualità sonora.

Nella scheda Flash è possibile impostare la qualità sonora.
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E' possibile definire la velocità di campionamento del suono. Più la velocità è 
alta più il suono è preciso e fedele, eventualmente è anche possibile 
impostarlo in stereo. Bisogna tenere presente che aumentando la velocità 
aumenta anche la dimensione del file finale.
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Pannello impostazione qualità sonora

La tabella seguente mostra la relazione tra velocità di campionamento in 
kiloByte al secondo e la Qualità.

Velocità Qualità
audio Uso ideale

8 Kbps molto scarsa
Suoni difficilmente riconoscibili

16 Kbps Appena Accettabile Solo per suoni semplici - bassa qualità

20,..,32 Kbps Accettabile Dialoghi e voce

48,56 Kbps Accettabile Grandi file musicali, suoni complessi per 
pulsanti

64 Kbps Buona Grandi file musicali, con una buona 
qualità audio

112,..,128 
Kbps Eccellente Quasi a livello CD

160 Kbps Ottima Quasi a livello CD

 

 

Segue ......................
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